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1 What’s New in This Release

What’s New in Siebel Healthcare Guide, Version 8.0
This guide has been updated to reflect product name and user interface changes. It was previously 
published as Siebel Healthcare Guide, Version 7.8. For more information about changes to the user 
interface, see Siebel Fundamentals.
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2 Overview of Siebel Healthcare

Oracle’s Siebel Healthcare includes various modules that you can mix and match according to your 
business needs. The next topic, “Siebel Healthcare Functionality” on page 13, describes Siebel 
Healthcare functionality.

Siebel Healthcare is built upon the Siebel Business Architecture, which includes Siebel Sales, Siebel 
Service, and Siebel Call Center applications. Like many other Siebel Business Applications, Siebel 
Healthcare uses the Siebel Data Model, the Siebel Object Architecture, and the Siebel Application 
Server Architecture. 

This chapter includes the following topic:

■ Siebel Healthcare Functionality

Siebel Healthcare Functionality
Siebel Healthcare offers a solution for relationship management in the healthcare market that 
includes the health insurance, employee benefits, and care delivery sectors. Built on the strengths 
of Siebel's industry-leading Business applications, Siebel Healthcare allows organizations to 
successfully manage relationships throughout the entire customer lifecycle, across all stakeholder 
touchpoints. This provides a platform for identifying new opportunities and expanding upon existing 
business relationships. Recognizing that success comes from relationships with the expanded 
community of stakeholders, Siebel Healthcare’s suite of applications focus on the expanded 
healthcare ecosystem: insurance subscribers and members as well as employer accounts, 
independent brokers, direct sales channels and providers (health systems, physicians, hospitals, 
networks, ancillary providers).

By using Siebel's Business applications, Siebel Healthcare provides solutions to address the 
industry's most pressing business issues.

The Siebel Healthcare solution sets include:

■ End-to-End Sales

■ Manage Opportunity and Account Tracking for prospecting, renewal, and lost business 
analysis

■ Team based selling (including external team members such as brokers)

■ Sales Manager views to facilitate team management 

■ Embedded Sales strategy tools such as Miller-Heiman Strategic Selling

■ Capture of information for rating and underwriting such as census and health risk assessment

■ Automation capabilities to make sure that quotes and installed cases move through the 
organization

■ Agent/Broker/Consultant Solutions
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■ Profiling capabilities to track licenses, appointments, errors & omissions coverage, agency 
affiliation

■ Ability to assign an agent or broker to an opportunity or account

■ Management tools to assess the relative value of various selling partners

■ Delegated administration to allow agencies to administer their own user names and 
passwords

■ Group Account Relationship Management

■ Ability to communicate new product information and tailored messages about the plan 
consistently across every interface

■ Streamline the open and ad hoc enrollment processes. Employees can self-enroll online or 
administrators can submit enrollment by using the group portal

■ Manage service issues with analytics and reports. Employers can have visibility into 
aggregate claims data, physician networks and other relevant plan information

■ Promote online self-service as an avenue for quick resolution of billing issues 

■ Agent Tools

■ Support demand from web, fax, phone and email from a single interface

■ Address common inquiries with a dashboard of eligibility information, claims history, service 
history, and log of customer interactions

■ Use assignment manager and workflow products to allow agents to follow best-practice 
procedures

■ Allow new agents to get up to speed through the use of scripting tools and a common solution 
library

■ Health Management

■ Use the Events module to track available health classes and clinics and enroll members and 
patients

■ Create Activity plans and use workflow tools to outline the appropriate activities and 
resources required to proactively manage care

■ Develop campaigns for managing enrollment of at-risk populations in care      management 
programs

■ Provide information to educate members on critical life events, disease specific services, and 
available health classes

■ Use analytics capabilities to track and monitor the success of classes and programs

■ Provider Relationship Management

■ Consolidate critical information from back office systems related to individual physicians and 
other providers. This supports effective responses to inquiries and proactive management of 
the contracting relationship

■ Track key information on individual physicians such as panel size and status, location, office 
hours and hospital admitting privileges
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■ Search for providers and facilities in a geographic radius using Geocode searching capabilities

■ Access provider informationx online using a secure website

■ Generate provider reports by specialty, product, or state

■ Offer provider portal to promote self-service for common inquiries
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3 Getting Started with Siebel 
Healthcare

This chapter lists the applications administration tasks that are specific to Siebel Healthcare. Use this 
chapter in combination with Siebel Applications Administration Guide.

This chapter includes the following topics:

■ “About Applications Administration Tasks” on page 17

■ “Renaming Siebel Account Objects” on page 18

■ “Configuring Lists of Values” on page 18

■ “Configuring Summary Views” on page 18

■ “Adding Products and Product Lines” on page 19

■ “About Command Center” on page 20

■ “Command Center Configuration and Administration” on page 20

■ “Process of Configuring the Command Center Action Form” on page 20

About Applications Administration Tasks
Siebel Applications Administration Guide covers the setup tasks that are common to all Siebel 
Business Applications, such as using license keys, defining employees, and defining your company’s 
structure. It also provides the information you will need to implement, configure, and monitor the 
Siebel sales, service, and marketing products and to perform data administration and document 
administration tasks.

This guide assumes that you have already installed or completed the upgrade of Siebel Healthcare. 
If you have not, go to the Installation/Upgrade section of the Siebel Bookshelf and click the links to 
the guides that are relevant to your company’s implementation.

The Siebel database server installation creates a Siebel administrator account that can be used to 
perform the tasks described in this guide. For more information about this process, see the 
Installation Guide for your operating system.

CAUTION: Do not perform system administration functions on your local database using the Mobile 
Web Client. Although there is nothing to prevent you from doing this, it can have serious results, 
such as data conflicts, an overly large local database, or a large number of additional transactions 
to route.
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Renaming Siebel Account Objects
In general, Siebel applications refer to companies as accounts. In the Financial Services industry, the 
term account has typically been synonymous with financial accounts, so historically the word 
company has been used in many places in Siebel Healthcare. By default, Siebel Healthcare installs 
using the term accounts. Users can change this term and use another description, such as 
Companies, Clients, or Customers. Users wishing to change this default need to rename all Siebel 
Account objects prior to deployment. Make changes to the UI layer (for example, applet titles and 
control labels), rather than the Business Objects layer. For more information, see Siebel Database 
Upgrade Guide.

NOTE: All of the chapters in this guide are written assuming you have renamed Siebel Account 
objects to Companies.

Configuring Lists of Values
In Siebel Healthcare, modify the List of Values (LOV) in accordance with the terminology used by 
your financial institution. For example, the list of transaction types used in Siebel Healthcare should 
match those used by your financial institution. For more information on configuring a LOV, see Siebel 
Applications Administration Guide.

NOTE: This may impact certain forms and lists, which rely on the preconfigured values for correct 
operation.

Configuring Summary Views
In Siebel Healthcare, summary views have been restructured. In the past, multiple summary views 
existed, typically one summary view for a particular type of user. For example, there were 
preconfigured summary views specifically for salespeople and customer service agents. This has 
been replaced by common summary views whose appearance can be configured by individual end 
users.

Users can change the way a list appears in a summary view by using the controls in the top right 
corner of each list. These controls, described in Table 1, allow users to manage what appears on the 
summary view. 

Table 1. Summary View Controls

Button Description

Hide Temporarily hides a list or form from view.

Collapse Collapses the list of records. If the list cannot be collapsed, the expand button 
appears instead of the collapse button.

Expand Expands the list of records. If the list cannot be expanded, the collapse button 
appears instead of the expand button.
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Any changes made to a summary view layout are only visible to the current user and remain in effect 
until that user changes them again or reverts to the default layout. If users hide a list, they must 
click Edit Layout to restore it. For more information, see “Editing a Summary View Layout.”

Editing a Summary View Layout
Using the Edit Layout view, users can restore hidden lists, collapse or expand all lists, move lists or 
forms up or down on the page, or revert to the default layout. The edit layout buttons, described in 
Table 2, allow users to change the way a summary view appears and apply those changes to future 
sessions.

For more information on available summary views, see “Viewing a Contact Summary (End User)” on 
page 54, “Viewing Company Summaries (End User)” on page 43, and “Viewing Household Summaries” 
on page 60, and “Editing the Layout of the Members Summary View” on page 105.

Adding Products and Product Lines
Administrators must set up products, such as health insurance products, in Siebel Healthcare. After 
setting up a product, administrators can specify that it be included in a product line. They can also 
specify which product lines your company contracts agencies to sell or which ones the state licenses 
agencies to sell.

Setting up products is discussed in detail in Siebel Product Administration Guide. However, this guide 
also explains some steps for adding products in the appropriate chapters. In those chapters, values 
for specific fields are given to help administrators set up products correctly.

NOTE: Only those users with the required administrative responsibilities, such as Siebel 
administrators, can add products and information about product lines. 

Table 2. Edit Layout Buttons

Button Description

Collapse Collapses the list or form.

Expand Expands the list or form.

Move up Moves the list or form up on the home page.

Move down Moves the list or form down on the home page.

Show Displays the list or form on the home page.

Hide Hides the list or form from view on the home page.
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About Command Center
The command center allows you to launch a process, perform a task, or jump to a view. Command 
center actions are preconfigured by your system administrator in accordance with your company’s 
business process requirements. For example, if the financial services agents at your company often 
need to jump to the financial accounts view for a contact, you could configure the command center 
to perform this action, saving them time and keystrokes. See “Command Center Configuration and 
Administration” on page 20 for information on how to configure the command center.

Out of the box, the command center is only available from the Summary views on the Contacts, 
Companies, and Members screens.

Command Center Interface Types
There are two interface types for the command center:

■ Action form

■ Command line

Figure 1 shows the action form, a menu-driven interface guiding the end user through preconfigured 
choices in order to launch an action. The command line requires the end user enter specific command 
line syntax to launch the action.

Command Center Configuration and 
Administration
Command Center configuration and administration should only be done by expert users accustomed 
to working with business services.

Process of Configuring the Command 
Center Action Form
To configure the appearance and function of the Command Center Action form you must:

Figure 1. Command Center Action Form
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1 Define the business object where the Command Center Action form appears and what business 
component and fields are to be used. See “Defining the Command Center Business Object.”

2 Define actions available for the business object, indicating for each combination of possible 
attribute values what action is taken (launch a business service or workflow, go to a view, and 
so on). See “Defining the Command Center Actions.”

3 For actions defined as private, select the defined roles for which the actions will be available. See 
“Selecting the Command Center Responsibilities.”

An example configuration is included at “Example of Configuring the Command Center Action Applet” 
on page 25.

Defining the Command Center Business Object
The first step in configuring the Command Center Action form is to define the business object where 
the Command Center form appears, and what business component and fields are to be used. Out of 
the box, the Command Center forms appear on the Contact Summary and Company Summary views.

This task is part of “Process of Configuring the Command Center Action Form.”

To define the business object

1 Navigate to Site Map > Administration - Command Center screen > Defined Objects view.

2 Create a new object definition record and complete the fields as follows:

Field Parameters Description

Business Object Any Business Object for which 
the forms have been defined. 
For example, Contact or 
Companies. 

This identifies the screen where the 
Command Center form is to appear.

Source Business 
Component

The business component 
against which the Driving Field 
will be compared. For 
example, FINCORP Account.

This should be a business 
component available on the 
view where the Command 
Center applets are visible (for 
example, Contact Summary 
view).

The value of this field is constrained by the 
value of Business Object field. In turn, it is a 
constraint for the Driven Field.
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Source Business 
Search 
Specification

A filter on the source business 
component. For example, Acct. 
Status = Open. Only Financial 
accounts with a status of Open 
will be available in the 
Command Center.

Use this field to enter an optional filter 
criteria on the selected Business Component.

Driving Field A field name from the Source 
Business Component. The field 
name can be ascertained using 
Siebel Tools. 

Following the examples in the 
preceding field parameter 
descriptions, this could be the 
Financial Account name or ID.

The value of this field is constrained by 
Source Business Component and Source 
Business Search Specification (if entered).

The driving field is equivalent to Attribute 1.

Driving Field 
Label

Free text field, 20 character 
limit.

The text label exposed in the UI for Driving 
Field (Attribute 1). If blank, the label defaults 
to the Driving Field on the Command Center 
form.

Attribute 2,3,4 
Label

Free text fields, 20 character 
limit.

The text label for each of Attributes 2-4. If 
left blank, the attribute will not appear on the 
form.

Field Parameters Description



Getting Started with Siebel Healthcare ■ Process of Configuring the Command Center
Action Form

Siebel Healthcare Guide Version 8.0 23

Defining the Command Center Actions
After you define the business object, you define actions for each object. These actions indicate for 
each object a combination of possible attribute values what action is taken (launch a business service 
or workflow). The relationship is one-to-many.

This task is part of “Process of Configuring the Command Center Action Form” on page 20.

To define actions for the Command Center applet

1 Navigate to Administration - Command Center screen > Defined Objects view, and select the 
Object Definition for which you wish to define actions.

Driving Field on 
Cmd Form

Check box. If checked, it exposes the Driving Field label 
on the Command Center form preceding the 
Command field.

Expression Free text field. Use this field to constrain the available set of 
actions based on what the user has selected 
in the Driving Field. As each object definition 
can have multiple action definitions, the 
expression field is a way to limit the available 
actions based on a business component field.

For example, if the user selects a checking 
account, investment based actions may not 
be appropriate. 

For example: IIF([Account Number] LIKE 
'1800*', Liability, Asset). That is, if the 
account number starts with 1800, it maps to 
action definitions in the Action Definition list 
that have the Attribute 1 Map field set to 
Liability. Otherwise, it is mapped to action 
definitions that have the Attribute 1 Map field 
set to Asset.

If there is no need to constrain the actions, 
then any value will suffice (for example, 
Contact - All). 

Field Parameters Description
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2 Scroll down to the Action Definition list, create actions and complete the fields as described in 
the following table.

Field Parameters Description

Attribute 1 
Required

Check box. Indicates whether or not an entry in the 
Driving Field (Attribute 1) is required for 
the Command Center to return results.

Attribute 1 Map Free text. Works in concert with the Expression field 
of the Object Definition to determine the 
contents of the Command Center 
dropdown menus.

Attribute 2-4 Free text. Value lists for Attributes 2-4.

Command Free text. Each entry must be 
unique, that is, you cannot use 
the same command for different 
actions.

The command line equivalent for the 
action. 

These commands are restricted to the 
Business Object with which they are 
associated.

See also “Creating Global Commands for 
the Command Line Applet” on page 27.

Command Help 
Text

Free text. The Help text for the command help 
feature when a question mark (?) is 
entered using the command line.

This field is reserved for future use. You 
can expose it in some manner, should you 
choose, using a custom configuration.

Business Service Free text. 

EX: FINS Goto View Service

The name of the Business Service to be 
run. 

Business Service 
Context

Free text. The parameters for the Business service.

Business Service 
Method

Free text. The method for the selected Business 
service.

Public Flag Check box. If checked (true), then any roles selected 
for the action do not apply. 

If unchecked (false), then any roles 
selected do apply and visibility to actions 
will be limited by the selected roles.

Inactive Check box. This hides the defined action and 
attribute combination.
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Selecting the Command Center Responsibilities 
For each action, select the defined responsibilities for which the action will be available. The 
relationship between actions and responsibilities is one-to-many. 

This task is part of “Process of Configuring the Command Center Action Form” on page 20.

To select responsibilities for a Command Center action

1 Navigate to Administration - Command Center screen > Defined Objects view, and select the 
Action for which you wish to define responsibilities.

2 Scroll down to the Responsibility list, create a new record, and select the desired responsibility.

The responsibilities information appears as read-only in the Responsibility list. Selected 
responsibilities are only enforced if the Public Flag for the action is unchecked (false).

Example of Configuring the Command Center Action 
Applet
This topic gives an example of configuring the Action applet. You may use this feature differently, 
depending on your business model.

The Command Center is available on the Siebel Healthcare Member Summary view and can be 
configured to launch several key sales processes such as ordering a new ID card or changing a 
primary care physician. For more information on using the Member Summary Command Center when 
configured as in this example, see “Example of Using the Command Center for Common Member 
Services” on page 106. 

The Command Center is set up using the Administration - Command Center view.

To configure the action applet to run the business service FINS Goto View

1 Navigate to FINS Command Center Admin Object view and create a new object definition record. 
Complete the fields as follows:

Field Value

Business Object Name FINS Members

Source Business Component FINS Members

Driving Field Last Name

Driving Field Label Name

Attribute 2 Label Area

Attribute 3 label Action
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2 To set up a pop-up applet, in the Action Definition list create a new action record and complete 
the fields as follows:

3 To set up a view navigation, in the Action Definition list create a new action record and complete 
the fields as follows: 

Expression RedundantExpression

Driving Field On Cmd Form Checked

Field Value

Attribute 2 ID Card Requests

Attribute 3 Show History

Command IDCSH

Business Service SLM Save List Service

Business Service Context 'Applet Mode', '6', 'Applet Name', 'FINS Service 
Request Order ID Popup Applet'

NOTE:

Business Service Method LoadPopupApplet

Public Flag Checked

Field Value

Attribute 2 ID Card Requests

Attribute 3 Order New ID Card

Command IDCOR

Business Service FINS Goto View Service

Business Service Context 'ViewName', 'FINS Member Benefits View', 
'RowId', '[Current Src Rec Id]', 'AppletName', 
'FINS Member Form Applet - short'

NOTE:

Business Service Method GotoView

Public Flag Checked

Field Value
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Creating Global Commands for the Command Line 
Applet
Some users may prefer to use only the Command form. In this case, the only configuration required 
is to indicate the command line syntax and the associated business service and responsibility 
information. Use these global commands through the Command line form on whatever business 
object it appears.

To create global commands for the Command Line applet

1 Navigate to the Administration - Command Center screen > Global Commands view.

2 In the Global Commands list, create a command record, and complete the fields as described in 
“To define actions for the Command Center applet” on page 23.

3 For each Command, record select responsibilities as described in “To select responsibilities for a 
Command Center action” on page 25.
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4 Managing Companies

This chapter describes managing companies and accounts information. It includes the following 
topics:

■ “About Managing Companies and Accounts” on page 29

■ “About Company Hierarchies” on page 30

■ “Scenario for Managing Company Information” on page 30

■ “Process of Managing Companies” on page 31

■ “Setting Up Values for Companies” on page 32

■ “Deleting Company Information” on page 33

■ “Managing Competitor Information” on page 33

■ “Verifying Coverage Team Members” on page 34

■ “Managing the Custom-Defined Relationship Types LOV” on page 35

■ “Generating Company Hierarchies for Data Aggregation” on page 36

■ “Adding Companies and Investors (End User)” on page 39

■ “Viewing Company Hierarchies in Roll-Up Views (End User)” on page 39

■ “Creating Company Assessments (End User)” on page 41

■ “Adding Company Applications (End User)” on page 41

■ “Adding Company Service Requests (End User)” on page 42

■ “Managing Company Coverage Teams (End User)” on page 43

■ “Viewing Company Summaries (End User)” on page 43

■ “Viewing Company Summaries (End User)” on page 43

About Managing Companies and 
Accounts
Within Siebel Healthcare, the term companies refers to entities that are typically referred to as 
accounts in other Siebel applications. A company represents the relationship between your 
organization and companies or organizational entities (or structures) with which you do business. 
Use the Companies screen and its associated views to view company information and interactions.

CAUTION: This chapter assumes you have renamed Siebel Account objects to Companies. By 
default, Siebel Healthcare installs using the term Accounts. For more information on renaming Siebel 
Account objects, see Siebel Database Upgrade Guide.
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In Siebel Healthcare, the term investors refers to financial organizations such as mutual fund or 
money management institutions; investors are not contacts, rather they are companies that are 
identified as investors. In Siebel Financial Services, the investors functionality has migrated to the 
Companies screen. This chapter covers both regular company and investor procedures.

Use the procedures in this chapter to perform the administrator tasks of controlling company 
information, generating company hierarchies, managing competitor information, verifying coverage 
team members, and managing custom-defined relationship types. 

End users use the Companies views to add new companies and investors, create company 
assessments, associate service requests with a company, update the coverage team, define 
relationships to other companies, contacts, and households, and view company summary 
information. In addition, end users can retrieve information about investors, including investors’ 
preferences, holdings, and transactions.

You can save time and reduce keystrokes by using a workflow to automate steps that are repeatedly 
performed by end users. For more information, see Siebel Business Process Framework: Workflow 
Guide.

About Company Hierarchies
A company hierarchy is a group of companies that are organized by parent-child relationships. Siebel 
Industry Applications support displaying these company relationships in a hierarchical tree.

The hierarchical tree is a visual representation of company hierarchy data that allows end users to 
view the relationships between companies. By viewing a company roll-up, users can see aggregated 
company information, including contacts, coverage teams, activities, and opportunities. 

When end users have access to a company, they can review the hierarchical structure for that 
company, its child divisions, and the contacts that work there. Company hierarchies are displayed in 
five subviews of the Companies screen—Relationship Hierarchy view, Activity Roll-up, Contact Roll-
up, Opportunity Roll-up, and Coverage Team Roll-up. 

Depending on your configuration, a company that does not have a parent-child relationship with 
another company may not appear in the roll-up views. 

For more information on company hierarchies, see “Generating Company Hierarchies for Data 
Aggregation” on page 36 and “Viewing Company Hierarchies in Roll-Up Views (End User)” on page 39.

Scenario for Managing Company 
Information
This scenario features sample tasks performed by a sales representative in the insurance and 
healthcare industries. Your company may follow a different workflow according to its business 
requirements.

In this scenario, end users are the sales representatives who manage company information. They 
enter information to:

■ Add new companies to the database and create company assessments
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■ Associate applications and service requests with a company

■ Manage company coverage teams

■ View company summary information

■ View relationships in a graphical manner

Sales Representative Tracks Company Information
A sales representative uses the Companies screen to capture and manage profile information about 
her business customer, such as contacts, organizational structure, management, and financial 
information. In addition to viewing market statistics and D&B reports. Using Siebel Healthcare, she 
can capture and track information about a company’s:

■ Relationship with her organization, such as the coverage team, contract terms, sales and service 
information

■ Preferred delivery channels, at both summary and detailed levels

She can also view details of competitors and create and access marketing and sales presentations.

The sales representative can create a new company record or view and modify information about 
existing companies. For example, if the sales representative is preparing for a sales call, she can use 
the Companies screen to answer the following questions:

■ What business is this company in?

■ Who are the executives I should be calling on?

■ What is this company’s financial profile?

■ What financial accounts and products does the company already own?

■ What types of service issues has the company had?

Process of Managing Companies
This section details sample tasks often performed by administrators and end-users when managing 
companies. Your company may follow a different process according to its business requirements. 

Administrator Procedures
The following list shows tasks administrators typically perform to manage companies:

■ “Setting Up Values for Companies” on page 32

■ “Deleting Company Information” on page 33

■ “Managing Competitor Information” on page 33

■ “Verifying Coverage Team Members” on page 34

■ “Managing the Custom-Defined Relationship Types LOV” on page 35
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■ “Generating Company Hierarchies for Data Aggregation” on page 36

End-User Procedures
The following list shows tasks end users typically perform when managing companies:

■ “Adding Companies and Investors (End User)” on page 39

■ “Viewing Company Hierarchies in Roll-Up Views (End User)” on page 39

■ “Creating Company Assessments (End User)” on page 41

■ “Adding Company Applications (End User)” on page 41

■ “Adding Company Service Requests (End User)” on page 42

■ “Managing Company Coverage Teams (End User)” on page 43

■ “Viewing Company Summaries (End User)” on page 43

■ “Viewing Company Relationship Hierarchies (End User)” on page 44

Setting Up Values for Companies
Administrators can create new industries and territories so that the appropriate selections are 
available to end users when they add companies. 

When a company is added to Siebel Healthcare, the end user adding the company is responsible for 
indicating the industry to which the company belongs. Administrators are responsible for creating 
the industries that appear to end users. 

To add an industry

1 Navigate to the Administration - Data screen > Industries view.

2 In the Industries list, add a record, and complete the necessary fields.

Some fields are described in the following table.

Companies are often associated with a territory. Administrators can create the territories that appear 
in the Territory field when end users add a company to Siebel Healthcare.

Field Description

Language Code Primary language of the classification used.

SIC Code Standard Industry Classification code as defined by the U.S. 
Department of Commerce.

Type The classification used to describe the industry.



Managing Companies ■ Deleting Company Information

Siebel Healthcare Guide Version 8.0 33

To add a territory

1 Navigate to the Administration - Assignment screen > Territories view.

2 In the Territory List list, add a record, and complete the necessary fields.

Deleting Company Information
Deleting a company completely removes the company, as well as all activities related to the 
company, from the system. Only delete a company record if you are certain that the company is no 
longer active. If end users are unsure whether or not a company is still active (and therefore should 
not be deleted), they have the option of removing themselves from the company team instead of 
deleting the record.

As the Siebel administrator, you can make a company unavailable to all other users. First, you can 
assign yourself as the primary team member. Second, you remove all other employees from the 
company’s team. 

To make a company unavailable to all other users

1 Navigate to the Companies screen > Companies Administration view.

2 In the Company list, drill down on the Name link.

3 In the Company Team dialog box, locate the administrator, and click in the Primary field.

4 In the Company Team dialog box, delete all other coverage team members and click OK.

Only those users with access to the All Companies and All Companies Across Organizations views 
will be able to see this company. 

Managing Competitor Information
Effective sales and marketing requires that your employees have up-to-date and consistent 
information about the competition and their products. This section describes how to administer 
information about competitors and competitive products within the Companies screen. 

To indicate that a company is a competitor

1 Navigate to the Companies screen > Companies Administration view.

2 In the Company list, add or select a company.

3 In the Company form, click the show more button.
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4 Select the Competitor check box to add the company to the Competitor’s list.

The company appears in the Competitor’s list. The Competitor’s list is available in the 
Competitors screen and related screens, such as Opportunities.

NOTE: Non-administrators can specify that a company is a competitor by selecting Competitor from 
the Type drop-down list. However, selecting Competitor from the Type drop-down list does not add 
the company to the Competitor’s list as seen on the Competitor’s screen, or in the Pick Competitors 
dialog box, which is accessible on related screens, such as Opportunities. 

When a company has been indicated as a competitor, you may want to add document files of 
comparative and competitive literature. For more information, see the chapter on literature 
administration in Siebel Applications Administration Guide.

Removing Records from the Competitors List
You cannot delete records that have been added to the Competitors list, since deleting them would 
also remove them from related screens, like Opportunities. For example, a company may have been 
a competitor for an opportunity last month. Even if the company is no longer a competitor, the 
competitor record should remain as part of the history of the opportunity. 

If you no longer want a record to appear in the Competitor’s list, deselect the Competitor check box. 
This removes the record from the Competitors screen without affecting other screens.

Verifying Coverage Team Members
If you are logged on as a Siebel administrator, you can search for companies that do not have any 
coverage team members.

Managers can add or delete the members of a company’s coverage team if they are the existing 
primary team member, or the primary team member is one of their direct reports. If you are logged 
in as an administrator, you can change the primary team designate for any company in the Company 
Administration view. (Navigate to the Companies screen > Companies Administration view.)

NOTE: In Siebel Financial Services, the terms sales team and account team are equivalent to 
coverage team.

The procedures that follow involve making selections in the Account Team field. If the Account Team 
field does not appear in your installation, you may need to reveal it using the Columns Displayed 
dialog box.

NOTE: Usually, Assignment Manager resolves problems with coverage teams and owner assignment 
automatically. For more information on Assignment Manager, see Siebel Assignment Manager 
Administration Guide.

To search for a company without any coverage team members

1 Navigate to the Companies screen > Companies Administration view.
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2 In the Companies list, define a new query where the Name field is:

count(

) = 0

3 Execute the query.

The query returns a list of all companies that do not have any coverage team members.

To add or delete members of the coverage team for a company

1 Navigate to the Companies screen > Companies Administration view.

2 In the Companies list, select a company, and click the More Info view tab.

3 In the Account Team field, select an employee in the Coverage Team dialog box, and click Add or 
Remove.

To change the primary coverage team member for a company

1 Navigate to the Companies screen > Companies Administration view.

2 In the Companies list, select a company, and click the More Info view tab.

3 In the Account Team field, select the Primary field for the new primary coverage team member.

Managing the Custom-Defined 
Relationship Types LOV
If you are logged in as the Siebel administrator, you can create and maintain a list of predefined 
custom-defined relationship types. A default list of values is provided with the application. These 
relationship types appear in the drop-down LOV for the Type field found on the Relationship Hierarchy 
views, in the Party Relationship applet.

To add a custom-defined relationship type

1 Navigate to the Administration - Data screen > List of Values view.

2 In the List of Values list, create a New Query where Type equals PARTY_RELATIONSHIP_TYPE.

At least six records will be returned, showing the existing list of values for custom-defined 
relationship type.
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3 In the List of Values list, add a record, and complete the necessary fields. 

Some fields are described in the following table.

NOTE: You cannot delete LOV table entries. Use the Active check box to deactivate an LOV entry and 
thereby remove it from the Relationship drop-down list.

Generating Company Hierarchies for 
Data Aggregation
Data aggregation is available by using the Roll-up views, providing the administrator defined one or 
more hierarchies. The application administrator typically defines a default hierarchy by associating 
accounts with one another using the parent field on a company form, or the subaccount view for child 
accounts. Administrators can define Company hierarchies to display aggregated data—the activities, 
opportunities, contacts, and coverage teams—across organizational structures. For example, the top 
node of the hierarchy contains activities for the organization, the subsidiaries below the organization, 
the departments at the subsidiaries, and contacts working at any level of the tree. As the end users 
move up and down the tree, they see more or less data rolled up to the selected level.

By default, only companies that are part of a relationship hierarchy can display roll-up data. You can 
modify the application to display roll-up data for companies which are not part of a hierarchy.

To configure display of roll-up data for companies not in a hierarchy
■ Using Siebel Tools, set the DynHierachry user property of the Dynamic Hierarchy Direct 

Relationship business component to LoadAllAccounts

For more information on setting user properties, see Configuring Siebel Business Applications.

Field Comments

Active Determines whether the value is displayed to the end user in the 
Relationship drop-down list. 

Display Value Value as displayed in the Relationship drop-down list.

Language Independent 
Code

Code used internally by the Siebel application.

Language Name Language used for the list of values Display Value field.

Order Numerical order in which a value is displayed within the Relationship 
drop-down list.

Parent LIC Language-independent code of a parent list of values. It is used in 
hierarchical list of values.

Translate When checked, indicates that the list of values is part of a multilingual 
list of values (MLOV).

Type The type of list of values. For this procedure, select 
PARTY_RELATIONSHIP_TYPE.
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Siebel Global Accounts is the module that provides this aggregation functionality. For more on global 
accounts, see Siebel Applications Administration Guide.

The application administrator can define two types of hierarchies for data aggregation:

■ Default hierarchy for all end users, see Default Company Hierarchies on page 37

■ Specific hierarchies that are used only by certain end users, see Dynamic Company Hierarchies on 
page 38

Default Company Hierarchies
The application administrator sets up a default company hierarchy one time, during the initial 
application setup. The default hierarchy is available to all end users who are not tied to a specific 
hierarchy, and who have been granted view access to the companies represented in the hierarchy. 
It is the administrator’s responsibility to give end users access to Company views. For more 
information, see Siebel Applications Administration Guide.

When new companies are added, they are automatically added to the default hierarchy tree. The 
contacts, coverage teams, activities, and opportunities that are associated with the company are 
automatically displayed in the roll-up views. 

In the preconfigured application, using the Generate Hierarchy button adds only parent account and 
child companies to the hierarchy. Any company that does not have a child or parent is not displayed 
in the roll-up views. Use Siebel Tools to change the DynHierarchy LoadAllAccounts user property to 
alter this behavior.

You can set the DynHierarchy LoadAllAccounts user property on the Dynamic Hierarchy Direct 
Relationship business component to N or Y. When it is set to N, only parent and children appear in 
the a generated hierarchy. When DynHierarchy LoadAllAccounts user property is set to Y, all 
companies are added to the generated hierarchy. For more information on setting user properties, 
see Siebel Developer’s Reference.

To generate a default company hierarchy

1 Navigate to the Companies screen > Global Companies Administration view.

2 In the Company Hierarchies list, click Generate Hierarchy.

The parent-child account relationships that have been defined in your application are registered 
for participation in the roll-up views. This process may take some time, depending on the 
quantity of account records that are in your existing environment.

When the company hierarchy has been generated, a new record appears in the Company 
Hierarchies list. The Hierarchy Name field of the record contains the user ID of the administrator 
who generated the hierarchy and the time it was generated. If it is the only hierarchy record, the 
Default field is automatically checked. The companies that have been added for participation in 
the roll-up views appear in the Company Relationships list.

NOTE: If no accounts are visible in the Company Relationships list, click the query button, step 
off the query, and click Go to refresh the view.
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3 (Optional) Rename the company hierarchy and, if necessary, check the Default field.

NOTE: If end users are using the application when you generate a hierarchy, they must log off 
and log on again to see the default hierarchy in the roll-up views.

Dynamic Company Hierarchies
In some cases, users work with particular companies within a large corporation, but not with others. 
In these instances, some end users do not need to or should not see aggregated data across the 
entire corporation. An administrator can define a custom hierarchical structure across which data can 
be aggregated. This defined structure, called a dynamic hierarchy, can be as simple or complex as 
needed and offers users the ability to aggregate data across the companies they are interested in 
seeing.

To create a dynamic company hierarchy of selected companies

1 Navigate to the Companies screen > Global Companies Administration view.

2 In the Company Hierarchy list, and create a new record.

3 Scroll down to the Company Relationships list, create a new record, and select company.

All the accounts in the Company Relationship list belong to the new account hierarchy.

4 To define parent and child relationships:

a Select an company in the Company Relationship list that has no parent.

b In the Parent field, select a parent.

NOTE: Only companies entered in the Company Relationships list (Step 3) are available for 
selection in the parent field.

5 Repeat Step 4 for all companies that have no parents.

To associate the dynamic hierarchy with an organization

1 Navigate to the Administration - Group screen > Organizations view.

2 Select the organization in the Organizations list.

3 In the organization form, select the desired hierarcy in the Account Hierarchy field.

End users can only see the hierarchy with which their current position’s primary organization is tied. 
It is the administrator’s responsibility to associate end users with positions, positions with 
organizations, and organizations with hierarchies. For more information, see Siebel Applications 
Administration Guide.
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Adding Companies and Investors (End 
User)
When end users identify a possible lead, the lead can be added as a company. Users can then begin 
to add and track information about the company.

To add a company or investor

1 Navigate to the Companies screen > Companies List view.

2 In the Companies form, click the show more button, add a record, and complete the necessary 
fields.

3 To specify a privacy level, in the Privacy Option field select one of the following:

■ Opt-In. Sharing of non-public personal information is allowed without restrictions.

■ Opt-Out - Affiliates. Sharing of non-public personal information with affiliates is not 
allowed.

■ Opt-Out - Third Party. Sharing of non-public personal information with third parties is not 
allowed.

■ Opt-Out - All Parties. Sharing of non-public personal information with any affiliate or third 
party is not allowed.

United States law requires that financial institutions disclose their privacy policies regarding the 
sharing of non-public personal information with third parties, and fair credit reporting, that 
impacts the sharing of non-public personal information with affiliates. End users can specify a 
privacy level by making a selection from the Privacy Option field.

The Privacy Option field is for registering the privacy level requested by the company; it does not 
impact record visibility in any way. 

4 To identify the company as an investor, check the Investor box in the Company form.

Viewing Company Hierarchies in Roll-Up 
Views (End User)
End users can review the company and its parent organization, subsidiaries, contacts, opportunities 
and relationships to other entities using the graphical relationship hierarchy tree control. This control 
is available in the roll-up views. By drilling down on hypertext links on the hierarchy tree, end users 
can navigate to related views.

NOTE: If the company has not been added to a hierarchy tied to the user's position's organization 
(either default hierarchy or dynamic hierarchy), the hierarchy tree is not visible to the end user. The 
following message appears: “The selected record is not included as part of your defined hierarchy. 
If you feel this is in error, please contact your system administrator.” The administrator is responsible 
for associating positions with organizations and an organization with a hierarchy.
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The Activities-Roll-up view shows all of the activities associated with the selected company and its 
children. End users can apply filters to the list to find specific activity records and save the filtered 
list.

NOTE: If a company is not associated with any other organizations through the relationship 
hierarchy, then the roll-up views will not contain any data. A company must have a parent 
organization, or have children organizations, in order to display roll-up data.

To view aggregated activities for a company

1 Navigate to the Companies screen> Companies List view.

2 Drill down on the desired company, and click the Activities-Roll-up view tab.

The associated hierarchy appears on the right side of the screen. All activities associated with 
the company and all of its children appear in the Activities-Roll-up list. 

In the Activities-Roll-up List, you can:

■ Drill down on an activity type to navigate to the Activities screen > Attachments view.

■ Drill down on a company name to navigate to the Companies screen > Contacts view.

NOTE: If you create an activity in the Activities screen and do not set the Company field, the 
activity will not appear in the Activities-Roll-up list.

To view the aggregated coverage team for a company

1 Navigate to the Companies screen > Companies List view.

2 Drill down on a company, and click the Coverage Team-Roll-up view tab.

The associated hierarchy appears on the right side of the screen. All coverage team members 
associated with the company and all of its subsidiaries appear in the Coverage Team-Roll-up list.

In the Coverage Team-Roll-up list, you can:

■ Drill down on a last name to navigate to the Employees screen.

■ Drill down on an email address to open a blank email message addressed to the team 
member who has that address.

To view aggregated opportunities for a company

1 Navigate to the Companies screen > Companies List view.

2 Drill down on an company, and click the Opportunities-Roll-up view tab.

The associated hierarchy appears on the right side of the screen. All opportunities associated with 
the company and all of its children appear in the Opportunities-Roll-up list.

In the Opportunities-Roll-up list, you can:

■ Drill down on an opportunity name to navigate to the Opportunities screen.

■ Drill down on a company name to navigate to the Companies screen > Contacts view.
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To view an aggregated list of contacts for a company

1 Navigate to the Companies screen > Companies List view.

2 Drill down on a company, and click the Contact-Roll-up view tab.

The associated hierarchy appears on the right side of the screen. All contacts associated with the 
company and all of its children appear in the Contacts-Roll-up list.

In the Contacts-Roll-up list, you can:

■ Drill down on a last name to navigate to the Contacts screen.

■ Drill down on a company to navigate to the Companies screen > Contacts view.

■ Drill down on an email address to open a blank email message addressed to the contact who 
has that address.

Creating Company Assessments (End 
User)
An assessment is a set of attributes used to assess the business potential or credit worthiness of a 
company. Company assessments can be used to compare companies to each other or against a 
model, or to learn about companies and sales situations. End users complete the company 
assessment by selecting the appropriate values for the different attributes.

To perform a company assessment

1 Navigate to the Companies screen > Companies List view.

2 In the Companies list, drill down on the company for which the assessment is being performed.

3 Click the Assessments view tab, and create a new record.

4 In the Template Name field, select the appropriate template.

Attribute records are automatically generated in the Assessment Attributes list. 

5 In the Assessment Attributes list, make a selection in the Value field for each attribute.

NOTE: Administrators must create the assessment templates. See Siebel Applications 
Administration Guide for more information on how to create assessment templates.

Adding Company Applications (End 
User)
Applications are used for companies that want to apply for offered services or products. For example, 
a small business wants to apply for a business checking account. The end user handling the inquiry 
finds the company in the All Companies view, navigates to the Applications view, and creates an 
application record for this business checking account application. 
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To associate an application with a company 

1 Navigate to the Companies screen > Companies List view.

2 In the Companies list, drill down on the company to associate with an application.

3 Click the Applications view tab, create a new record, and complete the necessary fields.

NOTE: Drill down on the Application Name link to enter more detailed application information.

Adding Company Service Requests (End 
User)
A service request is a request from a company for information or assistance with a problem related 
to purchased products or services. When a customer calls about an existing service request, end 
users can find the service request and give status information to the caller in several ways. They can:

■ Review the service request information

■ Create an activity to record the customer’s call

■ Update the service request with additional information from the customer

■ Resolve the service request

■ Assign the service request 

■ Transfer the caller to another service representative

If a call requires that an end user create a new service request, she can create one. Siebel Healthcare 
automatically assigns a unique service request (SR) number to track the new service request 
throughout the system.

To add a service request associated with a company

1 Navigate to the Companies screen > Companies List view.

2 From the Show drop-down list, select All Companies.

3 In the Companies list, drill down on the desired company.

4 Click the Service Requests view tab, create a new record, and complete the necessary fields.

The application automatically assigns a service request number (SR#).
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Managing Company Coverage Teams 
(End User)
A coverage team is the group of employees that are assigned to manage the relationship with a given 
company. The coverage team for a company is defined as all users who have access to the company 
in the My Companies view. 

NOTE: Similar coverage team functionality is also available for contacts. You can use the Contact 
Coverage Team view (Navigate to the Contacts screen > Coverage Team view) to manage the contact 
coverage team.

End users can use the company coverage team functionality available in Siebel Healthcare to:

■ Record and display employees covering a company within a single company record

■ Specify and review the nature of the employee's relationship with each covered company, defined 
as the Coverage Role and Attributes list

To add a member to a coverage team

1 Navigate to the Companies screen > Companies List view. 

2 In the Companies list, drill down on the desired company.

3 Click the Coverage Team view tab, create a new record, and select an employee.

4 If known, select the employee’s coverage role using the drop-down list in the Coverage Role field.

NOTE: The Siebel administrator maintains the Coverage Role LOV in the List of Values screen 
under the Type field value type FINS_COVERAGE_ROLE_TYPE. Navigate to the Administration - 
Data screen > List of Values view, to access the List of Values screen.

5 If desired, scroll down to the Categories and Securities view tabs and select values defining the 
coverage relationship between the employee and the company; you can select one or more 
attributes. 

The application adds the employee to the coverage team with a defined relationship. The 
company will appear in the employee’s My Companies view.

Viewing Company Summaries (End 
User)
The Company Summary view provides a comprehensive view of a company in an editable format. 
This view displays basic company information, financial accounts, call reports, logged alerts, and 
contacts associated with a company. 

To view company summary information

1 Navigate to the Companies screen > Companies List view. 

2 In the Companies list, drill down on the desired company.
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3 Click the Summary view tab.

For more information on editing summary view information, see “Configuring Summary Views” on 
page 18.

Viewing Company Relationship 
Hierarchies (End User)
End users use the Relationship Hierarchy view to identify and capture key relationships for a 
company. This view features a graphical tree that provides a visual representation of a company’s 
relationships. The tree shows the natural hierarchy of a company’s parent-child relationships to 
entities such as companies, subsidiaries, divisions, contacts, and coverage relationships with 
employees, as well as custom-defined relationships.

Custom-defined relationships are ad-hoc associations between the company and any contact, 
organization, household, or employee. End users can record custom-defined relationships between 
any two entities in the adjacent Party Relationships list.

NOTE: The Relationship Hierarchy view is also available on the Contacts, Employee (read only) and 
Households screens. For more information, see “Viewing Contact Relationship Hierarchies (End User)” 
on page 54 and “Using the Household Relationship Hierarchy” on page 60.

To establish a natural parent-subsidiary relationship between two companies

1 Navigate to the Companies screen > Companies List view.

2 In the Companies list, drill down on the company to be established as the subsidiary.

3 Click the More Info view tab.

4 In the Parent field, select the parent company.

5 Repeat Step 2 through Step 4 to set up companies, subsidiaries, branches, and departments as 
needed for your deployment.

6 Click the Relationship Hierarchy view tab.

The new parent-subsidiary relationship is shown in the Relationship Hierarchy explorer in the 
lower-left corner of the screen.

To create a custom-defined relationship

1 Navigate to the Companies screen > Companies List view.

2 In the Companies list, drill down on the company for which you want to create a custom-defined 
relationship.

3 Click the Relationship Hierarchy view tab.



Managing Companies ■ Viewing Company Relationship Hierarchies (End User)

Siebel Healthcare Guide Version 8.0 45

4 In the Party Relationship list, add a record, and complete the necessary fields. 

Some fields are described in the following table.

The newly defined relationship appears in the Relationship Hierarchy explorer.

Field Comments

Relationship Categorizes the relationship between the company and another entity. 
Field has an LOV for custom-defined Relationship values. Predefined 
values include Reports To, Spouse, Child, Lawyer, Board Member, Primary 
Contact (Backup), Admin Assistant, Competitor, Referral, Service 
Provider, Investor, Wealth Management Rep, Related Subsidiary, Bank 
Attorney, Trustee Attorney, and Debtor Attorney.

This LOV can be modified by the Siebel administrator. For more 
information, see “Managing the Custom-Defined Relationship Types LOV” on 
page 35.

Start Date

End Date

If the custom-defined relationship falls:

■ Between the Start and End Dates, it appears in the tree. 

■ Outside the range, it does not appear to the user. The user can enter 
a start or end date, or both.

Type Use this field to determine the type of entity with which you wish to 
establish a relationship. Defaults to Contact. Other values include 
Household, Organization, and Employee.

Value The value in this field is based on the Type field. For example, if Type 
equals Contact, then clicking the select button in the Value field displays 
the Select Contact dialog box.
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5 Managing Contacts

This chapter includes the following topics:

■ “About Managing Contacts” on page 47

■ “Scenario for Adding a New Contact” on page 48

■ “Process of Managing Contacts” on page 48

■ “Managing Contact Information (End User)” on page 49

■ “Creating Customer Assessments (End User)” on page 53

■ “Setting the Customer Value Icon (End User)” on page 54

■ “Viewing a Contact Summary (End User)” on page 54

■ “Viewing Contact Relationship Hierarchies (End User)” on page 54

About Managing Contacts
Contacts are entities or individuals with whom the company does business with or with whom it 
expects to do business with in the future. Contacts includes employees of other companies, 
independent consultants, vendors, or personal acquaintances. Contacts can belong to only one 
company, but they can be part of many opportunities, including opportunities that do not involve 
their companies. Within Siebel Healthcare, contacts are presented in a single view of the customer 
and your relationship with the customer.

CAUTION: This chapter assumes you have renamed Siebel Account objects to Companies. By 
default, Siebel Healthcare installs using the term Accounts. For more information on renaming Siebel 
Account objects, see the Upgrade Guide for your operating system.

End users can:

■ Enter and track information about contacts, which includes products bought, details of signed 
agreements or contracts, and products previously recommended to the customer. 

■ Document marketing campaigns and details of each customer’s response. 

■ Maintain a history of service requests, insurance claims, and product applications that the 
customer has made in the past. 

■ Analyze a customer’s financial health as well as a customer’s needs.

The Contacts screen provides an alternative view of data that is available in other screens. Many 
tasks that can be performed in the Contacts views can also be performed in other screens. For 
example, users can create activities for a contact either in the Contact Activities view, or they can 
go to the My Activities view to enter a new activity, and then associate it with the contact.
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For more information on basic contact functionality and administration, see Siebel Applications 
Administration Guide.

You can save time and reduce keystrokes by using a workflow to automate steps that are repeatedly 
performed by end users. For more information, see Siebel Business Process Framework: Workflow 
Guide. 

Scenario for Adding a New Contact
These scenarios feature sample tasks performed by a sales representative in the healthcare industry. 
Your company may follow a different workflow according to its business requirements. 

Sales Representative Adds a New Contact
At a conference, a new account representative meets a potential customer. The potential customer 
gives the new account representative his business card and informs her that he had recently moved 
to the area and works for a medium sized software company.

The new account representative returns to her office and enters her new acquaintance into Siebel 
Healthcare as a new contact. She can also enter his company information and associate the company 
with the contact. In the Relationship Hierarchy view, she can enter the relationships for this contact, 
including all companies he is associated with, the contact's business partners, lawyer, his family 
members, and other influential relationships. As the creator of this new contact record, she is 
automatically added to the coverage team as the primary representative for the customer. If 
necessary, she can also add the small business manager and other product experts to the coverage 
team so they can see this new contact in their My Contacts view. 

As the customer is looking for personal and business services, the account representative can create 
separate opportunity records in Siebel Healthcare associated with the contact. In the opportunity 
records, she records the products and services the customer is interested in as well as other follow-
up activities to serve the customer's needs.

In the scenario, end users are the new account representatives who manage company information 
in the field. They enter information to:

■ Add a new contact and associate him/her with companies

■ Use the Relationship view to enter all the contact's influential relationships

■ Add other account representatives to the coverage team

■ Create new opportunities associated with the contact

■ Create follow-up activities and assign them to the right representatives to close the potential 
opportunities

Process of Managing Contacts
This section details sample tasks often performed by administrators and end-users when managing 
contacts. Your company may follow a different process according to its business requirements. 
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End-User Procedures
The following list shows tasks end users typically perform when managing contacts:

■ “Managing Contact Information (End User)” on page 49

■ “Creating Customer Assessments (End User)” on page 53

■ “Setting the Customer Value Icon (End User)” on page 54

■ “Viewing a Contact Summary (End User)” on page 54

■ “Viewing Contact Relationship Hierarchies (End User)” on page 54

Managing Contact Information (End 
User)
Contacts are entities or individuals with whom the company currently does business with or with 
whom it expects to do business with in the future. End users manage contact information by:

■ Adding new contacts. See “Adding Contacts” on page 49.

■ Creating contact categories and notes. See “Creating Categories for Contact Information” on 
page 50 and “Creating Notes About Contacts” on page 51.

■ Managing contact referral information. See “Managing Contact Referral Information” on page 51.

Adding Contacts
When end users meet someone in the course of business, they add a contact record for that 
individual to track pertinent personal information and possible potential future business.

NOTE: The Personal Contacts List is different from the Contacts Lists because it is designed for 
contacts not associated with a company. Therefore, in the Personal Contacts List, adding a company 
to a record does not also add it to the My Contacts view, All Contacts view, and so on. End users 
must add business contacts in one of the Contacts List views proper. They must create, review, and 
manage activities for their personal contacts only in the Activities view of the Personal Contacts List 
view, not in the other Contacts views.

To add a contact

1 Navigate to the Contacts screen > Contacts List view.

2 In the Contacts form, click the show more button, add a record, and complete the necessary 
fields.

3 To specify a privacy level, drill down on the contact name link, scroll down to the Privacy Option 
field, and select one of the following:

■ Opt-In. Sharing of non-public personal information is allowed without restrictions.
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■ Opt-Out - Affiliates. Sharing of non-public personal information with affiliates is not 
allowed.

■ Opt-Out - Third Party. Sharing of non-public personal information with third parties is not 
allowed.

■ Opt-Out - All Parties. Sharing of non-public personal information with any affiliate or third 
party is not allowed.

United States law requires that financial institutions disclose their privacy policies regarding the 
sharing of non-public personal information with third parties, and fair credit reporting, that 
impacts the sharing of non-public personal information with affiliates. End users can specify a 
privacy level by making a selection from the Privacy Option field.

The Privacy Option field is for registering the privacy level requested by the contact; it does not 
impact record visibility in any way. 

To associate a contact with a company

1 Navigate to the Contacts screen > Contacts List view.

2 In the Contacts list, drill down on the desired contact.

3 Click the More Info view tab.

4 In the Account Name field, select a record from the list of available companies.

The application automatically associates the company with the contact and populates the address 
with the default company address information. 

5 To change the address, click the select button in the Address Line field, and select an address.

6 To specify an address as the contact’s primary address, click the Primary field.

NOTE: The primary address in the Contact Addresses dialog box appears in the address fields 
on the More Info form.

7 In the Time Zone field, select the contact’s time zone.

Creating Categories for Contact Information
If the default Contacts list and More Info form do not contain fields to track the type of information 
that end users need to track, they can add additional categories. A manager may have set up a list 
of values from which they can select.

To add a category to a contact

1 Navigate to the Contacts screen > Contacts List view.

2 In the Contacts form, query for the desired contact.

3 Drill down on the Last Name link, click the Categories view tab, and create a new record.

4 In the Categories list, select a category from the list of values or create a new category.
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5 Complete the necessary fields.

6 Create additional categories by repeating Step 4 through Step 5.

Creating Notes About Contacts
As end users work with contacts, they learn things they may want to remember. Often these tidbits 
of information are best stored as notes. Users can create notes that everyone with access to the 
contact record can see, or they can create notes that only they can see.

To create a note regarding a contact 

1 Navigate to the Contacts screen > Contacts List view.

2 In the Contacts list, drill down on the desired contact.

NOTE: If the contact does not exist, add it. For more information, see “Adding Contacts” on 
page 49.

3 Click the Notes view tab.

4 From the link bar, select one of the following:

■ Public Notes. Notes that others can see.

■ Private Notes. Notes that only their creators can see.

5 In the Notes list, add a record and complete the necessary fields.

TIP: Click Check Spelling to check the spelling in your note. 

Some fields are described in the following table.

Managing Contact Referral Information
The Referrals view tab allows end users to enter referral information associated with contacts. 
Referrals are potential opportunities. 

In the Referrals tab view, end users can record both referrals they give to their contacts, as well as 
referrals received from a contact.

Field Comments

Created Automatically populates with a date and timestamp.

Type Default value is Note. Select alternate value to categorize the type of 
note.

Description Text field for the content of the note.
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To create a new contact for a referral

1 On the Contacts screen, create contacts. For more information, see “To add a contact” on page 49.

2 Associate those contacts with the new company. For more information, see “To associate a contact 
with a company” on page 50.

3 On Referrals view tab, select the Contact from the Pick Contact dialog box associated with this 
field.

To enter a referral received from a contact

1 Navigate to the Contacts screen > Contacts List view. 

2 In the Contacts list, drill down on the desired contact.

3 Click the Referrals view tab.

4 From the drop-down list, select Referral From This Contact. 

NOTE: View all referrals from the contact by selecting Referrals From This Contact in the drop-
down list.

5 In the form, add a record, and complete the necessary fields.

Some fields are described in the following table.

To create a referral to a contact

1 Navigate to the Contacts screen > Contacts List view.

2 In the Contacts list, drill down on the desired contact.

3 Click the Referrals view tab.

4 Scroll down to the Referrals to This Contact list, and from the drop-down list, select Referrals To 
This Contact.

Field Comments

Company Select an existing company or create a new one. The company selected 
represents the potential opportunity for your organization.

Last Name Select a contact to associate with the referral company, as selected in the 
Company field; if you entered a Company, the list of Contacts is restricted 
to those associated with the selected company.

Referred By Select the employee who made the referral. 
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5 In the list, add a record, and complete the necessary fields.

Some fields are described in the following table.

Creating Customer Assessments (End 
User)
The Contacts Assessments view can help end users qualify contacts. Contact assessments are 
created in the Contacts Assessments view. 

NOTE: A similar assessment functionality is available for companies. For more information, see 
“Creating Company Assessments (End User)” on page 41.

A customer assessment evaluates a contact based on defined criteria. Each assessment template has 
a group of assessment attributes that make up the different measurement points of the assessment. 
A Siebel administrator can create new templates and add or modify assessment attributes. For more 
information on assessment templates and how to define and manage them, see Siebel Applications 
Administration Guide.

To create a customer assessment

1 Navigate to the Contacts screen > Contacts List view.

2 In the Contacts list, drill down on the contact for whom the assessment will be added.

3 Click the Assessments view tab, and create an new record.

4 In the Template Name field, select the desired template. 

Assessment attributes, as defined for the template, are automatically created in the Assessment 
Attributes list.

5 Scroll down to the Assessment Attributes list, and where possible, select a value for each 
attribute by clicking the select button in the Value field.

Field Comments

Disposition The status of the referral.

Company Select an existing company or create a new one. The company 
selected represents the potential opportunity for your service 
provider.

Last Name Select a contact to associate with the referral company, as selected 
in the Company field; if you entered a Company, the list of Contacts 
is restricted to those associated with the selected company.

Referred By Select the employee from your organization who made the referral. 
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Setting the Customer Value Icon (End 
User)
In addition to the customer value assessment tool described in “Creating Customer Assessments (End 
User)” on page 53, there is an alternative customer value measurement device in Siebel Healthcare.

The customer value icon is a series of five stars visible on the contact form. The number of stars 
activated indicates the perceived value of the contact. 

To adjust the customer value stars
■ From the Contacts > More Info view, adjust the value in the Tier field.

Viewing a Contact Summary (End User)
The Contact Summary view provides a comprehensive view of a contact’s relationship with an end 
user’s organization in an editable format. This view displays the customer’s contact information, 
financial accounts, applications, alerts, campaigns targeted at the customer, and service requests 
and opportunities associated with the customer. 

The Customer Value stars on the Contact form indicates the customer’s value to the organization. 
For more information, see “Setting the Customer Value Icon (End User)” on page 54.

To view contact summary information

1 Navigate to the Contacts screen > Contacts List view.

2 In the Contacts list, drill down on a contact.

3 Click the Summary view tab.

For more information on editing summary view information, see “Configuring Summary Views” on 
page 18.

Viewing Contact Relationship 
Hierarchies (End User)
A contact’s relationships are those of influence. End users may have a contact who relies heavily on 
the opinions of others when making purchasing or other decisions. If so, they may want to keep track 
of the relationships between a contact having purchasing authority and those who might influence 
his purchasing decisions.

End users use the Contacts Relationship Hierarchy view to identify and capture key relationships for 
a contact. This view features a graphical tree that provides a visual representation of a contact’s 
relationships. The tree displays both the natural hierarchy of a contact’s parent-child relationships 
to entities such as companies and households, as well as custom-defined relationships.
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Custom-defined relationships are ad-hoc associations between the contact and any other contact, 
organization, or household. End users can record custom-defined relationships between any two 
entities in the adjacent Party Relationships list.

NOTE: The Relationship Hierarchy view is also available on the Companies and Households screens. 
For more information, see “Viewing Company Relationship Hierarchies (End User)” on page 44 and 
“Using the Household Relationship Hierarchy” on page 60.

To view a contact’s relationship hierarchy

1 Navigate to the Contacts screen > Contacts List view.

2 In the Contacts list, drill down on the contact for whom you want to view a relationship hierarchy.

3 Click the Relationship Hierarchy view tab.

The Contacts Relationship Hierarchy view appears.

To define a relationship between contacts

1 Navigate to the Contacts screen > Contacts List view.

2 In the Contacts list, drill down on the contact for whom you want to describe relationships; if the 
contact does not exist, add it. 

For more information on adding contacts, see “Adding Contacts” on page 49.

3 Click the Relationship Hierarchy view tab.

4 In the Party Relationship list, add a record, and complete the necessary fields. 

Some fields are described in the following table.

The newly defined relationship is expressed in the Relationship Hierarchy explorer.

Field Comments

Relationship Categorizes the relationship between the contacts. The field has an LOV for 
Custom Defined Relationship values. Predefined values include Reports To, 
Spouse, Child, Lawyer, Board Member, Primary Contact (Backup), Admin 
Assistant, Competitor, Referral, Service Provider, Investor, Wealth 
Management Rep, Related Subsidiary, Bank Attorney, Trustee Attorney, and 
Debtor Attorney.

The Siebel administrator can modify this LOV. For more information, see 
“Configuring Lists of Values” on page 18.

Type Defaults to Contact. Other values include Household, Organization, and 
Employee.

Value Identifies the other member of the relationship. The values are constrained by 
the Type field selection. For example, if Type equals Contact, then clicking the 
select button displays the Select Contact dialog box.
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6 Managing Households

This chapter includes the following topics:

■ “About Managing Households” on page 57

■ “Scenario for Managing Households” on page 58

■ “Process of Managing Households” on page 58

■ “Adding Households” on page 58

■ “Setting the Household Privacy Option” on page 59

■ “Associating Contacts with Households” on page 59

■ “Viewing Household Summaries” on page 60

■ “Using the Household Relationship Hierarchy” on page 60

About Managing Households
A household is a group of contacts generally sharing a common link or association. Households 
provide valuable segmentation information on the household as a whole, as well as a summary of 
information about the household member contacts. Users can use the Households screen for 
identifying and capturing demographic information about a household. They can also use the 
Households screen to review customer’s financial accounts, products, and contact information 
associated with that household. This information allows them to assess customers’ data.

CAUTION: This chapter assumes you have renamed Siebel Account objects to Companies. By 
default, Siebel Healthcare installs using the term Accounts. For more information on renaming Siebel 
Account objects, see the Upgrade Guide for your operating system.

Grouping all of a customer’s accounts by household allows a service provider to identify a client’s 
real value to the organization and seek opportunities to cross-sell and up-sell additional products and 
services to them, such as homeowners insurance and loans for children’s education. In addition, the 
ability to view all of a customer's financial accounts and related portfolio information by household 
allows an organization to view the household’s overall financial position. 

By following the procedures described in this chapter, users can enter, manage, and review 
information about household members (contacts), accounts, policies, underwriting reports, claims, 
opportunities, activities, service requests, and relationship hierarchies.

NOTE: Many of the views are read-only, as they provide a summary of information about household 
contacts. The only editable views are Contacts and Relationship Hierarchy.

The Households screen and associated views that appear in Siebel Healthcare share much of the 
functionality found in Siebel Business Applications. This chapter focuses on the household 
functionality that is unique to Siebel Healthcare. For more information on basic household 
functionality, see Siebel Applications Administration Guide.
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Scenario for Managing Households
These scenarios are examples of workflows performed by sales representatives and their managers 
in the insurance and healthcare industries. Your company may follow a different workflow according 
to its business requirements.

Household information supports sales and service decisions for segmentation and cross-selling. It 
also provides background information for the finance and insurance industries about a household and 
all of its contacts.

A sales representative uses the Household screen for identifying and capturing demographic and 
relationship information about the household, and for reviewing policies and products associated 
with that household. From the Households screen, the sales representative creates a new household 
for a new customer. He then adds contacts to the household. 

Some weeks later, the sales representative wants to review household information. He navigates to 
the My Households view, and then selects the Insurance Summary view to review a list of contacts, 
service requests, policies and quotes, and claims associated with a household.

In this scenario, end users are the sales representatives who manage household information in the 
field. They enter and review information to:

■ Add a household

■ Add a contact to a household

■ View household summary information

■ View household relationships

■ View household policies

Process of Managing Households
This section details sample tasks often performed by end-users when managing households. Your 
company may follow a different process according to its business requirements. 

■ “Adding Households” on page 58

■ “Setting the Household Privacy Option” on page 59

■ “Associating Contacts with Households” on page 59

■ “Viewing Household Summaries” on page 60

■ “Using the Household Relationship Hierarchy” on page 60

Adding Households
End users can collect and manage information about a customer’s household. Households are added 
from the Households screen. For detailed information on how to add a household see Siebel 
Applications Administration Guide.
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Setting the Household Privacy Option
United States law requires that financial institutions disclose their privacy policies regarding the 
sharing of non-public personal information with third parties, and fair credit reporting, that impacts 
the sharing of non-public personal information with affiliates. End users can specify a privacy level 
by making a selection from the Privacy Option field.

The Privacy Option field is for registering the privacy level requested by the household; it does not 
impact record visibility in any way. 

To set the privacy option for a household

1 Navigate to the Households screen > List view. 

2 To specify a privacy level, scroll down to the Privacy Option field and select one of the following:

■ Opt-In. Sharing of non-public personal information is allowed without restrictions.

■ Opt-Out - Affiliates. Sharing of non-public personal information with affiliates is not 
allowed.

■ Opt-Out - Third Party. Sharing of non-public personal information with third parties is not 
allowed.

■ Opt-Out - All Parties. Sharing of non-public personal information with any affiliate or third 
party is not allowed.

Associating Contacts with Households
Contacts are persons associated with a household. End users can specify one person in the household 
as the head of household and then identify the others as spouse, child, or dependent parent.

To add a contact to a household

1 Navigate to the Households screen > List view.

2 In the Households list, drill down on the household to which the contacts will be added.

3 Click the Contacts view tab.

4 In the Contacts list, click Add, and do one of the following:

■ Select an existing contact and click OK.

■ Perform a query to choose an existing contact. 

■ Select New to add a new contact.

The contact is associated with the household.

NOTE: In the Households screen, a contact’s address is his or her residential or personal 
address. In the Contact’s screen, a contact’s address is his or her work address. Household 
addresses can only be selected from among residential addresses.
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Viewing Household Summaries
The Household Summary view provides a comprehensive view of the household’s relationship with 
an end user’s organization in an editable format. This view displays basic information about the 
household, contacts, financial accounts, and past or pending service requests. 

To view household summary information

1 Navigate to the Households screen > List view.

2 In the Households list, drill down on the household, and click the Summary view tab.

Using the Household Relationship 
Hierarchy
End users use the Household Relationship Hierarchy view to identify and capture key relationships 
for a household. This view features a graphical tree that provides a visual representation of a 
household’s relationships, which includes its natural relationships to the household contacts as well 
as custom-defined, ad-hoc relationships. 

Users can create custom-defined relationships between a household and any contact or organization. 
End users can record custom-defined relationships between any two entities in the adjacent Party 
Relationships list.

NOTE: The Relationship Hierarchy view is also available on the Contacts and Companies screens. For 
more information, see “Viewing Contact Relationship Hierarchies (End User)” on page 54 and “Viewing 
Company Relationship Hierarchies (End User)” on page 44.

To create a custom-defined relationship

1 Navigate to the Households screen > List view.

2 In the Households list, drill down on the household for which you wish to define relationships.

3 Click the Relationship Hierarchy view tab, and in the Party Relationship list, add a record.
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4 Complete the necessary fields.

Some fields are described in the following table.

.

The newly defined relationship appears in the Relationship Hierarchy explorer.

Field Comments

Relationship The value in this field categorizes the relationship between the household 
and the other entity. The field has an LOV for custom-defined Relationship 
values. Predefined values include Reports To, Spouse, Child, Lawyer, 
Board Member, Primary Contact (Backup), Admin Assistant, Competitor, 
Referral, Service Provider, Investor, Wealth Management Rep, Related 
Subsidiary, Bank Attorney, Trustee Attorney, and Debtor Attorney. This 
LOV can be modified by the Siebel administrator. For more information, 
see “Configuring Lists of Values” on page 18.

Type The value in this field determines the type of entity with which you wish 
to establish a relationship. Defaults to Contact. Other values include 
Household, Organization, and Employee.

Value The value in this field is based on the Type field. For example, if Type 
equals Contact, then clicking the select button in Value field displays the 
Select Contact dialog box.
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7 Managing Call Reports

This chapter includes the following topics:

■ “About Managing Call Reports” on page 63

■ “Scenario for Managing Call Reports” on page 64

■ “Process of Managing Call Reports” on page 64

■ “Viewing Call Report Charts” on page 65

■ “Activating the New Call Report Workflow” on page 66

■ “Managing Call Report Templates” on page 67

■ “Adding Call Reports (End User)” on page 67

■ “Creating Call Report Distribution Lists (End User)” on page 69

■ “Associating Action Items, Notes, and Attachments with Call Reports (End User)” on page 69

■ “Setting the Call Report Privacy Flag (End User)” on page 70

■ “Emailing and Printing Call Reports (End User)” on page 70

About Managing Call Reports
Call reports are records of meetings and other conversations with clients, organizations, and 
individuals. Call reports are often required of employees because they:

■ Are a means for new relationship managers to learn about the client and its history with the 
organization.

■ Allow senior managers and product specialists associated with a certain client to keep up with 
the developments in the client relationship, even if they do not meet with the client on a regular 
basis.

■ Provide a record of important and informal agreements. In the event that a failed financing 
transaction results in legal proceedings, these reports are an important component of the legal 
process.

Administrators use these procedures to view a chart of call reports and manage call report templates. 
End users use the Call Reports screen to add a new call report, create a call report distribution list, 
designate a report as private, and email or print call reports.

Siebel Healthcare can provide notification of new call reports to designated individuals. For more 
information, see Siebel Business Process Framework: Workflow Guide.
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Scenario for Managing Call Reports
This scenario features sample tasks performed by a sales representative at a healthcare company 
and his manager. The scenario outlined in this section is based on the business requirements of the 
healthcare industry. Your company may follow a different workflow according to its business 
requirements. 

 After returning to the office following a successful meeting with the client, a sales representative for 
the Large Group Division of a healthcare company loads Siebel Healthcare to complete his call report. 
The representative navigates to his calendar and marks the meeting as Done. He then navigates to 
the Call Reports screen and enters a new call report to document the meeting. In the Report Detail 
view, he types a brief log of the meeting and adds the names of contacts and employees who 
participated.

Upon completing his report, the sales representative turns to the action items that resulted from the 
meeting. First, he needs to send an email to a fellow employee to tell her about the meeting. He uses 
the Email Report button on the Call Report form to accomplish this task. 

Next, he remembers that he promised to include the client on the invitation list for the upcoming 
Charity Ball, so he adds an action item on the Call Reports Action Items view tab. He does this by 
clicking Add Action Items on the Call Report form. After he enters his action item, along with several 
others, he assigns them to members of his team for follow-up. 

The sales representative’s boss is also a member of the client team. When she arrives in the office 
the next day and loads Siebel Healthcare, she reviews the new call reports on the Call Reports 
screen, reading about the meeting details and notes. 

In this scenario, managers or Siebel administrators can use Siebel Healthcare to view graphical 
representations of their call reports, and perform volume analysis of their own calls, their team’s 
calls, or all call reports.

The end users are sales representatives who create call reports to record their meetings and 
activities. They enter information to:

■ Create new call reports 

■ Create call report distribution lists

■ Create call report action items

■ Attach related documents

■ Specify a call report as private

■ Review and add additional notes or comments

■ Email or print call reports

Process of Managing Call Reports
This section details sample tasks often performed by administrators and end-users when managing 
call reports. Your company may follow a different process according to its business requirements.
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Administrator Procedures
The following list shows tasks administrators typically perform to manage call reports:

■ “Viewing Call Report Charts” on page 65

■ “Activating the New Call Report Workflow” on page 66

■ “Managing Call Report Templates” on page 67

End-User Procedures
The following list shows tasks end users typically perform when managing call reports:

■ “Adding Call Reports (End User)” on page 67

■ “Creating Call Report Distribution Lists (End User)” on page 69

■ “Associating Action Items, Notes, and Attachments with Call Reports (End User)” on page 69

■ “Setting the Call Report Privacy Flag (End User)” on page 70

■ “Emailing and Printing Call Reports (End User)” on page 70

Viewing Call Report Charts
As a manager or Siebel administrator, you can use the Call Report Charts view for call volume 
analysis of your own calls, your team’s calls, or all call reports in Siebel Healthcare. Use this view to 
analyze call volume and call types by employee and by customer, in order to determine which clients 
are receiving the most service.

To view a chart for your call reports

1 Navigate to the Call Reports screen > Call Report List view.

2 From the visibility filter, select one of the following:

■ My Call Reports

■ My Team’s Call Reports

■ All Call Reports

The view selected returns an appropriate set of call report records to be analyzed.

3 Click the Charts link on the link bar.

The chart reflects only those call report records in the current query; that is, those records listed 
in the Call Reports list preceding the chart.
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4 From the lower Show drop-down list, select one of the following chart types:

NOTE: Place your cursor over any chart segment to reveal additional information about that 
segment. Click a segment to drill down and refocus on just the call reports in that segment.

Activating the New Call Report Workflow
When activated, the New Call Report Workflow allows end users to create call report records 
automatically from the Contacts, Companies, Activities, and Opportunities screens. After the 
administrator activates the New Call Report Workflow, the New Call Report icon appears in the upper-
left corner of those screens for end users.

To activate the New Call Report Workflow

1 Navigate to the Administration - Business Process screen > Workflow Deployment view.

2 In the Repository Workflow Processes list, query for the New Call Report Workflow record.

3 Click the Activate button at the top of the list to activate this workflow process.

When activated, the definition is written to the run-time tables and appears in the Active 
Workflow Processes view.

To use the New Call Report feature after it is activated, end users can do one of the following: 

■ Click the icon

■ Choose File > Auto > Call Report from the application-level menu 

■ Use the short cut key Alt+P

NOTE: The New Call Report Workflow uses the Data Transfer Utility business service to transfer fields 
from one view to another. For information on modifying the New Call Report Workflow, so that it is 
available from more screens, or populating more fields when moving from one screen to the next, 
see “Using Data Transfer Utilities (DTU)” on page 204 for details on the Data Transfer Utilities business 
service. The current Data Map Objects used for the New Call Report in the Data Transfer Utility 
business service include: New Call Report - Account, New Call Report - Activity, New Call Report - 
Contact, and New Call Report - Opportunity.

Chart Comments

Call Type Analysis A breakdown of all selected call reports by Call Type.

Call Volume Analysis Charts the number of calls per month, quarter, or year.

Call Volume by Employee Charts the number of calls per month, quarter, or year, per 
employee.

Company Calling Analysis Charts the number of calls per company.

Employee Calling Analysis Charts the number of calls per company, by employee.



Managing Call Reports ■ Managing Call Report Templates

Siebel Healthcare Guide Version 8.0 67

Managing Call Report Templates
You can email call reports. Emailed call reports, like other communications in Siebel applications, use 
templates to automatically format information in a message sent as an email. When you email a call 
report, Siebel Healthcare uses the Call Report Email template to populate the email message. 

For more information on configuring communication templates, see Siebel Communications Server 
Administration Guide.

To view or change the call report email template 

1 Navigate to the Administration - Communications screen > All Templates view. 

2 In the Templates list, query for the template named Call Report Email.

3 Review or change the call report in the Call Report Email form.

Siebel Healthcare provides additional syntax for customizing message templates, offering a way to 
embed multi-value fields within the body of the message templates. As an example of this syntax, 
examine the template text for the Call Report Email template. 

Adding Call Reports (End User)
End users add call reports to create a record of meetings and other conversations with clients, 
organizations, and individuals.

To add a call report

1 Navigate to the Call Reports screen > Call Report List view.
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2 In the Call Report form, add a record and complete the necessary fields. 

Some fields are described in the following table.

NOTE: In the Call Reports list, the New flag is a calculated field and appears checked for five 
days after the creation of a call report. Your systems administrator can change this setting. 

3 In the Call Reports list, drill down on the Description link to navigate to the Report Detail view.

4 In the Employees and Contact lists, enter detailed information about the call. 

Information you enter here appears in emailed or printed call reports.

Field Comments

Associated 
Activity

The activity that is the subject of the call report; each call report can have 
only one associated activity. Selection of the associated activity is 
governed by the following constraints if those fields are populated:

■ Same Company ID

■ Same Primary Opportunity ID

■ Same Primary Contact ID

Contacts Enter the participating contacts who were at the meeting. Designate a 
primary contact if desired, otherwise the first contact selected is defaulted 
as the primary. Entries appear in the Report Detail view and on the printed 
Call Report.

Description A summary description of the call report; enter a more detailed report in 
the Report Detail view.

Distribution List additional employees from your organization who should receive the 
Call Report, but should not appear on the list of participants. The call 
report creator and all Employee Participants are automatically placed on 
the distribution list.

Employees List employees from your organization who participated in the call. Entries 
appear in the Report Detail view and on the printed Call Report. The call 
report creator is automatically listed as a participant.

Opportunity Associate an opportunity with the call report. You can view all call reports 
associated with any given opportunity from the Opportunities screen.

Type The LOV type for this field is FINCORP_CALLRPT_CONTACT_TYPE.
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Creating Call Report Distribution Lists 
(End User)
A distribution list is the list of contacts who need to know what is happening with a particular client. 
Usually, it is the coverage team for the client, plus any additional employee participants. The 
application automatically places the call report creator and each employee participant on the 
distribution list. For other employees, such as the coverage team, to receive a call report, end users 
must manually add them to the distribution list.

When end users use the call report Email Report feature, the distribution list controls who receives 
the report. The call report Print Report function and the Send Email function, both available through 
the application-level File menu (F9), are not affected by the distribution list.

To create a distribution list

1 Navigate to the Call Reports screen > Call Report List view.

2 In the Call Reports list, drill down on the call report for which you want to create a distribution 
list.

3 In the Distribution field, select one or more employees to add to the distribution list.

The selected name or names are added to the distribution list.

Associating Action Items, Notes, and 
Attachments with Call Reports (End 
User)
After an end user has added a call report, they can associate it with action items, notes, and 
attachments.

NOTE: Call report attachments, like the attachments for other activities, are stored in the 
S_ACTIVITY_ATT table. 

To associate action items, notes, and attachments

1 Navigate to the Call Reports screen > Call Report List view.

2 In the Call Reports list, drill down on the desired call report.

3 To add notes or action items to the call report, in the Call Report form click the appropriate view 
tab:

■ Notes. Adds notes or comments.

■ Action Items. Adds an action item.

4 To attach external documents to a call report, click the Attachments view tab, and choose a file 
or select a URL.
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Setting the Call Report Privacy Flag (End 
User)
Certain call reports may contain sensitive or confidential information about a given company or 
opportunity. Users can designate certain calls as private by clicking the Private check box in the call 
report form or list. After a call report is marked as private, only those employees on the employees 
list can access it. 

To set a privacy flag

1 Navigate to the Call Reports screen > Call Report List view.

2 In the Call Reports list, select the desired call report, and click the Private field.

The call report is now categorized as private. Only the employees on the employees list can 
access it.

Emailing and Printing Call Reports (End 
User)
You can email or print call reports for distribution and record keeping. First, submit a call report and 
then email or print the report.

To submit a call report

1 Navigate to the Call Reports screen > Call Report List view.

2 In the Call Reports list, select the call report to submit.

3 In the Call Report form, select Submitted from the drop-down list.

To email or print a call report

1 Navigate to the Call Reports screen > Call Report List view.

2 In the Call Reports list, drill down on the call report to email or print.



Managing Call Reports ■ Emailing and Printing Call Reports (End User)

Siebel Healthcare Guide Version 8.0 71

3 In the Call Report form, do one of the following:

To... Click...

Email the report. Email Report.

The report is automatically emailed to 
everyone on the distribution list.

Print the report. The toolbar Reports icon.

In the Reports dialog box, select 
Summary or Detail and click Run.
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8 Facilities

Facilities are healthcare organizations that are paid by or file claims with your health plan or health 
insurance company. Examples of facilities are hospitals, clinics, and pharmacies. Facilities are also 
referred to as provider organizations.

Using the procedures given in this chapter, you will be able to perform the administrator tasks of 
adding facilities to Facility Locator. End users use the Facilities screens to associate providers, 
facilities, and contacts with a facility, add a facility contract, add a facility payment, and add a facility 
claim.

This chapter includes the following topics:

■ Scenario for Adding a New Healthcare Facility

■ Administrator Procedures for Facilities on page 74

■ Adding Facilities to the Facility Locator on page 74

■ End-User Procedures for Facilities on page 74

■ Adding Facilities on page 75

■ Associating Providers, Facilities, and Contacts with a Facility on page 75

■ Adding Facility Contracts on page 75

■ Adding Facility Payments on page 76

■ Adding Facility Claims on page 76

Scenario for Adding a New Healthcare 
Facility
This scenario features sample tasks performed by a contracting specialist. Your company may follow 
a different workflow according to its business requirements.

In this scenario, a contracting specialist for a health plan is responsible for managing information 
about the healthcare facilities, such as hospitals and healthcare networks, with which your company 
does business. She just established a contract with a single facility.

She adds the new facility to the Siebel database. Next, she adds information about the facility’s 
business hours and specialties. Then, she associates the facility with individual providers and with 
other facilities. Next, she adds information about contracts the facility holds with your company along 
with the facility’s payment preferences.

In this scenario, the end users are contracting specialists for a health plan. They enter information 
to:

■ Add new facilities
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■ Associate providers, facilities, and contacts with a facility

■ Add facility contracts, facility payments, or facility claims

Administrator Procedures for Facilities
The following administrator procedure is described in this section:

■ “Adding Facilities to the Facility Locator” on page 74

Adding Facilities to the Facility Locator
As an administrator, you can add facilities to the facility locator. The facility locator searches for 
facilities using latitude and longitude. If you do not know the latitude and longitude, leave those 
fields blank. If the City, State, Zip Code, and Country fields are correct, the latitude and longitude 
values will automatically generate when you save the facility. 

NOTE: The latitude and longitude values will not generate if any one value in the City, State, Zip 
Code, or Country fields is incorrect. For example, if the ZIP Code is incorrect, you will receive an 
error message. To correct this problem, navigate to the Application Administration, ZIP Code 
Administration view and make sure the Geo values for that city, state, and ZIP Code combination has 
been loaded. For more information, see Siebel eService Administration Guide.

To add a facility to the facility locator

1 Navigate to Site Map > Administration - Application > Branch Locator.

2 In the Branch Locations list, add a record.

3 In the Branch Locations list, complete the necessary fields.

End-User Procedures for Facilities
The following end-user procedures are described in this section:

■ “Adding Facilities” on page 75

■ “Associating Providers, Facilities, and Contacts with a Facility” on page 75

■ “Adding Facility Contracts” on page 75

■ “Adding Facility Payments” on page 76

■ “Adding Facility Claims” on page 76
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Adding Facilities
End users can add or change healthcare facility records. After users add facility records in the 
Facilities screen, they can view them in both the Facilities screen and the Companies screen. In the 
Companies screen, a check mark appears in the Facility field of the record, indicating that the 
company is a facility.

NOTE: If users add healthcare facility records in the Companies screen, they will not appear in the 
Facilities screen.

To add a facility

1 Navigate to the Facilities screen > Facility List view. 

2 In the Facilities list, add a record and complete the necessary fields.

NOTE: Records in the Facilities list contain a few of the most frequently used facility fields. You 
can add text into additional fields, such as Main Office, in the More Info form.

Associating Providers, Facilities, and 
Contacts with a Facility
Facilities usually have affiliations with providers, other facilities, or contacts. For example, a hospital 
may be affiliated with a clinic.

To associate a provider, facility, or contact with a facility

1 Navigate to the Facilities screen > Facility List view. 

2 In the Facilities list, drill down on the facility to associate with a provider, facility, or contact.

3 Click the appropriate view tab:

■ Summary. To associate a contact with a facility, use the Contacts list on this view tab.

■ Affiliated Providers. To associate a provider with a facility.

■ Facility Affiliations. To associate a facility with another facility.

4 Add a record and either select an existing contact, provider, or facility or add a new one.

Adding Facility Contracts
A company may have contracts for its healthcare products with a facility or provider organization, in 
addition to contracts with individual providers. For example, they may have a contract with a 
pharmacy or clinic. Each contract is based upon one of the company’s healthcare products and may 
have different terms, payment preferences, and payment methods.
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End users can set up payment preferences and payment methods for facilities. Their company may 
have more than one contract with a facility. They can set up different payment arrangements and 
methods for each contract.

To add a facility contract

1 Navigate to the Facilities screen > Facility List view. 

2 In the Facilities list, drill down on the desired facility. 

3 Click the Contracts view tab.

4 In the Contracts list, add a record and complete the necessary fields.

5 If payments will be made by EFT or check, scroll down to the Payment Preferences - Check form 
and select one of the following from the drop-down list:

■ Payment Preferences - Check. To add information for check payments.

■ Payment Preferences - EFT. To add information for electronic funds transfer payments.

6 Complete the necessary fields.

Adding Facility Payments
End users can add information about payments their company makes to facilities. Payment 
information can include payment amount and payment date.

Facility payments may be imported from a bill payment engine by using Siebel Enterprise Application 
Integration. For more information, see “Integration” on page 133 and Overview: Siebel Enterprise 
Application Integration.

To add a facility payment

1 Navigate to the Facilities screen > Facility List view. 

2 In the Facilities list, drill down on the desired facility.

3 Click the Payments view tab.

4 In the Payment list, add a record and complete the necessary fields.

NOTE: Records in the Payments list contain a few of the most frequently used payment fields. 
To add text into additional fields, such as Check #, scroll down to the Payment Details form.

Adding Facility Claims
A contract with a facility may specify that the facility should be paid each time it provides a service 
to a member. If so, the facility or member may contact a company to initiate claims for payment.
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Facility claims may be imported from a claims processing engine, by using Siebel Enterprise 
Application Integration. For more information, see “Integration” on page 133 and Overview: Siebel 
Enterprise Application Integration.

To add a facility claim

1 Navigate to the Facilities screen > Facility List view. 

2 In the Facilities list, drill down on the desired facility.

3 Click the Claims view tab.

4 In the Claims list, add a record.

5 In the Add Claims dialog box, perform the appropriate task:

■ To choose an existing record, select a record and click OK.

■ To add a new record, click New and complete the fields.
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9 Individual Health Policies

Individual health policies are insurance policies issued to individuals for themselves and their family 
members or dependents. Each individual health policy includes one primary member and may include 
additional members.

Each individual health policy offers one or more products, called policy coverages. Examples of 
individual health insurance products are HMO, PPO, dental, and vision coverage.

The Individual Health Policies screen allows end users to manage individual health insurance policies. 
Using the procedures given in this chapter, end users can generate quotes, accept applications, 
handling service requests, and process claims.

NOTE: In order to generate quotes from the Individual Health Policies screen, you must purchase 
the Siebel Proposals & Presentations module.

For more information on views common to all policy screens, see “Common Policy Views” on page 88.

This chapter includes the following topics:

■ Scenario for Health Insurance Quote and Application

■ Administering Individual Health Policies on page 80

■ Adding Insurance Products and Product Lines on page 80

■ Adding Insurance Rate Bands on page 81

■ End-User Procedures for Individual Health Policies on page 82

■ Providing Individual Health Policy Quotes on page 82

■ Accepting Individual Health Policy Applications on page 83

■ Adding Service Requests to Individual Health Policies on page 85Setting Up Pay Plans for Individual 
Health Policies on page 85

Scenario for Health Insurance Quote and 
Application
This scenario features sample tasks performed by a licensed sales representative. Your company may 
follow a different workflow according to its business requirements.

In this scenario, a licensed sales representative for an insurance company is on the phone with a 
prospective customer who has called to request a quote for individual health insurance.
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The sales representative adds information about the prospect and the prospect’s dependents 
(including coordination of benefits). The prospect requests a quote for PPO coverage, dental 
insurance, and vision insurance. The sales representative adds the products and reviews the product 
attributes. Next, he asks the prospect for enough information to provide an initial premium quote to 
the prospect. He gives the prospect a verbal quote and ends the conversation. 

One week later, he receives an email message that the prospect has called back and would like to 
purchase a policy. In Siebel Healthcare, he adds information about coverages for each applicant 
according to the needs of the prospect. In this case, one of the dependents will receive both dental 
and vision coverage. Another will receive vision coverage only. Therefore, he associates the first 
dependent with both vision and dental, and the second dependent with vision only. Next, he 
schedules an activity as a reminder to call the prospect back with the revised premium information.

During the second call, he gathers information from the prospect in order to process the application. 
First, he performs a health risk assessment for each applicant. Then he adds billing and payment 
arrangements. Finally, he follows the procedures implemented by his company to submit the policy 
for issuance and billing.

In this scenario, end users are a sales representatives who manages customer requests. They enter 
information to:

■ Generate customer quotes

■ Add an applicant

■ Perform a health risk assessment

■ Convert a quote to an active policy

■ Associate a policy coverage with an applicant

■ Add a service request

■ Set up a payment plan

■ Add detailed payment information for a payment plan

Administering Individual Health Policies
The following administrator procedures are described in this section:

■ “Adding Insurance Products and Product Lines” on page 80

■ “Adding Insurance Rate Bands” on page 81

NOTE: Only those with Siebel administrator responsibilities can change entries in the Administration 
- Insurance and Administration - Product screens.

Adding Insurance Products and Product 
Lines
As an administrator, you can add products to the Siebel database. This section describes the 
procedure for setting up products and product lines in general terms. 
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You can also specify that a product line is one that your company contracts agencies to sell, or that 
the state licenses agencies to sell, or both.

For more information about adding product and product lines, see Siebel Product Administration 
Guide and Siebel Applications Administration Guide.

To add an insurance product

1 Set up the product class structure, including product class attributes.

2 Add the products to the Siebel database and associate them with the appropriate class. 

3 In the Category field in the Products list, select Individual Health Insurance.

4 Include the product in a product line.

To specify product line type

1 Navigate to Site Map > Administration - Product > Product Lines.

2 In the Product Line list, select the desired product line record and then check one or both of the 
following fields:

■ Contracting. To specify that the product line is one that your company contracts agencies 
to sell.

This product line will appear to end users as a choice in the Lines of Business dialog box in 
the Partners screen > Contracts view tab.

■ Licensing. To specify that the product line is one that agencies can be granted a state license 
to sell.

This product line will appear to end-users as a choice in the Lines of Business dialog box in 
the Partners screen > Licenses & Appointments view tab.

Adding Insurance Rate Bands
After you add a product in the Administration - Product screen, you can use the Administration - 
Insurance screen to associate a rate band with the product. 

A rate band is pricing information about the deductible, the premium, and the payroll deduction for 
each insurance product. 

To add a rate band

1 Navigate to Site Map > Administration - Insurance > Health and Group Products.

2 In the Products list, select a product.

3 In the Rate Bands list, add a record and complete the necessary fields.
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End-User Procedures for Individual 
Health Policies
The following end-user procedures are described in this section:

■ “Providing Individual Health Policy Quotes” on page 82

■ “Accepting Individual Health Policy Applications” on page 83

■ “Adding Service Requests to Individual Health Policies” on page 85

■ “Setting Up Pay Plans for Individual Health Policies” on page 85

Providing Individual Health Policy 
Quotes
In Siebel Healthcare, a quote is a policy that has not been issued. End users can provide a quote for 
a new policy or make changes to an existing quote. The following procedure shows how to provide 
a quote for a new policy. The Individual Health Policies screen captures the information necessary to 
generate a quote. If a plan has predefined rates for individuals, Siebel Healthcare can access this 
information in two ways:

■ Using Siebel Pricer. For information, see Siebel Pricing Administration Guide.

■ Using an external table that your company has integrated with Siebel Healthcare.

To provide a quote

1 Navigate to the Individual Health Policies screen.

2 In the Individual Health Policies list, add a record and complete the necessary fields.

3 To add a new applicant:

a Click the Applicants view tab.

b Scroll down to the Applicants form and add a record.

c In the Add Applicants dialog box, select an existing applicant or click New to add a new applicant.

If you select an existing contact who is not a member, the Coordination of Benefits field will 
not be hyperlinked to the Members > Applicants view.

d Repeat Step 3 for each new applicant that you want to add to this quote.

4 To select an existing contact:

a Click the Applicants view tab.

b Scroll down to the Applicants form and click the Show More button.

c In the Applicants form, add a record.
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d In the Add Applicants dialog box, select a record and click OK.

NOTE: If you select an existing contact who is not a member, the Coordination of Benefits 
field will not be hyperlinked to the Members > Applicants view.

e To specify a contact as a member, select the Members check box.

After you save the record, the Coordination of Benefits value is hyperlinked to the Members 
> Applicants view.

f If you plan to add records to the Coordination of Benefits field, select the Coordination of Benefits 
check box.

After you save the record, the Coordination of Benefits field changes to Yes.

g Repeat Step 4 for each existing contact that you want to add to this quote.

NOTE: For information about Coordination of Benefits, see “Adding Additional Benefits 
Coverage for Members” on page 109.

5 In the Applicants list, select the record for the primary applicant for this quote and click the 
Primary field.

A check mark appears, indicating that this applicant is the primary applicant.

NOTE: If you do not select the primary field for one of the applicants, you will not be able to 
successfully add a product in the Policy Coverages view.

6 Click the Policy Coverages view tab.

7 In the Policy Coverages product list, add a record and complete the necessary fields.

8 Repeat Step 6 and Step 7 for each product you would like to add for this applicant.

After end users generate the quote, the Primary field is automatically added. The quote for this 
applicant appears in the Premium Totals field in the Policy Coverages list.

Accepting Individual Health Policy 
Applications
Accepting applications requires adding applicants, performing health risk assessments for each 
applicant, and associating policy coverages with each applicant. If end users have already provided 
a quote for an application, they can begin by performing a health risk assessment for each applicant 
listed in the quote.

To add an applicant

1 Navigate to the Individual Health Policies screen.

2 Click the Applicants view tab.

3 In the Applicants list, add a record.

4 In the Add Applicants dialog box, perform the appropriate task:
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■ To choose an existing record, select a record and click OK.

■ To add a new record, click New and complete the fields.

NOTE: The Primary field is filled automatically after you generate a quote.

5 Repeat Step 3 and Step 4 for each applicant you would like to add.

6 In the Applicants list, select the record for the primary applicant for this quote and click the 
Primary field.

A check box appears in the Primary field.

7 If the check box is empty, select it.

A check mark appears, indicating that the selected applicant is the primary applicant.

After end users add an applicant, they need to perform a health risk assessment for each one.

To perform a health risk assessment

1 Navigate to the Individual Health Policies screen.

2 In the Individual Health Policies list, select a record.

3 Click the Health Risk Assessments view tab.

The Health Risk Assessments form appears, showing the selected record. 

4 Scroll down to the Risk Assessment form, add a record, and complete the necessary fields

5 Repeat Step 4 for each applicant.

After end users complete the risk assessment, they can convert the quote to an active policy.

To convert a quote to an active policy

1 Navigate to the Individual Health Policies screen.

2 In the Individual Health Policies list, select a record.

3 Click the Applicants view tab and scroll up to the Individual Health Policies form.

4 In the Individual Health Policies, More Info form, change the following fields:

a In the Status field, select Inforce.

b In the Effective Date field, add the date that the policy will go into effect.

After end users convert the quote to an active policy, they can associate policy coverages with an 
applicant.

To associate policy coverages with an applicant

1 Navigate to the Individual Health Policies screen.

2 Select the record in the Individual Health Policies list for which you would like to set up policy 
coverages.
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3 Click the Member Coverages view tab.

4 In the Member Coverages product list, add a record, and complete the necessary fields.

5 Repeat Step 4 for each additional applicant.

NOTE: You can also use the Member Coverage Matrix view to select applicant and dependent 
coverages. However, the Member Coverage view should be used to associate a primary care 
provider. For additional information, see “Changing the Primary Network or IPA for Members” on 
page 109.

Adding Service Requests to Individual 
Health Policies
End users can add service requests for individual health policies. Examples of service requests are a 
change of primary care provider, a request for literature, or a question about an insurance claim.

To add a service request

1 Navigate to the Individual Health Policies screen.

2 In the Individual Health Policies list, select a policy.

3 Click the Service Requests view tab.

4 In the Service Requests list, add a record and complete the necessary fields.

Setting Up Pay Plans for Individual 
Health Policies
End users can use the Pay Plans view tab to set up pay plans for individual health insurance policies 
and to add details about payment methods and due dates.

To set up a pay plan for an individual health policy

1 Navigate to the Individual Health Policies screen.

2 In the Individual Health Policies list, select a policy, and click the Pay Plans view tab.

3 In the Pay Plan list, add a record and complete the necessary fields.

4 Scroll down to the Payment Details form and update the statement information.

a In the Last Name field, click the select button.

b In the Pick Contact dialog box, select a name and click OK.
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10 Managing Group Policies

This chapter contains the following topics:

■ “About Group Policies” on page 87

■ “Scenario for Group Policies” on page 88

■ “Process of Managing Group Policies” on page 89

■ “Adding Group Insurance Products and Product Lines” on page 90

■ “Adding Group Insurance Rate Bands” on page 91

■ “Defining Activity Plan Templates for Group Policies” on page 91

■ “Defining Proposal Templates for Group Policies” on page 92

■ “Adding Group Policy Records” on page 92

■ “Importing Census Information” on page 93

■ “Adding Census Information in the Group Policies Screen” on page 94

■ “Adding Employee Classes for Group Policies” on page 95

■ “Designing Plans for Group Policies” on page 95

■ “How Enrollment Waiting Periods Affect the Start of Coverage” on page 97

■ “Reconfiguring Customizable Products in Plan Design” on page 98

■ “Generating Proposals for Group Policies” on page 98

■ “Managing Underwriting Information” on page 99

■ “Adding Eligible Members to Group Policies” on page 100

■ “Enrolling Members in Group Policies” on page 100

■ “Adding Beneficiaries to Group Policies” on page 101

■ “Setting Up Payment Plans for Group Policies” on page 101

About Group Policies
Group policies are insurance policies sold to a group on behalf of its members. The group is the 
insured party and can be an employer purchasing insurance for its employees, a group of employers 
who are purchasing insurance together, or an association or club purchasing insurance for its 
members.

Each group policy can offer many products. Group insurance products include group life, 
supplemental group life, group disability, group health, vision, and dental.
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Some group policies, especially those for larger groups, offer different products to different employee 
classes of group members. Examples of employee classes are salaried employees and hourly 
employees.

Group members have the option to accept coverage that is available for their class. Group members 
who accept coverage are enrolled in the policy and are considered the primary member of the policy. 
Enrolled members are usually referred to as members (for health insurance) or policyholders (for 
other kinds of insurance).

Primary members can choose products for themselves and for family members or dependents. 
Usually, different products are available for primary members and for other policy members.

The Group Policies screen allows users to manage group insurance. Specifically, it allows end users 
to generate proposals, create policies and quotes, add employee classes, design plans, enroll 
members, and provide service for the policy.

NOTE: In order to generate proposals from the Group Policies screen, you must purchase the Siebel 
Proposals & Presentations module.

Common Policy Views
Table 3 describes views common to all policy screens.

For more information on other healthcare policy views, see Chapter 9, “Individual Health Policies.”

Scenario for Group Policies
This scenario features sample tasks performed by a licensed sales representative. Your company may 
follow a different workflow according to its business requirements.

Table 3. Common Policy Screen Views

View Tab Description

Summary Displays a summary of key data associated with a policy in a single view.

Claims Displays claims recorded for an individual policy. 

Proposals Allows for the creation and retrieval of quotes prepared for a customer 
associated with an individual quote or policy. Proposals would normally show 
up in the quote process, but not later.

Underwriting 
Reports

Allows users to collect and manage underwriting information associated with 
an application. These reports are sometimes ordered during the application 
process and sometimes after an application is submitted.

Documents Allows users to collect and manage documents associated with an application.
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In this scenario, a licensed sales representative for an insurance company is on the phone with an 
insurance agent. The insurance broker has called on behalf of a prospective customer who wants to 
offer insurance to its employees at group rates.

In Siebel Healthcare, the sales representative adds a policy record for the company, which 
automatically assigns a unique policy number to the company. Then he imports census information 
for the company using the electronic file he received from the broker (alternatively, the broker may 
import the census himself through the Siebel Agent Portal). Next, he sets up employee classes, and 
adds a plan design by adding products for the policy. The plan design information and census data 
can be sent to the insurance company’s rating engine to generate a quote for this policy.

Next, he uses a template to generate a proposal, which he then sends to the prospect.

Two weeks later, he receives an email message from the broker indicating that the prospect has 
called back and will probably purchase a policy, but requires a revised proposal. He selects a group 
insurance plan according to the needs of the prospect. Next, he schedules an activity as a reminder 
to return the call with the revised premium information.

The prospect accepts the revised proposal. Now the sales representative needs to complete the 
procedures necessary to issue a policy. This includes collecting information about group members 
and about billing and payment preferences. He follows the procedures implemented by his company 
to submit the policy for issuance and billing.

Process of Managing Group Policies
This section details sample tasks often performed by administrators and end-users when managing 
group policies. Your company may follow a different process according to its business requirements.

Administrator Procedures
The following list shows tasks administrators typically perform to manage group policies:

■ “Adding Group Insurance Products and Product Lines” on page 90

■ “Adding Group Insurance Rate Bands” on page 91

■ “Defining Activity Plan Templates for Group Policies” on page 91

■ “Defining Proposal Templates for Group Policies” on page 92

NOTE: Only those with Siebel administrator responsibilities can change entries in the Insurance 
Administration and Product Administration screens.

End-User Procedures
The following list shows tasks end users typically perform when managing call group policies:

■ “Adding Group Policy Records” on page 92

■ “Importing Census Information” on page 93
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■ “Adding Census Information in the Group Policies Screen” on page 94

■ “Adding Employee Classes for Group Policies” on page 95

■ “Designing Plans for Group Policies” on page 95

■ “Reconfiguring Customizable Products in Plan Design” on page 98

■ “Generating Proposals for Group Policies” on page 98

■ “Managing Underwriting Information” on page 99

■ “Adding Eligible Members to Group Policies” on page 100

■ “Enrolling Members in Group Policies” on page 100

■ “Adding Beneficiaries to Group Policies” on page 101

■ “Setting Up Payment Plans for Group Policies” on page 101

Adding Group Insurance Products and 
Product Lines
As an administrator, you can add products to the Siebel database. This section describes the 
procedure for setting up products and product lines in general terms. 

You can also specify that a product line is one that your company contracts agencies to sell, or that 
the state licenses agencies to sell, or both.

For more information about adding product and product lines, see Siebel Product Administration 
Guide and Siebel Applications Administration Guide.

To add a group insurance product

1 Set up the product class structure, including product class attributes.

2 Add the products in the Product Administration screen and associate them with the appropriate 
class. 

3 In the Category field in the Products form, select Group Insurance.

4 Include the product in a product line.

5 Specify a product line type:

a From the application-level menu, choose View > Site Map > Application Administration > Product 
Lines.

b In the Product Line list, select one or both of the following fields:

❏ Contracting. To specify that the product line is one that your company contracts 
agencies to sell. This product line will appear to end users as a choice in the Lines of 
Business dialog box in the Partners, Contracts view tab.
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❏ Licensing. To specify that the product line is one that agencies can be granted a state 
license to sell. This product line will appear to end users as a choice in the Lines of 
Business dialog box in the Partners, Licenses & Appointments view tab.

A check box appears in the middle of the field.

c Click in a blank check box to select the product line type or click the X in a check box to clear it.

6 Set up the Customization Product by defining configuration rules and specifying the user 
interface. 

For more information, see the section on creating customizable products in Siebel Product 
Administration Guide.

Adding Group Insurance Rate Bands
After you add a product in the Product Administration screen, you can use the Insurance 
Administration screen to associate a rate band with a product. A rate band is pricing information 
about the deductible, the premium, and the payroll deduction for each insurance product.

To add a rate band

1 From the application-level menu, choose View > Site Map > Insurance Administration > Health 
and Group Products.

2 In the Products list, select a product.

3 In the Rate Bands list, add a record and complete the necessary fields.

Defining Activity Plan Templates for 
Group Policies
Activity Plan Templates allow you to create and manage activities related to group policies. You define 
templates using the Administration - Data screen Activity Templates and Activity Template Details 
views. 

To create an activity plan template 

1 Navigate to Site Map > Administration - Data > Activity Templates.

2 In the Activity Plan Templates list, add a record. 

3 In the Name field, type a name for the template.

4 In the Type field, choose FINS Group Policy.

5 Complete the remaining necessary fields.

For more information, see Siebel Applications Administration Guide.
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To create activities for the template 

1 Navigate to Site Map > Administration - Data > Activity Templates.

2 In the Activity Plan Templates list, select a template.

3 Click the Activity Template Details view tab. 

4 In the Activity Template Details list, add a record.

5 Complete the necessary fields for each activity assigned to the template.

6 From the drop-down list, choose an activity type.

NOTE: Repeat Step 2 through Step 6 to add activities to the template. 

7 Save the activity.

Defining Proposal Templates for Group 
Policies
Proposal Templates with a particular definition allow you to create and manage proposals related to 
group policies. You define templates using the Administration - Document screen Proposal Templates 
view. 

To create an proposal template for group policies

1 Navigate to Site Map > Administration - Document > Proposal Templates.

2 In the Proposal Templates list, add a record. 

3 In the Name field, type a name for the template.

4 In the Category field, select Insurance Proposal.

5 Complete the remaining necessary fields.

For more information, see Siebel Applications Administration Guide.

Adding Group Policy Records
Adding a group policy record is the first step in generating a policy proposal or issuing a group policy. 
After end users add a policy record, they must set up employee classes, add a policy plan design, 
and generate a policy proposal. If the customer accepts the proposal, they add eligible members, 
enroll members who elect coverage under the plan, and set up policy payment plans. 

To add a policy record

1 Navigate to the Group Policies screen.

2 In the Policies/Quotes list, add a record and complete the necessary fields.
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Importing Census Information
Insurance companies often receive group insurance census information from external sources. For 
example, an insurance broker collects this data and provides it to the insurance company as a comma 
separated text file.

End users can use the Group Policies Census view to import the census data into Siebel Healthcare.

NOTE: Census data can also be imported from the Companies Census view.

Both detailed and segmented census data can be imported for each census. Usually, either only 
detailed or segmented census information is added for a company. However, both types of census 
information can be added.

Census data can also be imported by the originators, such as insurance brokers or employer groups, 
using Siebel Agent Portal or Siebel Group Portal. For more information about these two products, see 
Siebel Partner Relationship Management Administration Guide Addendum for Industry Applications.

Census data can also be entered manually. See “Adding Census Information in the Group Policies 
Screen” on page 94.

To import detailed census data

1 Navigate to the Group Policies screen.

2 In the Policies/Quotes list, drill down on a policy.

3 Click the Census view tab.

4 Click New to create a new census record and complete the fields.

5 In the Census list, from the view link list, select Detailed Census.

6 Scroll down to the Employee list and click Import.

7 In the Import dialog box, locate the file from which to import data and set the remaining 
parameters.

Some parameters are described in the following table.

The field mappings appear in a dialog box showing how each import field maps to the Siebel field. 
By default fields with matching labels are mapped to each other.

8 To add or change a field mapping:

a Highlight the field in the Import Field list

Parameter Description

Input Format Select either comma separated text or tab 
delimited text file type.

Input Source Select Auto Mapping.

Conflict Resolution Choose how to handle data conflicts. Defaults 
to Overwrite Existing Record.
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b Highlight the field to map to in the Siebel Field list

c Click Update Mapping

9 To remove an existing field mapping:

a Highlight the field in the Import Field list

b Highlight <ignore this field> to disregard the import field

c Click Update Mapping

10 Click Next.

The census data is imported into the Siebel application and appears in the Employee List list.

To import segmented census data
■ Follow the steps in “To import detailed census data” on page 93 except select Segmented Census 

in Step 5.

The census data is imported and appears in the Employee Count list.

Adding Census Information in the Group 
Policies Screen
End users can add census information for companies that request a quote or proposal for a group 
insurance policy. To add census information, end users must:

1 Add a policy in the Group Policies screen

2 Add census information using the instructions in the “To add census information” procedure

3 Associate the census with the policy using the instructions in the “To associate a census with a 
policy” procedure

Census data can also be automatically imported. See “Importing Census Information” on page 93.

To add census information 

1 Navigate to the Group Policies screen.

2 In the Policies/Quotes list, drill down on a policy.

3 Click the Census view tab.

4 In the Census list, from the view link list, select Segmented Census or Detailed Census.

■ Segmented Census. Add information for groups of employees.

■ Detailed Census. Add information for individual employees.

NOTE: Usually, either only detailed or segmented information is added for a single census. 
However, information can be added for both.

5 In the Census list, add a record and complete the necessary fields.
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6 For a Segmented Census:

■ Scroll down to the Employee Count list.

■ In the Employee Count list, add a record and complete the necessary fields.

7 For a Detailed Census: 

■ Scroll down to the Employee List list.

■ In the Employee List list, add a record and complete the necessary fields.

To associate a census with a policy

1 Navigate to the Group Policies screen.

2 In the Policies/Quotes list, select a policy.

3 In the Policy Census field of the Policies/Quotes form, click the select button.

The Pick Group Census dialog box appears, showing each census available for that policy.

4 In the Pick Group Census dialog box, select a census and click OK.

Adding Employee Classes for Group 
Policies
Some group policies, especially those for larger groups, offer different products to different employee 
classes of group members. Examples of employee classes are salaried employees and hourly 
employees. Each employee class offers a unique combination of products, product options, and 
product rates. Users can use the Classes view to add or make changes to employee classes.

To add an employee class

1 Navigate to the Group Policies screen.

2 In the Policies/Quotes list, select a policy.

3 Click the Classes view tab.

4 In the Classes list, add a record and complete the necessary fields.

Designing Plans for Group Policies
End users can design plans for group polices by adding information about products, product classes, 
and rate bands. 

A rate band is pricing information about the deductible, the premium, and the payroll deduction for 
each insurance product. 

The following lists are available in the Plan Design view:
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■ Product Attributes. This view contains the Plan Design Product list and the Attributes list. Use 
the Plan Design Product list to associate a product with the policy that appears in the Group Policy 
form. Use the Attributes list to view attribute information and change attribute values.

■ Product Classes. This view contains the Plan Design Product list and the Classes list. Use the 
Classes list to select employee classes that you want to associate with the selected product.

■ Product Class Matrix. This view contains the Plan Design Product Class Matrix list. In this list, 
you associate an employee class with the selected product.

■ Product Class Rate Bands. This view contains the Plan Design Product Class Rate Band list. 
Use this list to associate a rate band with the selected product/class.

To add a plan design

1 Navigate to the Group Policies screen.

2 In the Policies/Quotes list, drill down on a group policy.

3 Click the Plan Design view tab.

The Plan Design Product list appears, showing the selected policy.

NOTE: If you need to add a product, in the Plan Design Products list, click New and complete the 
fields.

4 From the view link list, select Product Attributes and scroll down to the Attributes list.

5 In the Attributes list, change the appropriate information.

6 From the view link list, select Product Classes and scroll down to the Classes list.

a In the Classes list, click New to associate an employee class with the selected product.

b In the Class Name field, click the select button.

c In the Pick Class dialog box, select an employee class from the Class Name field and click OK.

NOTE: Only employee classes available for the selected product appear in the Pick Class dialog 
box. You can add employee classes to the list in this dialog box by using “Adding Employee Classes 
for Group Policies” on page 95.

7 From the view link list, select Product Class Matrix.

a In the Product Class Matrix list, check the appropriate product column for each class. 

8 From the view link list, select Product Class Rate Bands.

a In the Product Class list, select a record with the appropriate product and class and scroll down 
to the Rate Bands list.

b In the Rate Bands list, click New to associate a rate band with the selected product and class.

c In the Rate Bands field, click the select button.
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d In the Pick Product Rate Bands dialog box, select a Rate Band and click OK.

NOTE: Only available rate bands for the selected product appear in the Pick Product Rate Bands 
dialog box. Rate Bands are created in the Administration - Insurance > Health and Group 
Products view. For more information about how to add Rate Bands, see “Adding Group Insurance 
Rate Bands” on page 91. 

To generate a proposal for this plan, see “Generating Proposals for Group Policies” on page 98.

How Enrollment Waiting Periods Affect 
the Start of Coverage
You can control how Siebel Healthcare calculates the start of coverage by defining the enrollment 
waiting period in the Group Policies screen. When you add a Plan Design (see “Designing Plans for 
Group Policies” on page 95), you define Product Classes that you then associate with a specific 
product. In the Classes list you can specify the Waiting Period, that is the number of days that must 
pass prior to the start of coverage. The actual start of coverage appears in the Effective Date field 
in the Group Policies, Enrollment view. The Waiting Period you specify in the Plan Design, Classes list 
directly impacts this Effective Date.

By default, Siebel Healthcare has the following defined rules:

■ If a Waiting Period is specified, the Effective Date is set to the number of waiting days from 
today’s date.

■ If a Waiting Period is not specified, the application checks today's date. If that date is before the 
15th of the month, the Effective Date is set to the first of the month. If that date is after the 15th 
of the month, the Effective Date is set to the first of the following month.

When a user enrolls a new member in the Group Policy, Enrollment view, the Effective Date field 
defaults to a value based on these two rules and the application sets the Status field to Waiting. 

The FINS Member Enrollment Rules Workflow enforces these rules. Users can invoke this workflow 
by submitting a repeating component job request that repeats every 24 hours in batch mode. It 
checks the Effective Date of existing enrollment records and updates the Status from Waiting to 
Active if:

■ The Effective Date of a record is less than or equal to today’s date

■ The Status is still set to Waiting

For more information on component job requests, see Siebel System Administration Guide.
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Reconfiguring Customizable Products in 
Plan Design
End users can dynamically reconfigure customizable products by using the Customize Plan button in 
the Product Attributes list. The Customize Plan button is only available if Siebel Configurator was 
installed and the selected product was created as a customizable product in Siebel Configurator. For 
more information, see the chapters about customizable products in the Siebel Product Administration 
Guide.

To dynamically reconfigure customizable products in plan design

1 Navigate to the Group Policies screen.

2 In the Policies/Quotes list, drill down on a group policy.

3 Click the Plan Design view tab.

4 Select the Product Attributes view link.

5 In the Product list, click Customize Plan.

A configuration session launches and a selection page appears. The changes made in the 
configuration session are reflected in the line items in the Attributes list. 

Generating Proposals for Group Policies
A proposal is a written quote for a policy. Before generating a proposal, end users must add the 
policy, set up classes, and add the policy plan design. Usually, the last step in adding the plan design 
is to activate the software program your company uses to rate policies. For more information, see 
“Designing Plans for Group Policies” on page 95.

Proposals are built off of pre-defined templates. For more information on creating proposal 
templates, see the chapter on proposals in Siebel Applications Administration Guide.

NOTE: Only those with Siebel administrator responsibilities can create or change proposal templates 
from the Administration - Document screen.

To generate a proposal

1 Navigate to the Group Policies screen.

2 In the Policies/Quotes list, drill down on a policy.

3 Click the Proposals view tab.

4 In the Proposals list, add a record.

5 In the new record, select the appropriate template.

6 Click Generate Draft.
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Managing Underwriting Information
End users can use the Underwriting Reports view tabs on the Group Policies screen to collect and 
manage underwriting information.

To add underwriting information

1 Navigate to the Group Policies screen.

2 In the Policies/Quotes list, drill down on a policy.

3 Click the Underwriting Reports view tab.

4 In the Underwriting Reports list, attach the information and complete the necessary fields. 

Some fields are described in the following table.

To view historical underwriting information

1 Navigate to the Group Policies screen.

2 Click the Group History view tab.

3 From the view link list in the Group History list, select a type of underwriting information:

■ Rates

■ Prior Insurance History

■ Premium/Claim History

■ Large Claimant History

Field Comments

Type Type of underwriting report or information being requested. 

Status Status of the current report. Valid options include:

■ Requested

■ Received

■ Submitted

Ordered Date automatically generated by the application when a new record is 
created.

Received Date the underwriting report was received.



Siebel Healthcare Guide Version 8.0

Managing Group Policies ■ Adding Eligible Members to Group Policies

100 

Adding Eligible Members to Group 
Policies
After a customer accepts a group policy plan, end users can add or make changes to eligible 
members. Eligible members can accept or decline group policy coverages. Members who accept 
coverage can be enrolled in the plan.

To add an eligible member

1 Navigate to the Group Policies screen.

2 In the Policies/Quotes list, drill down on the policy.

3 Click the Eligible Members view tab.

4 In the Primary Members list, add a record.

5 In the Add Members dialog box, select an existing record, or add a record and complete the 
necessary fields.

NOTE: During implementation, you will import the eligible members from the final census. For 
more information, see “Importing Census Information” on page 93.

Enrolling Members in Group Policies
Group members who accept coverage are enrolled in the policy and are considered the primary 
member of the policy. End users use the Enrollment view to enroll eligible members, including the 
primary member and dependents, who accept coverage in the plan.

To enroll a member

1 Navigate to the Group Policies screen.

2 In the Policies/Quotes list, drill down on the policy.

3 Click the Enrollment view tab.

4 In the Primary Members list, select the primary member to enroll and scroll down to the Member 
Products list.

a In the Member Products list, add a record and complete the necessary fields.

b Repeat Step 4 for each product you would like to add for this primary member.

All the products related to this primary member’s enrollment are added.

5 Scroll down to the Insured Members list.

a In the Insured Members list, click New to enroll the primary member and the dependents.

b In the Last Name field, click the select button. 

c In the Pick Contacts dialog box, select the primary member that you would like to associate with 
the selected product and click OK.
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d In the Insured Members list, complete the remaining fields.

NOTE: Add dependent members in the Pick Contacts dialog box by clicking on the New 
button and completing the fields.

6 Repeat Step 4 and Step 5 for each member you would like to enroll.

When you finish, all enrolled members, including the primary member, appear in the Insured 
Members list.

Adding Beneficiaries to Group Policies
Some group policies, such as group life insurance policies, require that members designate one or 
more policy beneficiaries. End users can use the Member Beneficiary view to add or make changes 
to group policy beneficiaries.

To add a beneficiary

1 Navigate to the Group Policies screen.

2 In the Policies/Quotes list, drill down on the policy.

3 Click the Member Beneficiary view tab.

4 In the Member Life Products list, select a primary member record.

5 Scroll down to the Insured Members list and select a member for whom to add a beneficiary.

6 In the Beneficiary list, add a record and complete the necessary fields.

Setting Up Payment Plans for Group 
Policies
End users can set up payment plans, including details about payment methods, for group insurance 
policies.

To set up a payment plan for a group policy

1 Navigate to the Group Policies screen.

2 In the Policies/Quotes list, drill down on the policy.

3 Click the Payment Plans view tab. 

4 In the Pay Plans list, add a record and complete the necessary fields.

5 Scoll down to the Payment Details form and update the statement information.

a In the Last Name field, click the select button.

b In the Pick Contact dialog box, select a name and click OK.
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11 Members

The chapter explains the procedures necessary to administer and use the members functionality in 
Siebel Healthcare. It includes the following topics:

■ “About Members for Siebel Healthcare” on page 103

■ “Scenario for Handling Insurance Agent and Member Inquiries” on page 103

■ “Administrator Procedures for Members” on page 104

■ “Adding Health Programs” on page 104

■ “Configuring the Command Center for Common Member Services” on page 105

■ “End-User Procedures for Members” on page 105

■ “Editing the Layout of the Members Summary View” on page 105

■ “Enrolling Members in Health Programs” on page 106

■ “Example of Using the Command Center for Common Member Services” on page 106

■ “Changing the Primary Network or IPA for Members” on page 109

■ “Adding Additional Benefits Coverage for Members” on page 109

■ “Setting the Member HIPAA Privacy Option” on page 110

About Members for Siebel Healthcare
Members are individuals who are insured by an organization. In some cases, members are also 
known as policyholders, subscribers, or insureds.

The Members screen allows user to manage insurance policy members. It allows end users to add 
and track information about members with whom they do business, such as enrolling them in health 
programs; changing a member’s primary care provider, primary network, or independent practice 
association (IPA); or adding service requests or activities for members. 

Scenario for Handling Insurance Agent 
and Member Inquiries
This scenario features sample tasks performed by a call center representative. Your company may 
follow a different workflow according to its business requirements.

In this scenario, a call center representative for a health plan or an insurance company is handling 
multiple calls each day from insurance agents and members.
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Typically, members call to ask questions regarding their insurance coverage. The call center 
representative accesses this information in the Members screen, Summary view. To enroll members 
in a health program, she uses the Health Programs view. To handle a request for a change of primary 
care provider (PCP) or a primary network or independent practice association (IPA), she goes to the 
Benefits view.  

NOTE: Do not add member records in the Members screen. Use the Group Policies screen or the 
Individual Health Policies screen to add member records. For more information, see “Individual Health 
Policies” on page 79 or “Managing Group Policies” on page 87.

Members often call to request information about providers. After the representative adds provider 
records in the Providers screen, she can view them in both the Providers and Contacts screens. She 
can view the member’s current provider in the Members Benefits view. She can also use this view to 
process requests to change a member’s primary care provider

NOTE: Use the Providers screen to add provider records. For more information, see “Providers” on 
page 121.

In this scenario, end users are the call center representatives. They enter information to:

■ Enroll a member in a health program

■ Charge a PCP, primary network, or IPA for members

■ Add additional benefits coverage

Administrator Procedures for Members
The following administrator procedure is described in this section:

■ “Adding Health Programs” on page 104

■ “Configuring the Command Center for Common Member Services” on page 105

NOTE: Only those with the required administrative responsibilities, such as Siebel administrators, 
can change entries in the Administration - Insurance screen.

Adding Health Programs
Health programs are medical programs designed to maintain a member’s health or to prevent 
disease. Health programs include those that offer maternity care or infant care, diet and exercise 
programs, and chronic-illness management programs.

To add a health program

1 Navigate to Site Map > Administration - Insurance > Health Programs.

2 In the Health Programs list, add a record and complete the necessary fields.
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Configuring the Command Center for 
Common Member Services
Siebel Healthcare ships with the Command Center applet embedded in the Member Summary view. 
In order for the Command Center applet to work as described in “Example of Using the Command 
Center for Common Member Services” on page 106, the applet needs to be configured as described in 
“Example of Configuring the Command Center Action Applet” on page 25.

Also provided, is an alternate, preconfigured, common task applet. You can replace the Command 
Center applet with the common task applet using Siebel Tools.

To configure the common task applet

1 Launch Siebel Tools.

2 In the Object Explorer, select View.

3 Query for FINS Member Summary View in the right-hand list.

4 Expand the View in the Object Explorer.

5 Select View Web Template and select the Base template.

6 Expand the Web Templates within the Object Explorer to expose the View Web Template Item.

7 On the right, replace the FINS Command Center Action Form Applet with the FINS Member 
Summary Common Task List Applet.

8 Save your work, compile the view, and deploy the new SRF file.

For more information, see Using Siebel Tools.

End-User Procedures for Members
The following end-user procedures are described in this section:

■ “Editing the Layout of the Members Summary View” on page 105

■ “Enrolling Members in Health Programs” on page 106

■ “Example of Using the Command Center for Common Member Services” on page 106

■ “Changing the Primary Network or IPA for Members” on page 109

■ “Adding Additional Benefits Coverage for Members” on page 109

■ “Setting the Member HIPAA Privacy Option” on page 110

Editing the Layout of the Members 
Summary View
The Members Summary view has an editable layout so end users can arrange the view information 
to meet their needs.
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To edit the Members Summary view layout

1 Navigate to Members > Summary view.

2 Click Edit Layout.

3 In the Edit Layout form, make changes by clicking the different controls that appear on each list 
or form.

For more on edit layout controls, see Siebel Fundamentals.

4 Click Done to register the changes and return to the Members Summary view.

Enrolling Members in Health Programs
Health Programs are medical programs designed to maintain a member’s health or to prevent 
disease. Health programs include those that offer maternity care or infant care, diet and exercise 
programs, and chronic-illness management programs. Once a member is added, they can be enrolled 
in a health program.

To enroll a member in a health program

1 Navigate to the Members screen.

2 In the Members list, drill down on the last name of the member to be enrolled.

3 Click the Health Programs view tab.

4 In the Health Programs list, add a record and complete the necessary fields.

Example of Using the Command Center 
for Common Member Services 
The Command Center is a quick launch point for several common member processes. Available on 
the Members Summary view, end users can use the drop-down menus to perform such member 
services tasks as:

■ Order a new ID card

■ Change the PCP

■ View claims information

■ Show a history of ID card orders and changes to PCP

On the Members Summary view, the Command Center is not preconfigured to perform these or any 
functions. It must be set up to run the member processes particular to your business. This section 
presents an example of how the Command Center could be used on the Members Summary view. 
The necessary configuration to set up the Command Center to run the processes shown in this 
example, appears in “Example of Configuring the Command Center Action Applet” on page 25.

For additional information about the Command Center feature, see “About Command Center” on 
page 20.
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ID Card Requests
When a member requests a new ID card, the call center representative would typically first check 
for outstanding card requests and then place the new card order. The Command Center on the 
Members Summary view provides a convenient way to retrieve the order history and then place a 
new order.

To check the ID card order history

1 Navigate to the Members screen.

2 In the Members list, drill down on the last name of the member.

3 Click the Summary view tab.

4 In the Command Center form, in the Area field drop-down list, select ID Card Requests.

5 In the Action field drop-down list, select Show History.

6 Click Go.

The Order ID History dialog box appears.

To place a new ID card order

1 Navigate to the Members screen.

2 In the Members list, drill down on the last name of the member.

3 Click the Summary view tab.

4 In the Command Center form, in the Area field drop-down list, select ID Card Requests.

5 In the Action field drop-down list, Order New ID Card.

6 Click Go.

The application navigates to the Members Benefits view.

7 In the Benefits list, select the policy for which to order the ID card.

8 Click Order ID.

9 Complete the fields in the service request form.

10 Click Submit to submit the service request for fulfillment.

NOTE: The fulfillment process can be implemented using Assignment Manager or Siebel business 
services.

PCP Requests
The Command Center on the Members Summary view provides a convenient way to retrieve primary 
care provider (PCP) history and update Siebel Healthcare with any changes.
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To check the PCP change history

1 Navigate to the Members screen.

2 In the Members list, drill down on the last name of the member.

3 Click the Summary view tab.

4 In the Command Center form, in the Area field drop-down list, select PCP Requests.

5 In the Action field drop-down list, select Show History.

6 Click Go.

The Change PCP History dialog box appears.

To change the PCP

1 Navigate to the Members screen.

2 In the Members list, drill down on the last name of the member.

3 Click the Summary view tab.

4 In the Command Center form, in the Area field drop-down list, select PCP Requests.

5 In the Action field drop-down list, Change PCP.

6 Click Go.

The application navigates to the Members Benefits view.

7 In the Benefits list, select the policy for which to change the PCP.

8 Click Change PCP.

The Service Member Services > Change PCP view appears.

9 In the Service Request Change PCP view:

a Pick a reason code

b Select a new PCP

c Select a new primary network

10 (Optional) Use the Provider Locator functionality to select a new PCP:

a Click Provider Search button

b In the Provider Locator view, enter appropriate search criteria and click Go

c In the list of providers returned, drill into the a provider name for more details

d On the Provider Details view, click Select this Provider to continue with the Service Request 

e Alternatively, click Restart Search to perform search again using a new criteria

11 (Optional) To alert old/new provider and member on PCP change:

a Click Email Update

b Select the appropriate party to whom you wish to send an email
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c (Optional) Make modifications to the content

d Click Send to send the email

12 Click Submit to submit the service request for fulfillment.

NOTE: The fulfillment process can be implemented using Assignment Manager or Siebel business 
services. 

Claims Inquiries
End users can use the Command Center on the Members Summary view to respond to claims inquires 
and quickly navigate to the Members Claims view.

To view claims information

1 Navigate to the Members screen.

2 In the Members list, drill down on the last name of the member.

3 Click the Summary view tab.

4 In the Command Center form, in the Area field drop-down list, select Claims Inquiries.

5 In the Action field drop-down list, select View Claims Info.

6 Click Go.

The Members Claims view appears.

Changing the Primary Network or IPA 
for Members
If a member changes primary network or independent practice association (IPA), end users can 
update Siebel Healthcare to reflect the change.

To make changes to member care information

1 Navigate to the Members screen.

2 In the Members list, drill down on the member’s last name.

3 Click the Benefits view tab.

4 In the Benefits list, select the Primary Network/IPA field and enter the new information.

Adding Additional Benefits Coverage for 
Members
Additional benefits are called coordination of benefits. Two examples are:
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■ When the spouse of a member has the same coverage as the member.

■ When a member has medicare as secondary coverage.

To add an additional benefits coverage

1 Navigate to the Members screen.

2 In the Members list, drill down on the member’s last name.

3 Click the Coordination of Benefits view tab.

4 In the Coordination of Benefits list, add a record.

5 In the Add Coordination of Benefits dialog box, perform the appropriate task:

■ Select a record and click OK.

■ Click New to add a new record.

Setting the Member HIPAA Privacy 
Option
United States law requires that medical institutions disclose their privacy policies regarding the 
sharing of non-public personal information with third parties and fair credit reporting that impacts 
the sharing of non-public personal information with affiliates. End users can specify a privacy level 
by making a selection from the HIPAA Option field.

The HIPAA Option field is for registering the privacy level requested by the contact; it does not impact 
record visibility in any way.

To record a member’s HIPAA privacy choice

1 Navigate to the Members screen.

2 In the Members list, drill down on the member’s last name.

3 In the Members form, specify a HIPAA choice in the HIPAA Option field, selecting one of the 
following:

■ Opt-In. Sharing of non-public personal information is allowed without restrictions.

■ Opt-Out - Affiliates. Sharing of non-public personal information with affiliates is not 
allowed.

■ Opt-Out - Third Party. Sharing of non-public personal information with third parties is not 
allowed.

■ Opt-Out - All Parties. Sharing of non-public personal information with any affiliate or third 
party is not allowed.
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12 Managing Partners and 
Agencies

This chapter contains the following topics:

■ “About Partners and Agencies” on page 111

■ “Scenario for Working with Partners and Agencies” on page 112

■ “Process of Managing Partners and Agencies” on page 112

■ “Adding New Partners” on page 113

■ “Adding Agents” on page 113

■ “Adding Information Associated with an Agent” on page 113

About Partners and Agencies
Siebel Healthcare allows you to manage partners and agencies.

■ Partners include service providers, aggregators, and insurance agencies. 

■ Agencies are organizations that act on behalf of insurance companies to sell insurance policies. 
Agents and brokers are the licensed sales representatives who sell the insurance policies. For 
many insurance companies, agencies are often the most important type of partner. 

Tracking partner information is important because for many healthcare companies, partners such as 
banks, agencies, and brokerages often function as a primary revenue channel.

NOTE: Adding partners on the Partners screen only allows you to track and monitor partner 
information. If you want to share data with a partner, the partner should be upgraded to a Siebel 
Organization. To perform this and other Partner administration tasks, you use the Administration -
Partner screen. For more information, see Siebel Partner Relationship Management Administration 
Guide.

End users use the Agents screen for healthcare-related procedures such as:

■ Adding agents

■ Viewing agent information

■ Creating service requests or activities for agents

■ Tracking information about contracts, licenses, appointments, registration, errors and omissions, 
policies, and quotes

NOTE: Under the Party Model, where contacts include all persons, individuals added in the Agents 
business component are also members of the Contacts business component. Agents are a special 
subset of contacts who are engaged in the sales of Financial Services products.
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Scenario for Working with Partners and 
Agencies
These scenarios feature sample tasks performed by a health plan company employees. Your company 
may follow a different workflow according to its business requirements.

In these scenarios, the end users are company employees who manage information in the field. They 
enter information to:

■ Create a partner 

■ Add a contact that represents an agency

■ Add new agents 

■ View information about existing agents

■ Track agent information about contracts, licenses, appointments, registration status, errors and 
omissions, policies, and quotes

■ Create service requests or activities for agents

Employee Adds a New Agency
In this scenario, an insurance company uses independent agencies as one of the channels for 
distribution of its insurance products. An employee for this insurance company needs to add a newly 
appointed agency to represent his company’s products to consumers.

His company has verified the qualifications of the agency, so he adds information about the agent. 
Then, he adds a new Partners record and adds information about the agency’s errors and omissions 
coverage. 

Next, he navigates to the Licenses & Appointments view to record information about the agency’s 
license. Finally, he adds a contact with the agency.

Company Signs a New Agent
An healthcare company signs a new agent. A licensing and contracting coordinator for the company 
receives an interoffice mail containing the required paperwork. She enters the agent’s contact, 
license, appointment, and contract information into Siebel Healthcare.

Six months later, the agent moves to a new office. He forwards his new address and phone number 
to the sales representative who is his main contact at the healthcare company. The sales 
representative locates the agent in Siebel Healthcare and updates his address and phone number.

Process of Managing Partners and 
Agencies
This section details sample tasks often performed by end-users when managing partners and 
agencies. Your company may follow a different process according to its business requirements.
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End-User Procedures
The following list shows tasks end users typically perform when managing partners and agencies:

■ “Adding New Partners” on page 113

■ “Adding Agents” on page 113

■ “Adding Information Associated with an Agent” on page 113

Adding New Partners
End users can create new partner records and make changes to existing service provider information.

To create a partner

1 Navigate to Partners > Partner List view.

2 In the Partners form, add a record, and complete the necessary fields. 

3 In the Partner Type field, select the appropriate type; if this partner is a service provider, select 
Service Provider.

Adding Agents
Agents are the licensed sales representatives who sell insurance policies. Adding an agent is the first 
step in managing procedures related to the agent. 

To add an agent

1 Navigate to the Agents screen.

2 In the Agents list, add a record and complete the necessary fields.

a In the Partner field, click the select button.

b In the Partners dialog box, select a record and click OK, or click New to add a new partner.

c If adding a new partner, complete the fields.

NOTE: To add or change the columns displayed in the list, click the list’s menu button and choose 
Columns Displayed.

Adding Information Associated with an 
Agent
Using the view tabs on the Agents screen, end users can track additional information related to 
agents including information about contracts, licenses and appointments, errors and omissions, 
National Association of Securities Dealers (NASD) registration, and policies and quotes.
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To add additional information about an agent

1 Navigate to the Agents screen.

2 In the Agents list, drill down on the desired agent and click the appropriate view tab from the 
following list:

■ Contracts. To add information about the agent’s contracts.

■ Licenses and Appointments. To add information about licenses the agent holds.

■ Errors and Omissions. To add information about the agent’s errors and omissions.

■ Registration. To add information about the agent’s registration status.

■ Policies/Quotes. To view policies and quotes for the agent.

3 In the selected view list, add a record and complete the necessary fields.
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13 Referrals and Authorization

Siebel Healthcare allows you to track referrals to other providers and authorizations of specific 
healthcare services. Service agents use the Referrals\Authorizations screen to collect the information 
required for referral and authorization approval, validate the fields, initiate workflow, and track the 
status on behalf of a provider, member, or other inquiring party. This information can then be 
integrated with back-office systems using a prebuilt referral and authorization ASI. For more 
information, see Chapter 16, “Integration.”

This chapter includes the following topics:

■ Scenario for Creating and Authorizing a Referral

■ Administrator Procedures for Referrals and Authorizations

■ End-User Procedures For Referrals and Authorizations on page 116

■ Creating Referrals or Authorizations on page 116

■ Associating Actions and Providers to Referral or Authorization Requests on page 117

■ Recording Approval Decisions for Referrals or Authorizations on page 118

Scenario for Creating and Authorizing a 
Referral
The following business scenario features sample tasks performed by a call center representative for 
health plan company. Your company may follow a different workflow according to its business 
requirements. 

A healthcare provider calls a health plan’s call center in order to refer a patient to an orthopedic 
surgeon. A call center representative receives the call from the provider. The call center 
representative first authenticates the provider and then looks up the member on the Members 
screen. By looking at the Member Summary view, she verifies the member’s basic eligibility and 
coverages. She then navigates to the Referrals/Authorizations screen. She creates a new referral and 
completes the necessary fields. Once she finishes entering the necessary data, she changes the value 
in the Status field to Open and sets the Sub-status field to Submitted.

Administrator Procedures for Referrals 
and Authorizations
The following administrator procedures are described in this section:

■ To create an activity plan template

■ To create activities for the template
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Activity Plan Templates allow you to create and manage activities related to referrals and 
authorizations. You define templates using the Administration - Data screen’s Activity Templates and 
Activity Template Details views. 

To create an activity plan template 

1 Navigate to Site Map > Administration - Data > Activity Templates.

2 In the Activity Templates list, add a record. 

3 In the Name field, type a name for the template.

4 In the Type field, choose FINS Referrals Authorizations.

5 Complete the remaining necessary fields.

For more information on creating activity templates, see Siebel Applications Administration Guide.

To create activities for the template 

1 Navigate to Site Map > Administration - Data > Activity Templates.

2 In the Activity Plan Templates list, select a template.

3 Click the Activity Template Details view tab. 

4 In the Activity Template Details list, add a record.

5 Complete the necessary fields for each activity assigned to the template.

NOTE: Repeat Step 2 through Step 5 to add additional activities to the template. 

End-User Procedures For Referrals and 
Authorizations
End users use the Referrals/Authorization view to record the necessary information for processing a 
referral or authorization. Using the Referrals/Authorization form and More Info view tab, users can 
verify they have recorded all the required information, check on member eligibility, and track the 
status of referrals and authorizations.

The following end-user procedures are described in this section:

■ “Creating Referrals or Authorizations” on page 116

■ “Associating Actions and Providers to Referral or Authorization Requests” on page 117

■ “Recording Approval Decisions for Referrals or Authorizations” on page 118

Creating Referrals or Authorizations
End users can create referrals or authorizations from the Referrals/Authorization screen. 
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To create a referral or authorization

1 Navigate to the Referrals/Authorization screen.

2 Add a record and select the request type: Authorization or Referral.

3 Drill down on the Tracking #.

4 Click the More Info view tab and add additional information as necessary.

Some fields are described in the following table.

Associating Actions and Providers to 
Referral or Authorization Requests
End users can use the Actions view tab to record activities related to a referral or authorization. For 
more information on creating activity plan templates, see “To create an activity plan template” on 
page 116.

To associate an action or provider with a referral or authorization

1 Navigate to the Referrals/Authorization screen.

2 In the Referrals/Authorizations list, drill down on the tracking # of the desired request.

Field Comments

Last Name Last name of the member. The application automatically populates the 
First Name field.

For more information on adding members, see “Adding Eligible Members to 
Group Policies” on page 100.

Status Status of this referral or authorization. 

Requestor Last 
Name

Last name of provider. The application automatically populates the 
Requestor First Name field.

For more information on adding providers, see “Adding Providers” on 
page 123.

Diagnosis Codes Diagnosis code for this referral or authorization.

For more information on adding codes, see the discussion on modifying 
the List of Values (LOV) in Siebel Applications Administration Guide.

Procedure Codes Procedure code for this referral or authorization.

For more information on adding codes, see the discussion on modifying 
the List of Values (LOV) in Siebel Applications Administration Guide.

# of Visits 
Requested

For referral requests, the number of doctor visits requested for approval.

Maximum Benefit The maximum dollar amount for the specified benefit.
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3 Click the Actions view tab.

4 In the Actions list, add a new record and select the desired activity template.

5 Save the record.

The activities associated with the activity template selected are automatically entered in the 
Activities list.

6 To add additional activities, add a new record in the Activities list and complete the necessary 
fields.

Recording Approval Decisions for 
Referrals or Authorizations
End users can use the Decision History view tab to record for each referral or authorization, the 
approved actions and physician and facility referrals. Actions include things such as a medical 
equipment and prescription drug supplies.

To record referral or authorization decisions

1 Navigate to the Referrals/Authorization screen.

2 In the Referrals/Authorizations list, drill down on the tracking # of the desired request.

3 Click the Decision History view tab.

4 In the Approved Actions form, add a record and complete the necessary fields. 

Some fields are described in the following table.

.

Field Comments

Type The type of referral or authorization decision. Valid options include:

■ Lab - Lab referral or authorization.

■ Test - Medical test referral or authorization.

■ DME - Authorization for durable medical equipment, for example, 
wheelchair.

■ Rx - Specified drug treatment. 

Description Description of this referral or authorization.

Equipment # Equipment identification number. 

Rx Drug The specific drug treatment requested by the provider. If the provider 
requests a unauthorized drug, then they must indicate the quantity, 
dosage, and expected treatment before submitting the request. 

Rx Dosage The specific dosage of the requested drug treatment. If the provider 
requests a unauthorized drug, then they must indicate the quantity, 
dosage, and expected treatment before submitting the request. 
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5 In the Approved Providers and Facilities list, add a record and complete the necessary fields.

Some fields are described in the following table.

Field Comments

Provider Last 
Name

Last name of the provider. The application automatically populates the 
Provider First Name and ID#.

For more information on adding providers, see “Adding Providers” on 
page 123.

Facility The facility where the treatment will be performed. The application 
automatically populates the remaining fields.

For more information on adding facilities, see “Adding Facilities” on 
page 75.
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14 Providers

Providers are healthcare professionals who are paid by, or file claims with, your health plan or health 
insurance company. Examples of providers are physicians, nurse practitioners, dentists, and 
pharmacists.

The Providers screen allows end users to manage information about providers. Specifically, it allows 
end users to add and track information about providers and contracts, locate providers, associate 
facilities with a provider, indicate a provider’s specialties, add profile information (such as provider 
skills, background, and business locations and hours), add some provider claims (such as, an out-
of-service-area claim), view payment information, and print a Provider report.

This chapter includes the following topics:

■ Scenario for Adding and Managing a New Provider

■ End-User Procedures for Providers on page 122

■ Adding Providers on page 123

■ Adding Addresses for the Provider Locator on page 123

■ Associating Facilities with Providers on page 124

■ Associating Specialties with Providers on page 124

■ Adding Profile Information on page 124

■ Adding Provider Contracts on page 125

■ Viewing Provider Payments and Adding Payments Manually on page 125

■ Adding Provider Claims on page 126

■ Viewing and Printing a Provider Report on page 126

Scenario for Adding and Managing a New 
Provider
This scenario features sample tasks performed by a contracting specialist, a provider relations 
representative, and a member service representative. Your company may follow a different workflow 
according to its business requirements.

In this scenario, a contracting specialist for a health plan is responsible for managing information 
about the healthcare providers with which her company does business. She just established a 
contract with a single provider.
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She adds the new provider and then adds information about the provider’s area of specialization. 
Next, she adds information about the provider’s primary location (for example, a medical group or 
pharmacy), affiliations (such as hospitals or health networks), and whether or not hospital affiliations 
include admitting privileges. After that, she adds information about the provider’s skills, background, 
and clinic locations and hours. Then she adds information about contracts the provider holds with 
her company and adds the provider’s payment preferences.

A provider relations representative provides service for the provider. He uses the:

■ Encounters view and the Claims view to refer to reports regarding patient visits and claims

■ Payments view to refer to payments made to the provider

■ Service Requests view to add service requests such as referral inquiries

■ Alerts view to add important notes about this provider

A member service representative uses Siebel Healthcare to answer questions about contracted 
providers. Using the Provider Locator, she searches for providers by city, state, or ZIP Code. She 
views and prints Provider reports based on the product and speciality. Also, she can view some of 
the information the contracting specialist adds in the Providers screen and the Products screen. For 
example, the Products screen displays information about providers in the Primary Providers view and 
the Contracted Providers view.

In this scenario, end users are health plan contracting specialists, provider relations representatives, 
and member service representatives. They use Siebel Healthcare to:

■ Add a new providers and provider addresses

■ Associate a facility with a provider

■ Associate a specialty with a provider and add profile information

■ Add a provider contract

■ View provider payments

■ Add a provider claim

■ View and print provider reports

End-User Procedures for Providers
The following end-user procedures are described in this section:

■ “Adding Providers” on page 123

■ “Adding Addresses for the Provider Locator” on page 123

■ “Associating Facilities with Providers” on page 124

■ “Associating Specialties with Providers” on page 124

■ “Adding Profile Information” on page 124

■ “Adding Provider Contracts” on page 125

■ “Viewing Provider Payments and Adding Payments Manually” on page 125
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■ “Adding Provider Claims” on page 126

■ “Viewing and Printing a Provider Report” on page 126

Adding Providers
End users use the Providers screen to add or make changes to healthcare provider records. After 
they add provider records in the Providers screen, users can view them in the Providers and the 
Contacts screen. In the Contacts screen, a check mark appears in the Provider field of the record, 
indicating that the contact is a provider.

NOTE: End users can add healthcare provider records in the Contacts screen. However, they will not 
appear in the Providers screen unless they check the Providers check box on the More Info view tab.

To add a provider

1 Navigate to the Providers > Providers List view.

2 In the Providers list, add a record and complete the necessary fields.

Adding Addresses for the Provider 
Locator
Users must add provider addresses if they want to use the Provider Locator feature.

To add a provider address

1 Navigate to the Providers > Providers List view.

2 In the Providers list, drill down on the desired provider.

3 Click the Addresses view tab.

4 In the Addresses list, add a record.

5 In the Add Address dialog box, perform the appropriate task:

■ To choose an existing record, select a record and click OK.

■ To add a new record, click New and complete the fields.

6 In the Addresses list, click Update Geo Code.

NOTE: The latitude and longitude values will not generate if any one value in the City, State, Zip 
Code, or Country fields is incorrect. For example, if the ZIP Code is incorrect, you will receive an 
error message. To correct this problem, navigate to the Application Administration, ZIP Code 
Administration view and make sure the Geo values for that city, state, and ZIP Code combination has 
been loaded. For more information, see Siebel eService Administration Guide.
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Associating Facilities with Providers
A provider may be affiliated with one or more facilities. For example, a provider may work at both a 
clinic and a hospital. End users can use the Affiliations view to associate facilities, such as clinics, 
hospitals, or pharmacies, with providers.

To associate a facility with a provider

1 Navigate to the Providers > Providers List view.

2 In the Providers list, drill down on the desired provider.

3 Click the Affiliations view tab.

4 In the Affiliations list, add a new record.

5 In the Facilities dialog box, perform the appropriate task:

■ To choose an existing record, select a record and click OK.

■ To add a new record, click New and complete the fields.

Associating Specialties with Providers
Many providers have an area of medical specialization. End users can use the Specialties view to 
indicate a provider’s area of medical specialization by associating specialities with the provider.

To associate a specialty with a provider

1 Navigate to the Providers > Providers List view.

2 In the Providers list, drill down on the desired provider.

3 Click the Specialties view tab.

4 In the Specialties list, add a record and complete the necessary fields.

NOTE: To add a new Specialty, you must add a new value to the List of Values (LOV) by specifying 
the Type as FINS_AGDESG_HLTHSPEC_MLOV. For more information, see Siebel Applications 
Administration Guide.

Adding Profile Information
End users can use the Profile view to add profile information for providers. Profile information 
includes provider skills, background, business hours, and business locations.

To add profile information

1 Navigate to the Providers > Providers List view.

2 In the Providers list, drill down on the desired provider.
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3 Click the Profile view tab.

4 In the Skills and Background form, complete the necessary fields.

5 Scroll down to the Hours & Locations list.

6 In the Hours & Locations list, add a record and complete the necessary fields.

Adding Provider Contracts
A company may have one or more contracts with each provider with whom they do business. Each 
contract may have different terms, payment preferences, and payment methods. End users can use 
the Contracts view to add contracts with providers.

End users can set up different payment arrangements and methods for each provider contract.

To add a provider contract

1 Navigate to the Providers > Providers List view.

2 In the Providers list, drill down on the desired provider.

3 Click the Contracts view tab.

4 In the Contracts list, add a record and complete the necessary fields.

5 Scroll down to the Payment Preferences form.

6 In the Payment Preferences form, from the drop-down list, select one of the following:

■ Payment Preferences - Check. To pay using a check.

■ Payment Preferences - EFT. To pay using an electronic funds transfer.

7 In the selected Payment Preferences form, complete the necessary fields.

Viewing Provider Payments and Adding 
Payments Manually
End users can use the Payments view to review information about payments their company makes 
to providers. Payment information can include payment amount, payment date, payment 
adjustments, and reason for payment.

To view a provider payment

1 Navigate to the Providers > Providers List view.

2 In the Providers list, drill down on the desired provider.

3 Click the Payments view tab.

Provider payments are usually imported from an external billing system. You can add payments 
manually in the Providers list.
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To add payments manually

1 Navigate to the Providers > Providers List view.

2 In the Providers list, drill down on the desired provider.

3 Click the Payments view tab.

4 In the Payments list, add a record and complete the necessary fields. 

NOTE: You can scroll down to the Payment Details form to see additional fields.

Adding Provider Claims
A contract with a provider may specify that the provider is paid for each member visit or service. If 
so, providers or members may contact your company to initiate claims for payment. End users can 
use the Claims view to add claims for providers.

To add a provider claim

1 Navigate to the Providers > Providers List view.

2 In the Providers list, drill down on the desired provider.

3 Click the Claims view tab.

4 In the Claims list, add a record.

5 In the Add Claims dialog box, perform the appropriate task:

■ To choose an existing record, select a record and click OK.

■ To add a new record, click New and complete the fields.

NOTE: You can scroll down to the Claims form and complete additional fields.

Viewing and Printing a Provider Report
Provider reports can be viewed and printed by product and speciality.

To view a report of My Providers

1 Navigate to the Providers screen.

2 From the Show drop-down list, select My Providers.

NOTE: Only the providers listed in the Providers list will appear in the report.

3 Click the Reports Icon on the application tool bar.

4 Select a report from the drop-down list:

■ Provider by Speciality. Lists all the providers and their general information, sorted by their 
specialities (such as dermatology and pediatrics)
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■ Provider by Product. Lists all the providers with general information in the order of 
products (such as HMO Plus and PPO) with which they are contracted.

The Provider report appears in the Siebel Report Viewer.

5 To print the report, in the Siebel Report Viewer window, click the print button.

6 To return to the Providers list, close the Siebel Report Viewer.
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15 Managing Billing Accounts

This chapter contains the following topics:

■ “About Billing Accounts” on page 129

■ “Scenario for Billing Accounts” on page 129

■ “Process of Managing Billing Accounts” on page 130

■ “Creating Billing Account Records” on page 130

■ “Associating Billing Accounts with Other Records” on page 131

About Billing Accounts
To handle the payment of policy premiums, insurance companies use something called a billing 
account. A billing account is a construct that is used to handle the billing and payment activities 
associated with one or many insurance policies. The policy premiums are billed and collected through 
the billing account. This allows insurance companies to give users the flexibility to pay their 
premiums through a single bill, even though they may have several policies.

Siebel Healthcare provides flexibility for companies to handle billing-oriented transactions in various 
ways. Although billing accounts are a popular method within the industry, many companies handle 
billing on a single policy basis and many use a blend of billing account and single policy billing.

Using the procedures given in this chapter, end users will be able to use the Billing Accounts screen 
to add a billing account, associate a billing account with a policy, contact, or company, and add a 
service request to a billing account.

Scenario for Billing Accounts
This scenario features sample tasks performed by an insurance agent. Your company may follow a 
different workflow according to its business requirements.

An insurance agent creates a new billing account to manage the various policies held by one of her 
customers. First, she associates the policies and certain contacts with the billing account. In this 
context, a contact can be someone who is responsible for paying the bills associated with an account 
or someone associated with the billing account, such as the secondary insured on a policy. 

Later, the insurance agent receives a call from one of her contacts. The contact has a problem with 
his latest bill. The insurance agent logs a service request against the customer’s billing account.
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Process of Managing Billing Accounts
This section details sample tasks often performed by end-users when managing billing accounts. 
Your company may follow a different process according to its business requirements.

End-User Procedures
The following list shows tasks end users typically perform when managing billing accounts:

■ “Creating Billing Account Records” on page 130

■ “Associating Billing Accounts with Other Records” on page 131

Creating Billing Account Records
End users can add a new billing account record from any Billing Accounts view, including the Contacts 
screen, the Companies screen, the Service Requests screen, or the Billing Accounts screen.

To add a billing account

1 Navigate to the Billing Accounts screen.

2 Add a new record and complete the necessary fields. 

Some fields are described in the following table.

Field Comments

Account # Automatically generated by the application. You can configure Siebel 
Healthcare to assign a billing account number based on your company’s 
standards and conventions.

Effective Date Set to the current date.

Status Set to New.

Type The type of billing account. Select:

■ Single Policy if you will associate only one policy with the billing 
account.

■ Multiple Policy if you will associate more than one policy with the 
billing account.
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Associating Billing Accounts with Other 
Records
Billing accounts can be associated with policies, contacts, companies, service requests, and 
households. End users can make the associations directly from the Billing Accounts screen, the 
Contacts Billing Accounts view, or the Companies Billing Accounts views. 

Billing accounts can only be associated with households through an implicit relationship with a 
contact. That is, a billing account must be associated with a contact who is a member of a household 
in order for the billing account to be associated with the household. This relationship is then visible 
in the Households Billing Accounts view.

To associate a billing account with a policy

1 Navigate to the Billing Accounts screen.

2 In the Billing Account list, drill down on the billing account for which to associate a policy.

3 Click the Policies view tab.

4 In the Policies list, add a record.

The Add Policy dialog box appears.

5 Do one of the following:

■ If the policy already exists, select the policy in the Add Policy dialog box.

■ If the policy does not yet exist, click New to create a new policy.

The Add Policy dialog box closes and a record is added to the Policies list.

6 Complete the necessary fields.

The policy is now associated with the billing account.

NOTE: The billing account type determines how many policies should be associated. If the type 
is Single Policy, then only one policy should be associated.

To associate a billing account with a contact or a company 

1 Navigate to the Billing Accounts screen.

2 In the Billing Account list, drill down on the billing account with which to associate a contact or 
a company.

3 Click the Contacts view tab.

4 Do one of the following:

■ In the Contacts list, click New and either select or add a contact in the Add Contact dialog 
box.

■ In the Organizations list, click New and either select or add a company in the Add Companies 
dialog box.

The selected contact or company is now associated with the billing account.
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To add a service request to a billing account

1 Navigate to the Billing Accounts screen.

2 In the Billing Account list, drill down on the billing account to associate with a service request.

3 Click the Service Requests view tab.

4 In the Service Requests list, add a record and complete the necessary fields. 
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16 Integration

This chapter contains the following topics:

■ About the Siebel Financial Services Business Platform

■ Siebel Healthcare Integration Messages on page 134

About the Siebel Financial Services 
Business Platform
The Siebel Financial Services Business platform combines a set of tools, technologies, and prebuilt 
functional integration components to facilitate application integration. This set of products are 
referred to as Siebel Financial Services Business Application Integration (EAI). Siebel Financial 
Services EAI is an EAI solution built on top of Siebel EAI offered by Oracle. Siebel Financial Services 
EAI provides an integration solution using industry XML standards. These standards have been 
adopted by the industry and extended by middleware companies such as IBM MQSFSE. 

Siebel Financial Services EAI is designed as a set of interfaces that interact with each other and with 
other components within the Siebel application. These interfaces: 

■ Allow configurable messages within Siebel Tools for exchanging information using the various 
industry XML standards.

■ Expose internal Siebel Objects to external applications.

■ Take advantage of prebuilt adapters and enterprise connectors, and are compatible with third-
party adapters and connectors.

■ Allow prebuilt XML connectors for Siebel applications.

■ Allow for comprehensive data transformation.

■ Allow extension for customized XML connectors by providing the Siebel Industry XML Connector 
Factory API.

For more information on Siebel EAI, see Siebel Financial Services Enterprise Application Integration 
Guide and Overview: Siebel Enterprise Application Integration.
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Siebel Healthcare Integration Messages
Siebel Healthcare includes a number of integration messages designed to support key business 
processes for the healthcare industry. Table 4 describes these messages by defining the message 
type, the message purpose, the target application, and where you can find more information about it.

Table 4. Siebel Healthcare Integration Messages

Type Message Target Application Description

ASI Request Add/Cancel 
Group Policy Member

Policy Administration 
System

A message to add or cancel a group 
policy member.

For information, see Siebel 
Application Services Interface 
Reference.

ASI Response Add/Cancel 
Individual Policy 
Member

Policy Administration 
System

A message to add or cancel an 
individual policy member.

For information, see Siebel 
Application Services Interface 
Reference.

ASI Request Authorization Referrals and 
Authorizations System

A message to search for appropriate 
providers.

For information, see Siebel 
Application Services Interface 
Reference.

ASI Request Benefit Detail Benefits System A message to submit information 
required for determining eligibility.

For information, see Siebel 
Application Services Interface 
Reference.

ASI Request Member 
Details Update

Membership System A message to update demographic 
and contact details for a member.

For information, see Siebel 
Application Services Interface 
Reference.

ASI Request Preliminary 
Rating

Rating Engine A message to request a preliminary 
rate based on census and plan 
information.

For information, see Siebel 
Application Services Interface 
Reference.
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ASI Request Providers Provider System A message requesting benefit detail.

For information, see Siebel 
Application Services Interface 
Reference.

ASI Request Referral Referrals and 
Authorizations System

A message to submit authorization 
request.

For information, see Siebel 
Application Services Interface 
Reference.

ASI Update Provider Details Provider System A message to update the 
demographic and contact details for 
a provider.

For information, see Siebel 
Application Services Interface 
Reference.

Table 4. Siebel Healthcare Integration Messages

Type Message Target Application Description
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17 Business Services for Siebel 
Financial Services

This chapter describes the business services for Siebel Financial Services. It includes the following 
topics:

■ “About a Business Service” on page 138

■ “About Siebel Financial Services Business Services” on page 138

■ “VBC Cache and Instance Manager” on page 140

■ “Free Format Converter” on page 145

■ “Data Validation Manager” on page 146

■ “Business Rule Processor” on page 147

■ “Process of Defining Business Rule Processes” on page 148

■ “Creating and Managing Business Rule Processes” on page 149

■ “Defining Properties for a Business Rule Process” on page 152

■ “Defining Procedures for a Business Rule Process” on page 156

■ “Fine-Tuning the Assignment Statement” on page 164

■ “Handling Business Rules Processor Errors” on page 166

■ “Using BRP Helper Business Services” on page 168

■ “Invoking the Business Rule Processor” on page 178

■ “Logging Business Rules Processor Debug Messages” on page 180

■ “Requirements Manager” on page 180

■ “Customer Authentication Manager” on page 189

■ “Using the Calculation Manager” on page 195

■ “Using the Customer Expectations Manager” on page 201

■ “Using Data Transfer Utilities (DTU)” on page 204

■ “Automating Approval Processing” on page 219

■ “Automating the Display of Disclosure Documents” on page 223

■ “SmartScript Integration with Workflow” on page 226

■ “Dynamic UI Business Service” on page 229

■ “FINS Application View Navigation” on page 232
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About a Business Service
A business service is an object that simplifies the use of a specific set of functionality. Business 
services are not tied to specific objects, but rather operate or act upon objects to achieve a particular 
goal. You can use business services to execute predefined or custom actions in a workflow process.

For more information on:

■ Business services, see Overview: Siebel Enterprise Application Integration 

■ Workflows, see Siebel Business Process Framework: Workflow Guide

About Siebel Financial Services Business 
Services
Siebel Financial Services introduces a number of business services that fulfill a specific need in an 
end-to-end business process. The overall goal with these business services is to reduce the custom 
scripting that customers do during implementation. These business services benefit Siebel Financial 
Services customers in the following ways:

■ Increased efficiency and consistency with automation

■ Rapid deployment of functionality—less programming, and immediately deployable; SRF changes 
are not required

■ Better performance than scripting

■ Ease of maintenance—ability for a business analyst to maintain rules 

For example, the Data Validation business service allows customers to define data validation rules in 
an administration view that users trigger in run time. This significantly reduces the amount of custom 
scripting that would otherwise be required.

Other business services, such as the Disclosure and Approval business services, bring similar 
benefits to customers' disclosure and approval business processes. 
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Table 5 lists the business services available in Siebel Financial Services.

Table 5. Siebel Financial Services Business Services

Business Service Business Applications Functionality

Disclosure Manager Regulatory compliance, 
sales process 
compliance.

Present literature specific to products; logs 
presentation for compliance.

Approval Manager Policy exception 
approvals, underwriting.

Determines necessary approval sources 
and routes to inbox.

VBC Cache and Instance 
Manager

Cache data from external 
applications in Siebel for 
display.

Cache VBC data throughout user's session 
and use Siebel Workflow to query external 
data sources.

Free Format Converter Comma-delimited and 
other free-format 
message creation.

EAI Business Service to convert Siebel data 
to non-XML formats.

Workflow - SmartScript 
Integration

Embed Q&A style 
processes as part of a 
workflow process.

Launch SmartScript sessions within a 
workflow process. Pass information from 
SmartScript back into the workflow process 
for downstream processing.

Using Data Transfer 
Utilities (DTU)

Auto-creation, prefilling. Copies data from one Siebel BO/BC/Field to 
another BO/BC/Field.

Data Validation Manager Conditional logic, data 
integrity control.

Performs data validation across business 
component fields.

Requirements Manager Application closings, 
service case resolution.

Determines requirements and next steps 
for transaction completion.

Customer Authentication 
Manager

Transaction level 
security, regulatory 
compliance.

Situation specific customer authentication 
data collection and logging.

Using the Calculation 
Manager

Lead scoring, payment 
calculations, 
prioritization.

Performs arithmetic functions and if/then/
else calculations in background or through 
UI.

Using the Customer 
Expectations Manager

Customer services 
expectations, fulfillment 
expectations.

Calculates expected and promise dates, 
and sets priorities, based on item type and 
customer value.

Business Rule Processor Definition and execution 
of complex, frequently 
changing business logic.

Higher performance and more scalable than 
scripting. Can change business logic 
without a new SRF. Flexible - supports 
procedure, loops, if-then-else, switch-case 
constructs.
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CAUTION: As with other specialized code, users should use only the specialized business services 
that are documented in Siebel documentation. The use of undocumented services is not supported 
and can lead to undesired and unpredictable results.

VBC Cache and Instance Manager
Integrating external systems with Siebel data in real time is a common business requirement. A 
standard approach is to use Virtual Business Components (VBC) with a substantial amount of 
scripting. This approach, however, often has associated performance and scalability concerns. The 
Caching VBC was originally developed to address integration with external billing systems, and the 
design requires a minimal amount of scripting. These features, however, can be extended and applied 
to a broad set of integration challenges beyond billing.

Caching VBC Overview
The Caching VBC enhances the existing horizontal CSSBCVRec VBC class and works in conjunction 
with the SIA Billing Extern Service business service. Although the name of this business service 
implies that it is billing specific, it is a generic service without any industry specific functionality.

Features of the Caching VBC include:

■ Caching of response data, allowing navigation between records in a parent BC without generating 
duplicate requests in the child VBC

■ Ability to have a VBC be the parent of another VBC child within a single business object

■ Forced refresh of already cached data

■ Ability to generate integration object instances without using the EAI Siebel Adapter business 
service

■ Integration with workflow process that can take advantage of any existing integration flow that 
uses Application Service Interfaces (ASIs), Web Services, or connector technology

Possible limitations to consider:

■ Read-only behavior

Dynamic UI Business 
Service

Create read-only view 
that can be changed 
without the need to 
recompile and redeploy a 
Siebel Repository File 
(SRF).

Create and render views containing a single 
read-only applet in the Siebel Financial 
Services application. 

FINS Application View 
Navigation

View navigation. Guides users through a series of views 
based on administration data.

Table 5. Siebel Financial Services Business Services

Business Service Business Applications Functionality
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■ Only available as part of the Siebel Industry Applications (SIA) product

■ Queries are not supported

■ Only an active field of an active business component will have its value prefilled properly by the 
request integration object

■ The business service only references the top-level from the top-level integration component 
when creating the request message to populate predefault fields.

Components
Figure 2 shows the components to implement the Caching VBC.

Stages of the Caching VBC Process
The caching VBC process uses the following process flow.

1 The Caching VBC invokes the named service when queried.

2 User properties on the VBC identify:

■ Whether or not to enable caching

■ The service name to invoke (SIA Billing Extern Service)

■ The integration object name to be passed to the service as an input parameter

■ The workflow process name to be passed to the service as an input parameter

3 When the VBC is executed, the VBC calls the business service and passes it the integration object 
name and workflow process name.

4 The business service instantiates the named integration object and populates it with values in 
the currently active business object without using the EAI Siebel Adapter.

5 The business service passes the integration object instance to the SiebelMessage workflow 
process property and invokes the workflow process.

6 The workflow process handles any integration tasks, including communicating with the external 
system.

It receives data from the external system and populates a hierarchical process property that 
matches the field structure of the VBC.

7 The workflow process completes.

Figure 2. Caching VBC Components
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8 The business service reads the hierarchical output process property from the workflow process 
property named VBC Output and compares it with the fields in the VBC. 

Where matching field names are encountered, the value in the output process property is copied 
to the VBC. Field names that do not match are ignored and do not generate an error.

Caching VBC Configuration
Base the VBC on the CSSFABCVRec class. Table 6 lists the user properties VBC uses for its 
configuration.

You must also configure the fields for your business component. No other scripting is necessary to 
invoke the service or the workflow.

The VBC uses a special field called Vid. This field is an internally generated unique identifier. It is not 
necessary to create this field in your VBC. However, if you do create this field in your VBC, do not 
modify this value. Considered this field as a system field.

You can create link specifications between parent business components and this VBC, and between 
this VBC and any child VBC. Any field can be used as a link specification.

Table 6. User Properties for VBC Configuration

User Property Name Valid Names Description

Enable Caching Yes or No Yes enables the caching of 
records retrieved by the VBC.

No disables caching.

Outgoing Integration Object 
Name

An integration object name Name of the integration object 
to be passed to the business 
service.

ProcessName A workflow process Name of the workflow process 
to be passed to the business 
service.

Service Name A business service Name of the business service 
to be invoked when the VBC is 
executed.
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Purging the VBC Cache
Purge the VBC cache by configuring a button to invoke method RefreshVBCCache. Table 7 lists the 
consequences if Enable Caching is set to Yes or No.

Business Service Configuration
Base the business services specified in the Service Name parameter of the VBC on the 
CSSFAExternalService class, and have a method named query defined. You do not need to specify 
any input arguments to this method or configure any user properties. In this way, you can reuse this 
business service.

Integration Object Configuration
Use the integration object specified as the Outgoing Integration Object Name user property of the 
VBC to communicate record data between the business service and the workflow process. This 
integration object is non standard because it does not need to have an integration component for all 
the parent business components in the business object hierarchy. For example, if your business 
object hierarchy consists of Contact and the VBC as a child of Contact, you do not need to include a 
Contact integration component as the parent integration component in your integration object.

The reason for this is that this integration object is never used by the EAI Siebel Adapter. Therefore, 
you do not need to include the complete business component hierarchy in the integration object.

The integration object uses the PREDEFAULT user property (Table 8) on integration component fields 
to identify those fields that should be prefilled with data from the active business components:

Table 7. Consequences of Setting Enable Caching

If... Then...

Enable Caching is set to Y. The VBC purges cached values and forces a 
query of the external system.

Enable Caching is set to N. The RefreshVBCCache method has no effect.

Table 8. PREDEFAULT User Property

Integration Component Field 
User Property Valid Values Description

PREDEFAULT [Business Component 
Name.Field Name] 
For example, 
[Contact.Primary Personal 
Postal Code]

Identifies the source business 
component field that the 
Business Services uses to 
prefill the integration 
component field.
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After the workflow process completes, values in the integration component fields that have matching 
names in the VBC are copied back to the VBC. If the integration object has fields that do not match 
the VBC, then those fields are ignored and no error is produced.

Workflow Configuration
The workflow process specified as the ProcessName user property of the VBC is used to identify which 
workflow process the business service should invoke after instantiating the named integration object. 
Table 9 lists the two process properties that must be configured for this process to communicate with 
the business service.

Table 9. Workflow Process Properties

Process Property Name Type Description

SiebelMessage Integration Object The input of the workflow 
process. This is passed in by 
the business service.

Contains the integration 
object instance of the 
integration object identified 
with the Outgoing Integration 
Object Name user property 
on the VBC. This integration 
object instance contains data 
for integration component 
fields that have the 
PREDEFAULT user property 
set as described in the 
Integration Object 
Configuration section of this 
document.

VBC Output Hierarchy The output from the workflow 
process. 

This is returned to the 
business service. Contains 
the integration object 
instance of the result of 
querying the external system 
that is to be returned to the 
business service for inserting 
into the VBC.
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The SiebelMessage process property contains the query parameter for the external system. The 
workflow process transforms this data to a format understood by the external system, then uses a 
transport to send the request and receive the response from the business service. Finally, it must 
transform the response data back to a format that matches the VBC fields. This transformed 
response data needs to be stored in the VBC Output process property so that the calling business 
service can map it back to the VBC.

Free Format Converter
This section describes how to leverage the FINS EAI Free Format Hier Converter business service to 
convert a Siebel property set into a UTF-8 based text file structure for downloading.

Out of the box, the FINS EAI Free Format Hier Converter business service is used in the FINS 
eBanking Account Download Outbound workflow to enable the creation of flat file, tag-based data 
stream for download. The business service follows the same model as the EAI XML converter, but 
provides flexibility for manipulating the output data stream and header information.

If the desired output format is XML-based, use EAI XML Converter, XML Hierarchy Converter, or other 
XML related converter Business Service that Oracle provides. If the file format is not XML-based, use 
FINS EAI Free Format Hier Converter.

FINS EAI Free Format Hier Converter Methods
The FINS EAI Free Format Hier Converter business service provides two methods for creating text 
data streams:

■ PropSetToPlainText

■ PropSetToRawText

The difference between these two methods is that the PropSetToRawText method has the 
DiffBeginEndTag, EscCharSupport, and NewLineAfterNode user properties predefaulted. And in the 
PropSetToPlainText method, the following parameters are preset:

■ DiffBeginEndTag = N

■ EscCharSupport = N

■ NewLineAfterNode = Y

PropSetToPlainText and PropSetToRawText User Properties
Table 10 lists the user properties for the PropSetToPlainText and PropSetToRawText methods.

Table 10. User Properties

Parameter Name Description Predefault Value

BeginTagLeft A text value for the left boundary of the begin tag. <

BeginTagRight A text value for the right boundary of the begin tag. >
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Data Validation Manager
Many companies are governed by various regulatory agencies, as well as internal processes and 
procedures, to verify the quality and accuracy of their transactions. Data validation can involve many 
types of transactions, which includes orders, applications, claims, and various other service requests. 

Data validation is a key component of almost every business process in Financial Services. The Data 
Validation Manager business service can validate business component data based on a set of rules. 

DiffBeginEndTag Y or N

If there are different tags for the begin and end tag, 
then for XML, they are the same. Use “,” as the 
separator to set it differently.

For example, if this is set to Y, and the XML tag of 
any component is A,B, then the begin tag is A and 
end tag is B.

N

EndTagLeft A text value for the left boundary of the end tag. <

EndTagRight A text value for the right boundary of the end tag. >

EscCharSupport Y or N

Yes supports escape characters such as \n and \r.

Y

NewLineAfterNode Y or N

Yes prints a new-line character after each element.

N

PrintAggregateEndTag Y or N

Yes prints end tag for aggregate nodes.

Y

PrintElementEndTag Y or N

Yes prints end tag for element nodes (element that 
has no child).

Y

PrintEndTagBeforeChild Y or N

Yes prints the end tag before print out the first 
child.

N

PrintTagBound Y or N

Yes prints the tag boundaries.

Y

XMLHierarchy The IntObj instance that is parsed into the BusSvc.

Table 10. User Properties

Parameter Name Description Predefault Value
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In the case of a rule violation, a custom error message appears or a user-defined error code is 
returned. The validation rules are defined using the Siebel Query Language and can be conveniently 
constructed using the Personalization Business Rules Designer. The business service centralizes the 
creation and management of data validation rules without requiring Siebel Tools configuration, and 
does not require the deployment of a new SRF.

The Data Validation Manager business service significantly reduces the need for custom scripts, 
decreasing implementation costs and increasing application performance.

The Data Validation Manager features include:

■ Search automatically for the proper rule set to execute based on active business objects and 
views.

■ Write validation rules based on fields from multiple business components.

■ Apply a validation rule to a set of child business component records to see if a violation occurs 
from one or more records. 

■ Invoke specific actions to be performed as a result of a validation.

■ Write validation rules that operate on dynamic data supplied at run time without that data being 
from business component field.

■ Automatic logging of data validation events.

Some example business rules that can be enforced by the Data Validation Manager business service 
are:

■ In an insurance company, claim adjusters are required to enter a closed date whenever they 
close a claim. If the adjuster tries to close a claim without a closed date, he is prompted with an 
appropriate error message and the claim record is not committed to the database.

■ In a retail bank, different data validation rules are required for each of dozens of different service 
request types. When a customer service representative creates a new service request, the Data 
Validation manager identifies the appropriate validation rule set for the specific type of service 
request and executes the data validation rules of that rule set.

■ At a health insurance company, customer service representatives use activity plans and activities 
to track service requests. All activities must be closed before the service request can be closed. 
When the CSR closes the SR, the DVM loops through all associated activities making sure the 
status of each activity is closed. If any are still open, the SR cannot be closed.

For more information about Data Validation Manager, see Siebel Order Management Infrastructure 
Guide.

Business Rule Processor
The Business Rule Processor (BRP) business service is a general-purpose, highly-scalable business 
logic execution engine. The business logic is defined from within the Siebel client administration user 
interface, reducing the need to hard-code the logic into the Siebel Repository file. This supports 
scenarios in which there are constant changes to the business rules. The BRP can define and execute 
highly complex business logic.
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You can invoke the BRP by a run-time event, workflow, or Siebel script. This is described in Invoking 
the Business Rule Processor on page 178.

The Business Rule Processor features include:

■ Business logic administration through the application user interface.

■ Appropriate for complex business logic; supports procedure, loops, if-then-else and switch-case 
constructs.

■ Appropriate for business logic that changes frequently. You can modify business logic without 
deploying a new SRF.

■ Query, read, and write access to business components.

■ Error handling.

■ Support logging at multiple levels for easy testing and debugging.

■ Can potentially replace large amounts of custom scripts.

The BRP executes business rule processes. A business rule process is constructed much like a 
computer program or a Siebel workflow. A process consists of procedures. Procedures are made of 
steps. Steps, in turn, contain statements. A statement is a conceptual line of code.

BRP configuration and administration should only be done by expert users accustomed to working 
with business services.

TIP: Before you begin to create a business rule process, you need to carefully consider and plan out 
the required steps for the process.

Process of Defining Business Rule 
Processes
Defining business rules processes involves the following procedures:

1 “About Business Rule Process Property Types” on page 152

2 “Defining Procedures for a Business Rule Process” on page 156

3 “Using BRP Helper Business Services” on page 168
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Figure 3 presents an overview of defining business rule processes.

Creating and Managing Business Rule 
Processes
This topic describes how to create and manage business rule processes.

Figure 3. Business Rule Processor Design Diagram
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About Business Rule Processes
A BRP process is uniquely identified by its name. A process name must begin with a letter. It can 
contain alphanumeric, space, underscore, and hyphen. The name cannot contain other special 
characters like @ or !. 

NOTE: BRP names are case sensitive and limited to 75 characters.

TIP: It is important to establish a naming convention before you engage in the development of BRP 
processes.

About Defining Business Rule Processes
You define business rule processes from the Business Rule Processor screen. You can either revise 
an existing process or create a new one. 

A business rule process is made up of procedures and properties. 

A BRP process can have one of three statuses: 

■ In progress. You can modify only a process in the In-progress status

■ Active. An Active status indicates that the process definition is released for execution

■ Inactive. An Inactive process indicates that the process is in no longer in use and has been retired

NOTE: The status of process indicates its edit disposition rather than its current run-time execution 
status.

Additionally, all BRP process definitions are cached in the object manager across all login sessions to 
improve scalability. Hence, if any modifications are made to the process definitions, then they are 
not available to the run-time sessions until the cache is refreshed. 

It is recommended that you put in place procedures to promote BRP processes from development to 
production, and establish controls on how to refresh the cache.

You can import and export business rule processes. This makes migrating process definitions across 
development and production environments easier. The process is saved as an XML file for importing 
and exporting purposes. 

This step is part of Process of Defining Business Rule Processes on page 148.

To create a business rule process

1 Navigate to the Business Rule Processor screen.

2 Create a new record.

To revise an existing business rule process

1 Navigate to the Business Rule Processor screen.

2 In the Processes list, select a business rule process of status Active or Inactive and click Revise.

Clicking Revise changes the status of the process to In Progress. 
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3 Make the appropriate changes to the process.

To activate a business rule process

1 Navigate to the Business Rule Processor screen.

2 In the Processes list, select the business rule process you wish to activate.

3 Click the Activate button.

Clicking Activate changes the Status from In Progress to Active and makes the record read-only.

4 Click the Refresh Cache button. 

This clears the OM cache and creates a new copy of the process definitions.

Any process that is executing when the cache is cleared is allowed to complete. However, the 
new process definition is available to all processes that start right after the button is clicked.

NOTE: Take care while using this feature. Refresh Cache clears the cache for all BRP process 
definitions. Hence, any processes that are In-progress or Inactive are lost from the cache. 

To export a business rule process

1 Navigate to the Business Rule Processor screen.

2 In the Processes list, select the process you wish to export and click the More Info view tab.

3 In the Processes form, click the Export Process button.

4 Follow the on-screen prompts to save the rule set as an XML file.

To import a business rule process

1 Navigate to the Business Rule Processor screen.

2 Click the More Info view tab.

3 In the Processes form, click the Import Process button.

4 In the Workflow Process Import dialog box, locate the file you wish to import and click Import.

The imported process appears with a status of In Progress.

5 To activate the imported process, select it in the Processes list and click Activate.

Clicking Activate changes the rule set Status to Active and makes the record read-only. 

NOTE: If the process already exists, the process status must be In progress to allow the import.
View imported processes by performing a query/go operation to refresh the Processes list.



Siebel Healthcare Guide Version 8.0

Business Services for Siebel Financial Services ■ Defining Properties for a Business Rule 
Process

152 

Defining Properties for a Business Rule 
Process
Properties are:

■ Variables that are used either to facilitate flow of data in and out of a process or to store 
information temporarily for the life of the process.

■ Either global process properties or local procedure properties. Global properties are available for 
all procedures that are associated with the business rule process.

The property name:

■ Must begin with a letter.

■ Can contain alphanumeric, spaces, underscore, and hyphen. 

■ Cannot contain other special characters such as an ampersand (@ ) or exclamation mark (!).

■ Are case sensitive and limited to 75 characters.

NOTE: If a procedure defines a local property with the same name as a global property, the local 
property takes precedence over the global property within the scope of that procedure.

This step is part of Process of Defining Business Rule Processes on page 148.

About Business Rule Process Property Types
You can categorize properties into two classes:

■ Simple property types. Scalar properties such as an integer, string, or date.

■ Complex property types. Non-scalar properties such as property sets, vectors, and Siebel 
Business Component references. 

At run time, you can pass values for global properties to the BRP business service as an input 
argument. This run-time value overwrites the initial value definition, if any, on the property.

TIP: Use an appropriate prefix, such as global_, local_, or l_ to designate local and global 
properties.

Complex properties except ProperySet and Vector cannot be passed as inputs to a BRP process.
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Table 11 describes the complex types in further detail.

Table 11. Complex Property Types

Type Description

BusComp This data type stores a reference to a Siebel Business Component (BC) and 
is used in conjunction with the FINS CAP Buscomp Handler business service. 

See Using BRP Helper Business Services on page 168.

BusComp is used within BRP process as a stand-alone BC, without the 
context of Business Object (BO). Hence, you have to explicitly query the 
BusComp with the correct key values to establish a context.

Property Set Property sets are collections of properties used for storing data. They may 
have child property sets assigned to them to form a hierarchical data 
structure. 

See Siebel Object Interfaces Reference.

The Property Set itself can contain child property sets. This is particularly 
convenient to store array-like data. For example, to store multiple contacts 
and their properties such as Name, Phone Number, and Date of Birth. Each 
contact is stored as a child property set of Contacts. At the leaf, the property 
map stores data as a name-value pair.

A property set cannot be instantiated with an assignment. Property sets are 
always instantiated using a business service, such as FINS CAP Buscomp 
Data Loader Service. See Using BRP Helper Business Services on page 168.
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Vector Vectors are special-formatted Property Sets, where each non-leaf node 
stores a unique key as its value.

NOTE: The vector root node type for a BRP process is always 
SEBLFACapVector.

A vector cannot be instantiated with an assignment. Vectors are always 
instantiated using an business service, such as FINS CAP Buscomp Data 
Loader Service. See Using BRP Helper Business Services on page 168.

The following diagram shows a ProductRate vector that has 2 levels - Region 
& Product name. At the leaf level the vector stores the rate and the balance 
as key value pairs.

Table 11. Complex Property Types

Type Description
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To define a property for a business rule process

1 Navigate to the Business Rule Processor screen and select a process for which you want to create 
global variables.

Vector Reference Vector Reference is a reference to a property set, vector or a child property 
set. Once defined, you can use Vector Reference as a vector or propertyset. 

When the referenced object is reset, the dependent reference is 
automatically set to NULL.

This property set is particularly useful when accessing data on the child 
property sets. There are two ways to make a child Property Set reference:

■ childPropertySetRef = parentPropertySet[strkeyValue]

■ childPropertySetRef = parentPropertySet(nIndex)

About Using Parentheses
Round parentheses ( ) are used to retrieve a child Property Set by index. 

NOTE: The index starts at 0. 

Square parentheses [ ] are used to get a child Property Set by value. 

NOTE: Accessing by value is only valid for Vectors.

Only literals or property names can be used within [ ] or ( ). Expressions 
cannot be used within.

TIP: To use expressions within [ ] or ( ), assign these to a simple property 
type and use the simple property within [ ] or ( ).

You can use square and round parentheses in combination. 

Example:

grandchildPropertySetRef = parentPropertySet(2)["California"]

In the preceding notion, parentPropertySet itself can be a reference. In other 
words, a reference and a property set are used interchangeably for data 
access.

Retrieve leaf properties by using square parentheses [ ]. 

Example:

ProductRate = productRate[productId][domain]["Annual Fee"]

Table 11. Complex Property Types

Type Description
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2 Click the Properties view tab and create a new property completing the fields as necessary.

Some fields are described in the following table.

Defining Procedures for a Business Rule 
Process
Procedures are collections of steps. When a procedure is executed, each step in the procedure is 
executed in sequence.

One of the procedures is designated at the process level as the entry procedure. This procedure is 
executed when the process is executed. Within the entry procedure, other procedures are invoked 
by additional procedure statements.

Field Comments

Sequence Identifies the numeric sequence of this property. The application 
initializes properties in numerical order based on this number.

Data Type The data type for the property. The value can be one of the following. 

Simple types:

■ String

■ Integer

■ Number

■ Date

■ Boolean

Complex types:

■ Property Set

■ Vector

■ Vector Reference

■ BusComp

Value Initial value of the property.

Initial values can be set only for Simple property types.

Output Select this check box to make property an output argument and is used 
to pass information out of the business service. which has no output 
arguments of its own.

This flag does not apply to Complex property types except ProperySet 
and Vector.
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Each procedure is uniquely identified by its name. The name must begin with a letter. It can contain 
alphanumeric, spaces, underscores, and hyphens. It cannot contain other special characters such as 
an ampersand (@), exclamation mark (!), or percent sign (%). Procedure names are case sensitive.

A procedure can have its own local properties. These properties can only be accessed within the 
procedure where they are defined. If a local property has the same name as a global property, the 
local property takes precedence over the global property.

This step is part of Process of Defining Business Rule Processes on page 148.

To define a procedure for a business rule process procedure

1 Navigate to the Business Rule Processor screen and select a process.

2 Click the Procedures view tab, and create a new procedure.

3 In the Properties list, create new records to define local variables for the procedure.

The fields for a local variable are equivalent to those of a global variable. The fields are described 
in To define a property for a business rule process on page 155.

NOTE: Properties defined for a procedure are local variables accessible only to the parent 
procedure. You can define global variables in the Business Rule Processor Properties view. See 
Using BRP Helper Business Services on page 168.

To define a step for a business rule process procedure

1 Navigate to the Business Rule Processor screen, select a process and a procedure.
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2 Navigate to the Steps list and create a new record to define each step for the procedure.

Some of the fields are described in the following table.

3 Drill down on the Step Type and proceed to one of the following steps, depending on the step 
type.

■ “Statement Step” on page 158

■ “Business Service Step” on page 163

■ “Switch Step” on page 164

Statement Step
For a statement step:

Field Comments

Sequence The numerical order in which the steps are executed.

Step Type There are three types of steps:

■ Statement Step. Contains one or more child statements that are 
executed if and when the statement step is executed.

■ Business Service Step. Invokes a Siebel business service. Business 
Service Step provides a way to extend the capabilities of BRP beyond 
its out-of-box features. 

For instance, you could code custom functionality in an eScript and 
then wrapped as a Siebel Business Service. You could invoke this 
Business Service within the Business Service step and exchange 
arguments between the script and the BRP process.

■ Switch Step. Contains switch criterion and a switch block for each 
criteria. The switch block is like a statement step and contains one or 
more child statements.

TIP: Use the switch step if a variable is a bounded variable. From a 
performance and maintenance standpoint, a switch step is better than 
multiple conditional statement steps.

Inactive A check box to activate or inactivate a given step.

Comment A free text field used to document the step.

TIP: Make sure that each step has appropriate comments for ongoing 
maintenance of BRP process definitions.
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a Complete the fields in the Statement Steps form, some of which are described in the following 
table.

b Add one or more records to the Statements list, defining the statements of the statement step. 
Some of the field are described in the following table.

Field Comments

Condition A Siebel Query Language expression evaluated to be TRUE or FALSE. 

If the expression is evaluated to be TRUE, then the statement step is 
executed. If the field is not specified, then the statement step 
executes every time it is encountered.

Example: [SomeIntegerVariable] < 0

Loop If checked, the statement step iterates over and over as long as the 
Condition is evaluated to TRUE.

If neither Condition nor Loop is asserted, then the statement step is 
executed one time, unconditionally.

The looping is counted and compared with the maximum allowed Loop 
Count in order to avoid infinite looping. By default, this number is set 
to 1000, however, you can overwrite this value by defining the system 
preference FINS CAP Max Iteration. If the iteration number exceeds 
the maximum, an error is thrown. Refer to Handling Business Rules 
Processor Errors on page 166 for more information on handling errors.

TIP: Construct a For…next loop, by defining a local variable and then 
either incrementing or decrementing that variable in a statement. On 
the condition, check if the local variable has reached its limit.

Statement Type Value Expression Example

Assignment. 
Evaluates the 
expression and 
assigns the resulting 
value to the property 
listed in the Value 
field.

Name of a local, 
global, and system 
properties 
previously defined 
for the business 
rule process.

A Siebel Query 
Language 
expression.

Procedure. Invokes 
another procedure 
defined inside the 
BRP process.

Name of a defined 
procedure which is 
part of the business 
rule process.

Null and read-
only.
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PropertySet Value. 
Retrieves a property 
value from a property 
set or child property 
set, as defined by 
Expression. This 
property value is 
placed into the 
variable defined by 
Value.

Name of a local, 
global, and system 
properties 
previously defined 
for the business 
rule process.

A property set 
value retrieve 
expression. The 
expression must 
begin with a 
variable of type 
property set, 
vector set 
reference, or 
vector. 

Each index can be 
either a variable 
of type integer or 
number, or 
numeric literal. 
No Siebel 
calculation 
expressions can 
be involved.

EX: 
PropSet[AnIntege
r][“SomeName”]

PropSet(2)[“Som
eName”]

No Siebel 
calculation 
expressions can 
be involved.

Consider a Property Set 
called productRate that 
contains banking 
product information 
organized by Region and 
Product Name.

Retrieve the Annual Fee 
property from the 
Property Set and assign 
this to a local property 
named l_Rate, by 
setting:

Value = l_Rate

Expression = 
productRate["West"]
["Checking"]["Annual 
Fee"]

PropertySet Set 
Value. Assigns a 
value to a property 
set property value.

A property set 
value retrieve 
expression.

If the stated 
property name 
value does not 
exist, a new name/
value pair is 
created. 

Name of a local or 
global property.

If the property is 
not a string, it is 
internally 
converted to a 
string first by 
BRP.

Set the Annual Fee 
property on the Property 
Set productRate, by 
setting:

Value = 
productRate["West"]
["Checking"]["Annual 
Fee"]

Expression = l_Rate

Statement Type Value Expression Example
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PropertySet 
Reference. Creates 
a reference to a 
vector or property 
set. If the referenced 
object is a vector, the 
reference acts as a 
vector. Otherwise, 
the reference acts as 
a property set.

Creates an alias to a 
subset of a property 
set.

A local or global 
property of type 
Vector Reference.

The expression 
must begin with a 
variable of type 
property set, 
vector set 
reference, or 
vector.

Each index can be 
either a scalar 
property or a 
string or numeric 
literal. No Siebel 
calculation 
expressions can 
be involved.

Create a new Property 
Set Reference to all the 
products in the "East" 
region from the 
productRate Property 
Set, and assign this to a 
local variable 
l_east_prod, by setting:

Value = l_east_prod

Expression = 
productRate["East"]

PropertySet Sum. 
Retrieves an 
aggregation value 
from a vector or 
property set.

A local, global 
property.

The property 
should be of data 
type number or 
integer.

A property set 
value retrieve 
expression.

This expression 
differs from other 
property set 
retrieval 
expressions in 
that one of the 
indexes must be a 
wild card, 
indicating 
summing of all 
indices of that 
node. This is done 
by using an 
empty set of 
parenthesis.

If the child 
property set, or 
the property does 
not exist, the 
return value is set 
to null.

Calculate the sum of 
balances under the 
Savings product across 
all regions from the 
productRate Property 
Set, and assign this to a 
local variable 
l_savings_bal, by 
setting:

Value = l_savings_bal

Expression = 
producetrate[]
["Savings"]["Balance"]

Statement Type Value Expression Example
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PropertySet 
Childcount. 
Retrieves the number 
of child property 
sets.

A local, global 
property. 

Property should be 
of data type integer 
or number.

A property set 
reference retrieve 
expression.

If the property set 
does not have a 
child property set, 
the return value is 
0. If the property 
set does not 
exist, the return 
value is -1. The 
latter is a useful 
approach to 
determine if a 
property set, or a 
reference is null.

Calculate the number of 
products available in the 
west region from the 
productRate Property 
Set, and assign this to a 
local variable 
l_west_count, by 
setting:

Value = l_west_count

Expression = 
producetRate["West"]

Table Lookup. Look-
up a value based on 
ranges. The look up 
table is stored as a 
specialized property 
set. The property set 
consists of child 
property sets, and 
the child property 
sets contain three 
properties 
corresponding to 
Lower Bound, Upper 
Bound, and Value. 

At run time, for any 
input value, BRP 
looks up the child 
property set and 
locates the leaf 
whose lower Bound is 
smaller than the 
input value, but 
whose Upper Bound 
is bigger than the 
input value, and 
returns the Value 
property.

A local, global 
scalar property. 

The expression 
follows property 
set retrieval 
syntax, but in the 
following 
specialized 
format:

PropertySet 
[Upper Bound 
Field Name] 
[Lower Bound 
Field 
Name][Return 
Value Field Name] 
[InputProperty]

The Upper Bound 
Field Name, 
Lower Bound 
Field Name, and 
Return Value Field 
Name must be a 
string literal or a 
BRP string 
property. The 
InputPropety 
must be the name 
of a BRP numeric 
property used to 
do the lookup.

Consider a TaxRateTable 
vector, where High, Low, 
and Rate fields define 
the Upper Bound, Lower 
Bound, and Return 
Value. 

Lookup the effective tax 
rate for a person given 
the Total Income and 
assign this to a local 
variable l_tax_rate, by 
setting:

Value: l_tax_rate

Expression: 
TaxRateTable["High"]
["Low"]["Rate"]
[dMyTotalIncome]

Statement Type Value Expression Example
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Business Service Step
For a business service step:

a In the Business Service Step form, complete the fields as described in the following table.

b In the Arguments list, define required input and output arguments for the business service 
invoked. Some of the fields required are described in the following table.

Field Comments

Business Service The name of the business service to invoke. In particular for BRP, 
there are two helper business services that you are likely to use for 
data access: FINS CAP Buscomp Data Loader Service and FINS CAP 
Buscomp Handler.

For more information on these two business services, see Using BRP 
Helper Business Services on page 168.

Method The business service method to use.

BusComp A reference to a Buscomp Property Type.

This field is used only in conjunction with the two BRP helper business 
services, FINS CAP Buscomp Data Loader and FINS CAP Buscomp 
Handler. See Using BRP Helper Business Services on page 168.

Field Comments

Direction Type of argument: Input, Output, or Input/Output.

Name The argument name.

Use the pick list to select the name for registered business services. 
Picking the argument name automatically sets the direction.

Type The mechanics of passing values to the Business Service. Select from 
one of three values:

■ Literal. For Input and Input/Output arguments, the literal string 
in the value field is passed as an input to the Business Service 
method. For output arguments, this selection is invalid.

■ Property. For Input and Input/Output arguments, the value of the 
local or global property is passed as an input to the Business 
Service method. For output arguments, the return value is 
populated into the local or global property.

■ Expression. For Input and Input/Output arguments, the 
expression in the Value field is evaluated and is passed as an input 
to the Business Service method. For output arguments, this 
selection is invalid.
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Switch Step
For a switch step:

a In the Switch Steps form, enter the switch criteria, a Siebel Query Language Expression that 
evaluates to be a string.

b In the Switch Blocks list, create records and complete the fields as described in the following 
table.

c In the Statements list, enter one or more statements. See Statement Step on page 158 for 
details on creating statements.

Fine-Tuning the Assignment Statement
You can use two fields available at the statement level to fine-tune the performance of Assignment 
Statements:

■ Cache Flag

■ Light Parser Flag

For most cases, it is recommended to leave these fields at their default values. It is only necessary 
to consider changing these values if performance is deemed poor.

Value Contains different values depending on the argument type:

■ Literal. Contains the string value. 

■ Expression. Contains the Siebel query expression.

■ Property. Disabled.

Property Local or global property.

This field is disabled for Literal or Expression type arguments.

Field Comments

Value A string value used to compare with the switch step criterion value. 

If they are the same, the switch block is executed, which, in turn, 
executes the child statements belonging to the switch block.

Default If checked, the switch block acts as the default switch block. It is 
executed if no match is found for the switch step criteria.

At any point, you can disengage only one Switch Block as the default 
block.

Field Comments
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About the Light Parser Flag
Within your Siebel application, calculation expressions are evaluated using Siebel Query Language 
Parser. This parser could be performance and resource intensive if the expressions are simple 
numeric. However, to improve performance, BRP includes a high-performance light parser, which is 
used solely to evaluate numeric expressions. In most cases, the light parser works many times faster 
than the Siebel Query Language for simple numeric. 

The following examples are numeric expressions that can be handled by the light parser:

■ 12 + 8 + [A]* [B]

■ 5 + (12 + [A]* ([B] + [C]))

The following examples are considered complex and cannot be handled by the light parser:

■ IIf ([A] > [B], 0, 1)

■ [A] IS NULL

■ LN (10)

When the Light Parser flag is checked, BRP attempts to use the light parser to parse and evaluate 
the expression. If this fails, BRP resorts to Siebel Query Language engine to parse the expression. 
By default, Light Parser Flag is checked. 

TIP: If the Light Parser flag is checked, but the expression is not a simple expression, the BRP logs 
an entry in the log file at run time if the Siebel log level is informational or higher. Use these log 
entries to help you fine-tune assignment statements. See Logging Business Rules Processor Debug 
Messages on page 180 for more information.
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About the Cache Flag
Table 12 shows the options if the Cache flag is checked or unchecked. It is recommended that you 
leave this flag at its default value, that is, checked. 

NOTE: The Cache flag is only meaningful when the expression is not handled by a light parser. 

Handling Business Rules Processor 
Errors
BRP offers a mechanism to handle errors that includes two key features:

■ “Throwing Errors Within a Business Rules Process” on page 167

■ “Recovering From Errors Within a Business Rules Process” on page 167

Table 12. Cache Flag Options

If... Then...

The Cache flag is checked. Only one single parse tree is established for the 
expression within the object manager, 
irrespective of the number of open sessions. 

Therefore, when all sessions share the same 
parse tree, the memory footprint is reduced, 
however an overhead for context switch is 
assumed.

The flag is not checked. Each session has its own parse tree for the 
expression. 

There will be no context switch, but the memory 
footprint is increased. 
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Throwing Errors Within a Business Rules Process
The BRP process definition includes three global system properties to throw errors and provide some 
meaningful information when a run-time error occurs. These properties are presented in Table 13.

After each statement, step, or procedure is executed, the BRP processor checks if System_ErrorCode 
is an empty string. There are two ways to set System_ErrorCode:

■ Manually (Expected Error Conditions). An explicit assignment statement sets a non-empty 
string to System_ErrorCode.

■ Automatically (Unexpected System Error Conditions). The BRP Processor detects a system 
error such as failure to invoke a business service, or failure to evaluate a Siebel query language 
expression, and sets System_ErrorCode to a Siebel error code.

When System_ErrorCode is non empty, an error occurs and the BRP processor uses the following 
syntax to automatically set the error source to the full context of the current execution unit:

Statement Seq (Block Seq) Step Seq Procedure Name

where, Seq represents the sequence number of the Statement, Block, or Step. 

NOTE: Block is optional and occurs only inside a switch step.

The three output global properties System_ErrorCode, System_ErrorMessage, and 
System_ErrorSource are returned back to the calling process. 

Recovering From Errors Within a Business Rules 
Process
For every BRP process, a procedure can be nominated as the error procedure at the process level. If 
defined, when an error condition occurs, this procedure is automatically invoked to handle the error. 

On completion of the error procedure, System_ErrorCode property is rechecked. If it is empty, the 
execution continues from the point where the error was originally thrown. If the error code is still 
populated, the process does not necessarily end, but rather follows an error bubbling process. 

Table 13. Global System Properties for Errors

Property Name Type Description

System_ErrorCode String Alphanumeric error code.

This property contains an empty string when 
there is no error. 

System_ErrorMessage String Descriptive error message.

System_ErrorSource String Current context of the error.
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For example, if an error encounters in Statement 10 Step 5 Procedure Main, the error procedure is 
first executed with System_ErrorSource to be 'Statment 10 Step 5 Procedure Main'. If the error is 
not handled, the error bubbles one level higher, to Step 5 Procedure Main. The error procedure is 
then re-executed with System_ErrorSouce to be 'Step 5 Procedure Main'. If error is handled there, 
the next step following Step 5 is executed. Otherwise, the error bubbles to Procedure Main. 

The whole bubbling process continues until it reaches the process level, with System_ErrorSource to 
be Process myProcessName. If the error is not handled at the process level, the process ends with 
an error.

It is important that the error procedure be thoroughly tested. If an execution error occurs within the 
error procedure, the error procedure will not be recursively invoked; the error procedure will end 
with an error.

TIP: Use a Switch block within the error procedure to check for known error codes.

Using BRP Helper Business Services
In Siebel Financial Services, there are two helper business services that are used as business service 
steps within the BRP. They are both used to facilitate data access with a business rule process. The 
two business services are:

■ FINS CAP Buscomp Data Loader Business Service. The FINS Buscomp Data Loader is used to 
load data for prop sets.

■ FINS CAP Buscomp Handler Business Service. This business service takes the results of 
calculations done within the BRP and then either creates new buscomp records, updates existing 
buscomp records, or queries on calculation results. 

FINS CAP Buscomp Data Loader Business Service
Use this business service to load data from a Siebel business component into a Siebel property set. 
Additionally, once this data is loaded into a property set, it can be cached and shared across all login 
sessions.

This business service exposes three methods:

■ LoadData

■ ClearCache

■ NewVector
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About LoadData Method
Use the LoadData method to load Buscomp data into a property set. The property set follows the 
vector format. Table 14 describes the input and output parameters for this method.

NOTE: Default the Search Spec, Sort Spec, Hierarchical Key, Key Field, Value Field, and Aggregate 
field arguments by defining these as user properties on the source business component. Pre-fix the 
BC user property with FINS Data Loader to identify these fields. 

For example, define the default search spec as the Buscomp user property: FINS Data Loader Search 
Spec.

Table 14. LoadData Method Parameters

Parameter 
Name Direction Description

BusComp Input The name of a Siebel BC.

IsCachedData Input If true, the resulting vector is cached within the OM.   Further 
requests to load data from the same business component are 
handled through the cache. 

Cached data is retrieved based on the business component 
name. If a second retrieval request uses different search 
spec, fields, format, and so on, release the original cached 
data first.

Search Spec Input The search spec applied to the business component when 
loading data.

Since the FINS CAP Data Loader Service works outside the 
context of a business object, the search spec should include 
the appropriate user key fields.

Hierarchical Key 
[n]

Input Hierarchical keys define the hierarchy within the vector. These 
keys identify the unique key at each level.

Specify multiple hierarchical keys by defining [n] = 1, 2, 3 … n

Refer to the ProductRate vector illustrated under Defining 
Properties for a Business Rule Process on page 152. In the 
ProductRate vector, Region and Product fields represent the 
hierarchical keys.
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Sort Spec Input The sort specification applied to the business component 
when loading data.

It is important to match the Sort Spec and the hierarchical 
keys when creating the vector. When a business component is 
accessed through the FINS CAP Buscomp Data Loader 
Service, sorting controls the shape of the parent/child tree 
structure. Records are processed sequentially and are aware 
of only the last parent node key. When children nodes are 
added to a parent node, they continue to be added until a new 
value is retrieved for the hierarchical key. When a new key 
value is discovered, a new parent node is immediate created, 
and children are assembled under that parent. This process 
continues until all records are collected.

If a key equal to a previously processed node is retrieved after 
a different node key has been processed, a new node is 
produced rather than adding to the original.

Field [n] Input The name of Buscomp fields whose values are retrieved as the 
leaf propertyset properties. The property name is the field 
name, and the property value is the field value.

[n]=1,2,…

This represents one approach to how Buscomp fields can be 
retrieved. See Example of LoadData Method Using Field [n] on 
page 171. 

Key Field & Value 
Field

Input Used to retrieve data as Key/value pair and store as a 
property in the leaf propertyset. The field value of the Key 
Field is the name of the property and the value of Value Field 
is stored as the value of the property.

This is an alternative approach to Field [n] to retrieve data. 
See Example of LoadData Method Using Key Field and Value 
Field on page 172.

Duplicate Key/Value pairs are not allowed. If duplicates are 
found when the vector is created, the new entry replaces the 
old entry.

Table 14. LoadData Method Parameters

Parameter 
Name Direction Description
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Example of LoadData Method Using Field [n]
Golden Gate Bank defines its product rates in the Buscomp Financial Product. The fields in the 
Buscomp and some sample data are:

Use the following arguments to retrieve the data and store it in a format as defined by the 
ProductRate Vector sample diagram shown in Vector type in Table 11.

The data is stored into a vector named productRateVector. Then, the rate of the Checking product in 
the East region can be retrieved as:

       productRateVector["East"]["Checking"]["Rate"]

using a PropertySet Value statement.

Aggregate 
Field[n]

Input Fields that will be aggregated if duplicates occur. Multiple 
aggregate fields can be specified by defining [n] = 1, 2, 3 … n

This parameter is useful with the Key Field/Value Field data 
retrieval approach. For example, a contact can have multiple 
income records with different types. If the Aggregate Field is 
defined, the data loader service automatically sums the 
income and stores this as a single income key/value pair.

Vector Output The resultant vector output.

Region Product Balance Rate

West Checking 10000 0.2

West Saving 29000 2.1

West N Market 87560 2.5

East Checking 40000 0.24

Input Argument Name Value

Buscomp Financial Product

IsCachedData Y

Hierarchical Key 1 Region

Hierarchical Key 2 Product

Sort Spec Region, Product

Field 1 Balance

Field 2 Rate

Table 14. LoadData Method Parameters

Parameter 
Name Direction Description
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Example of LoadData Method Using Key Field and Value Field
Golden Gate Bank decides to implement its product rates using a different schema. Instead of one 
record for one product as shown in Example of LoadData Method Using Field [n] on page 171, they 
would like to store the data using name-value pairs for each product. The advantage of this approach 
is that they can add new attributes without schema changes. The data is stored in Financial Product 
Attribute buscomp in the following manner:

Use the following arguments to retrieve the data and store it in a format as defined by the 
ProductRate Vector sample diagram shown in Vector type in Table 11.

About ClearCache Method
Use this method to create an empty Vector or PropertySet. There is one output argument, Vector. In 
BRP, PropertySets and Vectors are uninitialized before they are populated by a business service 
method, for example, the data loader LoadData method. You can use the NewVector method to 
generate an empty PropertySet/Vector.

FINS CAP Buscomp Handler Business Service
FINS CAP Buscomp Handler Business Service provides the ability perform data operations such as 
query, update, and insert within the context of a business rules process. 

NOTE: The business component is established without the context of business object. Pay special 
care to identify the user keys for each record when inserting and setting values. Additionally, the 
normal Siebel error handling resulting from the business object context is not enforced.

FINS CAP Buscomp Handler Business Service provides the following five methods:

■ Query 

■ NextRecord

Region Product Attribute Name Attribute Value

West Checking Balance 10000

West Checking Rate 0.2

West Saving Balance 29000

East Saving Rate 2.1

Input Argument Name Value

Buscomp Financial Product Attribute 

IsCachedData Y

Hierarchical Key 1 Region

Hierarchical Key 2 Product

Sort Spec Region, Product

Key Field Attribute Name

Value Field Attribute Value
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■ GetFieldValue

■ SetFieldValue

■ InsertRecord

All of these methods need a BusComp variable to be defined under the business service step 
definition. See Business Service Step on page 163 for details on defining a business service step.

About Query Method
Use this method to retrieve data from a Siebel business component into a BRP BusComp property. 
Table 15 describes the input and output parameters for this method.

Table 15. Query Method Parameters

Parameter Name Direction Description

ActivateFieldName(1,2,3…n) Input The name of the fields that should be included in the 
query. List each field individually in a sequence.

Any field that you need to use with the GetFieldValue 
and SetFieldValue methods, must be activated prior 
to using these.

There are no limits to the number of fields that can 
be activated, however, care must be taken since this 
affects performance of the query.

BusCompName Input The Name of the business component from which the 
data is to be retrieved.

SearchSpec Input The search spec applied to the business component 
when retrieving data. This is a regular Siebel Query 
Language expression.

Since the business service operates without a context 
of business object, the search spec should include the 
appropriate user keys when the query is used for an 
update.

SearchSpecFieldName(1,2,3
…n)

Input Search Spec Field Name/Value pair is an alternative 
way to set search spec on a field. 

For example, SearchSpecFieldName1=Application 
Flag, SearchSpecFieldValue1=Y, then this is the 
equivalent of setting SearchSpec to be:

   [Application Flag] = Y

SearchSpecFieldValue(1,2,3
…n)

Input
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Figure 4 shows the use of Query method to retrieve data from the FINS Health Provider business 
component.

SortSpec Input The sort specification applied to the business 
component when querying data.

Status Output The status of the query operation. Status can have 
one of two values:

■ Succeeded. Indicates that the query returned at-
least one business component record.

■ Failed. Indicates that either the query returned 
no business component records or the query 
failed due to a system error.

Following any data operation, use the Status field to 
check for error conditions and take appropriate 
actions. See Handling Business Rules Processor 
Errors on page 166 for information on error handling.

Figure 4. Using Query Method to Retrieve Data

Table 15. Query Method Parameters

Parameter Name Direction Description
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About GetFieldValue Method
Use this method to get a value of a Business Component field into a local or global property. Table 16 
describes the input and output parameters for this method.

Table 16. GetFieldValue Method Parameters

Parameter Name Direction Description

BusCompName Input The Name of the business component from which the 
data is to be retrieved.

FieldName(1,2,3…n) Input Name of the fields to be retrieved. 

This field needs to be activated prior to retrieval. See 
Table 15 on page 173.

FieldValue(1,2,3…n) Output The output property into where the field value will be 
written. This is always of type property.

FieldName and FieldValue need to be defined in pairs. 
That is, for each FieldName defined, a FieldValue 
should be defined as well.

Status Output The status of the GetFieldValue operation. The status 
can have one of two values:

■ Succeeded. Indicates that the query returned at-
least one business component record.

■ Failed. Indicates that either the query returned 
no business component records or the query 
failed due to a system error.

Following any data operation, use the Status field to 
check for error conditions and take appropriate 
actions. See Handling Business Rules Processor 
Errors on page 166 for information on error handling.
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About SetFieldValue Method
Use this method to set a value of a business component field. Table 17 describes the input and output 
parameters for this method.

About InsertRecord Method 
Use this method to insert a record into a Business Component. Table 18 describes the input and 
output parameters for this method.

Table 17. SetFieldValue Method Parameters

Parameter Name Direction Description

BusCompName Input The name of a business component where the field to 
be updated is located.

FieldName(1,2,3…n) Input The name of the fields to be updated. 

This field needs to be activated prior to fetching. See 
About Query Method on page 173.

FieldValue(1,2,3…n) Input The new value for the field.

FieldName and FieldValue need to be defined in pairs. 
That is, for each FieldName defined, a FieldValue 
must be defined as well.

Status Output The status of the SetFieldValue operation. 

Status can have one of 2 values:

■ Succeeded. Indicates that the operation 
succeeded.

■ Failed. Indicates that the operation failed.

Use the status field to check for error conditions and 
throw appropriate errors. See Handling Business 
Rules Processor Errors on page 166 for information on 
error handling.

Table 18. InsertRecord Method Parameters

Parameter Name Direction Description

BusCompName Input The name of a business component to which a record 
is to be inserted.

FieldName(1,2,3…n) Input The name of the fields to be included in the insert. 
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About NextRecord Method
Use the NextRecord method to advance to the next record in a list of business component records. 
Table 19 describes the input and output parameters for this method.

FieldValue(1,2,3…n) Input The value for the field.

FieldName and FieldValue need to be defined in pairs. 
That is, for each FieldName defined, a FieldValue 
must be defined as well.

Status Output The status of the InsertRecord operation. 

Status can have one of 2 values:

■ Succeeded. Indicates that the operation 
succeeded.

■ Failed. Indicates that the operation failed.

Following any data operation, use the Status field to 
check for error conditions and take appropriate 
actions. See Handling Business Rules Processor 
Errors on page 166 for information on error handling.

Table 19. NextRecord Method Parameters

Parameter Name Direction Description

BusCompName Input The name of a business component.

Status Output The status of the NextRecord operation. 

Status can have one of 2 values:

■ Succeeded. Indicates that the operation 
succeeded.

■ Failed. Indicates that either the end record has 
reached or the operation failed with a system 
error.

Following any data operation, use the Status field to 
check for error conditions and take appropriate 
actions. See Handling Business Rules Processor 
Errors on page 166 for information on error handling.

Table 18. InsertRecord Method Parameters

Parameter Name Direction Description
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Invoking the Business Rule Processor
A business rule process can be invoked from a workflow or Siebel script. While the processor cannot 
be directly invoked from a run-time event, it can be invoked from a workflow that is triggered by a 
runtime event. For all three of these invocation methods, you can prepopulate global variables 
through the input arguments of the BRP. Input argument names must match the global variables you 
define.

For an example of how to invoke the BRP from a run-time event or a workflow, see the process for 
Data Validation Manager in Siebel Order Management Infrastructure Guide. 

For information on invoking the BRP from with eScript, see Using eScript to Invoke the Business Rule 
Processor on page 179.

NOTE: Within each session, BRP Processor creates a copy of the BRP executable objects. The 
executable objects belong only to a single login session and are not shared. These executable objects 
are cached within a login session. Release processes either explicitly or implicitly when the open 
session is closed.

The FINS CAP Processor Service Business Services exposes three methods. Table 20 describes these 
methods.

Table 20. FINS CAP Processor Service Business Services Methods

Method - Description Input Arguments Output Arguments

LoadProcess - The named 
calculation process definition is 
loaded, and an executable instance 
of the process is instantiated in the 
current Web session.

System_ProcessName - The 
name of a calculation process.

None.

RunProcess - This method executes 
the named process. If the process 
definition has not been loaded, the 
processor loads the definition first.

Whenever a BRP process is 
executed, the processor checks if the 
current process definition cached in 
the OM instance. If not, the 
processor instantiates the process 
definition into the OM instance.

System_ProcessName - The 
name of a calculation process.

System_ErrorCode

System_ErrorMessage

System_ErrorSource 

Return Codes. See 
Handling Business Rules 
Processor Errors on 
page 166.

ReleaseProcess - This method 
releases the named process 
executable in the current Web 
session. This does not affect other 
open Web sessions.

System_ProcessName - The 
name of a calculation process.

None.



Business Services for Siebel Financial Services ■ Invoking the Business Rule Processor

Siebel Healthcare Guide Version 8.0 179

Using eScript to Invoke the Business Rule Processor
The following is an illustration of how to invoke the BRP using eScript. 

Example of Loading the BRP Business Service 
This example provides a sample eScript that loads a BRP process definition.

var psIn  = TheApplication().NewPropertySet();
var psOut = TheApplication().NewPropertySet(); 
var bs    = TheApplication().GetService("FINS CAP Processor Service");

psIn.SetProperty ("System_ProcessName", "MyBRPProcessName");

bs.InvokeMethod("LoadProcess", psIn, psOut)

Example of Running the BRP Business Service
This example provides a sample eScript that executes a BRP process definition. The script also shows 
how to pass an input argument (g_AssetId) to a BRP process.

function WebApplet_PreInvokeMethod (MethodName)
{

if (MethodName == "InvokeMyBRP")
{

var psinputs  = TheApplication().NewPropertySet();
var psoutputs = TheApplication().NewPropertySet();
var oBusObj   = TheApplication().ActiveBusObject();
var oBusComp  = oBusObj.GetBusComp("FINS Group Policy");
var sAssetId  = oBusComp.GetFieldValue("Id");

psinputs.SetProperty ("g_AssetId", sAssetId);
psinputs.SetProperty ("System_ProcessName", "MyBRPProcessName");

var obs = TheApplication().GetService("FINS CAP Processor Service");
obs.InvokeMethod ("RunProcess",psinputs, psoutputs);

return (CancelOperation);
}
return (ContinueOperation);

}
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Logging Business Rules Processor 
Debug Messages
BRP provides different levels of execution logging in the form of trace files to facilitate debugging a 
process. Currently, there are two levels of BRP logging. These levels are detailed in Table 21:

The BRP log level is set with the environment parameter SIEBEL_FACAP_LOG_EVENTS.

BRP logging is written to the Siebel object manager log file. In order to enable BRP logging, the Siebel 
log level must also be informational or higher. For a mobile client, set the workstation system 
environment parameter SIEBEL_LOG_EVENTS = 3.

The SIEBEL_LOG_EVENTS can be set from Server Administration. Refer to Siebel System 
Administration Guide for more information.

In BRP logs, each local property is appended with its procedure name. For example, if a local property 
was defined as local_dMyIncome in Procedure Main, within the log file, this property would be 
identified as Main@local_dMyIncome.

CAUTION: BRP log files can grow quickly. In general, the logs should be enabled only for 
administrators to do debugging. 

Requirements Manager
The section is about the Requirements Manager business service and includes the following topics:

■ “About Requirements Manager” on page 181

■ “Administering Requirements Manager” on page 182

■ “Creating Record Templates” on page 182

■ “Creating Requirement Templates” on page 183

■ “Using Requirements Manager” on page 186

■ “Creating Record Group Templates” on page 186

Table 21. BRP Levels of Execution Logging

Level Severity BRP Implementation

4 Detail Log the execution and initialization path of the BRP process 
without details.

5 Debug Log execution details.

Under this level of logging, the values of local and global 
properties are logged as a part of the assignment statements.

TIP: To check the value of a variable, use a dummy 
assignment step.
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■ “Example of Using Requirements Manager for Record Group Templates” on page 188

About Requirements Manager
The Requirements Manager is a business service that automatically generates activities, customer 
submissions, and workflows required at predetermined steps in the business process. 

For example, a loan applicant may be required to submit proof of employment, account statements, 
and other documents. The Requirements Manager allows a business analyst to specify conditions 
under which certain documents would be required in order to move the application process forward. 
The business service is invoked at a predetermined point during the application process to generate 
the appropriate follow-up activities for customer submissions. 

The Requirements Manager can be applied to a wide variety of usage scenarios including service 
processes such as the auto-creation of a fund transfer service request. Some examples of 
Requirements Manager scenarios are:

■ Life Insurance. A life insurance policy might require a trailing document (a physical exam), an 
activity (such as an interview with an underwriter), and several forms to complete. If the product 
type = life insurance for instance, this set of requirements might be selected. However, an 
exclusion rule might be present to eliminate the need for the underwriter interview if the policy 
was for less than $100,000.

■ Mortgage Application. A mortgage application might require several documents, several 
disclosures, two annual tax returns (documents), an appraisal (activities), and a credit check 
(workflows) to complete. This set of requirements might be run for every mortgage, but there 
might be an exclusion rule such that if the loan-to-value is less than 50%, the tax returns are 
not required.

The Closing Requirement view is preconfigured in the Applications and Life & Annuities screens. You 
can use this to view the output of the Requirement Manager business service, for requirement 
templates defined on the FINS Application, and FINS Life Policy business objects respectively.

Key Features of Requirements Manager
The Requirements Manager business service provides the following key features:

■ Define multiple requirement templates that supports version control

■ Provide support for conditional expression in each requirement template

■ Define record templates that can insert records into any Siebel business object and component

■ Invoke predefined workflows automatically to support the processes

About Invoking Requirements Manager
Requirement Manager is invoked the same as any other business service; through a workflow, run-
time event, or script. At the time of execution, the service evaluates the various templates from 
which to execute, and executes each requirement where the exclusion rule evaluates to false.
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Administering Requirements Manager
Administering the Requirements Manager business service involves the following steps:

1 “Creating Record Templates” on page 182

2 “Creating Requirement Templates” on page 183

Optionally, you can create record group templates in order to aggregate other record group template 
and record templates. See Creating Record Group Templates on page 186.

Creating Record Templates
The Record template is used to define templates that will work in a specific business object/ 
component. It also defines the fields that will automatically populate the template in that business 
object/component. Upon execution, the business service generates a record in the business object/
business component and populates the fields according to the specified template. 

To create a record template

1 Navigate to the Administration - Record Template screen > Record Template view.

2 In the Record Template list, create a new record, and complete the fields.

Some of the fields are described in the following table.

Field Description

Template Name Name for the record template.

Display Name The display name of the template as seen in the UI.

Business Object The business object for the template to be enabled.

For example, to auto populate a record in the Applications or Life & 
Annuities screen, you must select FINS Application or FINS Life 
Policy business objects, respectively.

Business Component Business Component on the selected business object.

The Record Template Administration view is preconfigured so you 
can specify the prefill of two applets in the Closing Requirements 
view: activities and documents. 

For example, to prefill the record in one of these two applets, you 
must select Action or INS Policy Document, or FINS Application 
Mortgage Trailing Documents business component.
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3 In the Fields list, create a new record and complete the fields.

Some of the fields are described in the following table.

4 In the Related Record Template list, create a new record and complete the fields.

The Related Record Template applet is used to specify child and grand child of record templates. 
Upon execution, the business service inserts a record as specified in the parent record template, 
as well as all records specified in child and grandchild templates.

Creating Requirement Templates
The Requirement Template is used to aggregate several record templates. The record template 
specified in Creating Record Templates on page 182 only inserts one record in the business object/ 
business component. Insert multiple records in different business objects/components, by 
aggregating multiple record templates in a single requirement template. Additionally, in a 
requirement template, you can specify a workflow to invoke. 

To create a requirement template

1 Navigate to the Administration - Requirement Template screen > Workflows view.

2 In the Requirement Template list, create a new record and complete the fields.

Some of the fields are described in the following table.

Field Description

Sequence # Sequence number for the fields.

Field Name The field name in the specified business component.

Pre-Default Value The prefilled value for the field.

NOTE: You can put conditional statements on this field.

Business Component Read-only field of the business component name.

Field Description

Template Name Name for the requirement template.

Display Name The display name of the template as seen in the UI.

Business Object The business object for the template to be enabled.

For example, to pick the template name in Applications or Life & 
Annuities screen, you must select FINS Application or FINS Life 
Policy business objects, respectively.
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3 In the Workflow list, create a new record and complete the fields.

Some fields are described in the following table.

Business Component Business Component on the selected business object.

For example, to be able to pick the template name in the 
Applications or Life & Annuities screen, you must select 
Opportunity or FINS Life Policy business components, respectively.

Condition A valid Siebel query language expression. If this conditional 
expression evaluates to True then the rules under the rule-set 
would be evaluated.

TIP: Use the expression builder to test the validity of conditional 
expressions.

Version The version number of the template. 

NOTE: When you select the Revise button, the Siebel application 
automatically versions the template.

Status Status of the template with values: active, pending active, inactive, 
outdated, and in progress.

Start Date Start date for the template.

You can specify a date in the future, and when activated, the status 
of the template changes to Pending Active. The application 
automatically changes the status to Active on the specified date 
and time, and executes the appropriate version of the template.

End Date End date for the template.

The application sets the status of the template to Outdated once 
the specified end date arrives.

Field Description

Sequence # Sequence number for the workflow.

Workflow Name Name of the workflow that is enabled for the business object/
business component specified in the requirement template.

NOTE: The workflow called here should be deployed and active. 
Please see Siebel Business Process Framework: Workflow Guide for 
further information.

Exclusion Rules A valid Siebel query language expression. If this conditional 
expression evaluates to True, then the workflow is excluded.

Field Description
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4 Click the Record Template view tab.

5 In the Record Template list, create new record, and complete the fields in the list.

Some fields are described in the following table.

6 In the Requirement Template list, click Activate.

7 (Optional) To revise the requirement template, click Revise.

8 (Optional) To deactivate a requirement template, click Deactivate.

Execute Immediately A flag to automatically execute the workflow when the requirement 
template is executed. This field should be empty to execute the 
workflow manually.

See Using Requirements Manager on page 186 for information on 
executing the workflow manually.

Workflow Context A text field passed as process properties to the workflow.

The format of this field should be in the form of comma delimited, 
Name-Value pairs. For example:

“State”, “CA”, “Source BusComp”, “FINS Life Policy”

Where State and Source BusComp are property names, and CA and 
FINS Life Policy are property values, respectively.

Business Component Read-only field similar to the business component specified in the 
requirement template applet. Identifies the business component on 
which the exclusion rules will be evaluated.

Field Description

Template Name Select the template you want to associate with the requirement 
template.

Exclusion Rule A valid Siebel query language expression. If this conditional 
expression evaluates to True, then the record template is excluded.

Expectation Set A flag to automatically invoke the Customer Expectations Manager.

NOTE: The Customer Expectations Manager should be set before 
hand for this to work. Please see Using the Customer Expectations 
Manager on page 201 for more information.

Auto-Assign A flag to automatically invoke the Siebel Assignment Manager.

NOTE: Assignment Manager should be set before hand for this to 
work. Please see Siebel Assignment Manager Administration Guide 
for more information.

Field Description
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Using Requirements Manager
Use the Closing Requirement view, enabled in the Applications and Life & Annuities screens, to view 
the output of the Requirement Manager business service, for requirement templates defined on the 
FINS Application, and FINS Life Policy business objects respectively. However, through configuration, 
the Requirements Manager can be invoked from any screen. 

When invoked, the business service automatically prefills the target list or form with records as 
defined in the Administration - Requirement Template screen. 

To invoke Requirements Manager

1 Navigate to either:

■ Applications screen > Application List view > Closing Requirements view

■ Life & Annuities screen > Life Policy List view > Closing Requirements view

2 In the Templates list, create a new record.

3 Select the template name as defined in Creating Requirement Templates on page 183.

4 In the Templates list, click Execute.

Requirements Manager prefills Activities, Workflow, and Documents lists based on the records 
specified in the Administration - Requirement Template screen.

5 Complete the fields in the Activities, Workflow, and Documents lists.

NOTE: If the workflow is not set to run automatically, you can set the workflow manually by clicking 
Execute in the Workflow list.

Creating Record Group Templates
The Record Group Template is used to define a template that works in a specific business object/
component. The Record Group Template is used to aggregate other record group template and record 
templates. A record group template is based on the business component relationship defined in the 
business object layer. You can use the record group template to recursively execute interrelated 
business components, and generate data in a particular business component. 

A record group template can include other related record group templates and related record 
templates. When the business service executes a record group template, it automatically, recursively 
executes any other related record template or related record group template defined. 

Creating a Record Group Template involves the following steps:

1 Creating Record Group Templates 

2 Creating Related Record Group Templates

3 Creating Related Record Templates

For an example of setting up a record group template, see Example of Using Requirements Manager 
for Record Group Templates on page 188.
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To create a record group template

1 Navigate to the Administration - Record Template screen > Record Group Template view.

2 In the Record Group Template list, create a new record and complete the fields.

Some fields are described in the following table.

3 In the Related Record Template list, create a new record and complete the fields.

You can use the Related Record Template list to specify a child of the record group template. Upon 
execution, the business service inserts a record in the business component on which the record 
template is defined, for the corresponding parent record. 

4 In the Related Record Group Template list, create a new record, and complete the fields.

You can use the Related Record Group Template list to specify the child record group template. 
Upon execution, the business service executes the business component on which this record 
group template is defined, within the context of the corresponding parent record group template.

Field Description

Template Name Name for the record group template.

Display Name The display name of the template as seen in the UI.

Business Object The business object for the template.

Business Component The business component on the selected business object.

Field Description

Template Name Name of the child template record.

Exclusion Rules A valid Siebel query language expression. If this conditional 
expression evaluates to True, then the related record template is 
excluded.

Repeat Expression A field indicating the number of times the record template should 
be executed within the context of the parent record group 
template. By default this is set to 1.

Business Component Read-only field. Identifies the business component on which the 
exclusion rules are evaluated.

Field Description

Template Name Name of the related record group template.

Exclusion Rules A valid Siebel query language expression. If this conditional 
expression evaluates to True, then the related record template is 
excluded.

Business Component Read-only field. Identifies the business component on which the 
exclusion rules are evaluated.
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Example of Using Requirements Manager for Record 
Group Templates
This section provides an example of configuring record group templates for automatically generating 
vehicle coverages.

Record group templates can be used to automatically generate default coverage for vehicles in an 
auto policy. 

To setup auto coverage

1 Navigate to the Administration - Insurance screen > Auto Coverages view.

2 For each auto coverage in the Coverage Administration list, in the Coverage Values list, check 
the default flag for one of the values.

To configure a record group template for generating vehicle coverages

1 Navigate to the Administration - Record Template screen > Record Template view. 

2 Create a new record in the Record Template list, and enter the values as shown in the following 
table.

3 Leave the Fields list empty. 

The predefault values set for the fields in this business component in Siebel Tools will be 
considered during execution.

4 Click the Record Group Template link bar, create a new record in the Record Group Template list, 
and enter the values as shown in the following table.

Field Value

Template Name INS Vehicle Default Coverage

Display Name Auto Default Coverages

Business Object INS Policy

Business Component INS Vehicle Default Coverage

Field Value

Template Name INS Vehicle Available Coverage Value Template

Display Name INS Vehicle Available Coverage Value Template

Business Object INS Policy

Business Component INS Vehicle Available Coverage Value

Condition [Default]='Y'
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5 In the Related Record Template list, create a new record and pick the record template defined in 
Step 2.

6 Create another new record in the Record Group Template list, and enter the values as shown in 
the following table.

7 In the Related Record Group Template list, create a new record and pick the record group 
template defined in Step 2.

To create an new auto policy

1 Navigate to Auto Policies screen and create a new policy.

2 Drill down on the Policy # record to navigate to the Quick Quote view and create the following 
records:

a In the Vehicles list, create new vehicles 

b In the Drivers list, create new driver records

3 Click the Rate Model view tab.

The vehicles list should display the vehicles created in the previous step.

4 Select a vehicle record and click Default Coverages.

The Select Templates to Run dialog box appears, and displays the template defined in Step 6 after 
evaluating any conditional expressions defined.

5 In the dialog box, click Execute.

Default Vehicle Coverages are automatically created in the Vehicle Coverage list for the selected 
vehicle record. These default coverages correspond to the default coverages selected in the 
Administration - Insurance views in Step 2.

Customer Authentication Manager 
Financial service institutions require customer authentication before a financial transaction can take 
place. Furthermore, authentication becomes important as privacy and security regulations have 
become common in the retail banking, and also make their way into insurance and healthcare 
businesses. 

Field Value

Template Name INS Vehicle Template

Display Name Default Vehicle Coverage Template

Business Object INS Policy

Business Component INS Vehicle 
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Typically, a bank may enforce tiered authentication policies that require a basic validation for 
transactions up to certain limit, and require more rigorous transaction-based authentication for 
transactions over the limit. In certain cases, for customers who perform regular high-value 
transactions, the bank may use token validation, common ones being RSA tokens, or scratch lists.

Customer Authentication Manager is a utility that can be used to implement a secure and auditable 
customer authentication during a sales or service process. You can use the Customer Authentication 
Manager to prompt customer service representatives to authenticate a caller before providing any 
service. It provides the following key features:

■ Ability to define multiple authentication templates using fields from the contact profile

■ Rules-based, context sensitive invocation of authentication template

■ Access from the global toolbar

■ Audit trail of past authentication events; facilitates quick and accurate conflict resolutions

■ Ability to define success and failure workflows to take appropriate actions

Administering Customer Authentication Manager business service involves the following steps:

1 “Creating Customer Authentication Templates” on page 190

2 (Optional) “Defining Customer Authentication Rules” on page 192

Creating Customer Authentication Templates
Customer authentication templates define the credentials used for authentication and the actions 
that follow a successful or a failed authentication attempt. 

To create a customer authentication template

1 Navigate to the Administration - Application screen > Authentication Template view.

2 In the Templates list, create a new record, and complete the fields.

Some fields are described in the following table.

Field Comments

Name Name for the authentication template. 

Description Description for the template.

Success Workflow Invoke this Siebel workflow if the authentication is successful. 

The workflow called here should be deployed and active. The fields 
used for authentication are passed as process properties to this 
workflow.

TIP: Use the success workflow to log the status of the 
authentication for audit purposes.
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3 In the Credentials list, create a new record, and complete the fields.

Some fields are described in the following table.

Failure Workflow Invoke this Siebel workflow if the authentication failed. 

The workflow called here should be deployed and active. The fields 
used for authentication are passed as process properties to this 
workflow.  

Default If flagged as default, this template is used as the default template. 
The default template is invoked if all rules defined in the 
Authentication Rules fail.

Only one template can be flagged as default.

Alternate Template Defines an alternate template to use for authentication if the caller 
fails to authenticate using the current template. The alternate 
template is invoked by clicking the alternate button on the 
authentication pop up window.

Field Comments

Business Object Business Object for the credential field. 

In the current Siebel release, the Contact business object is the only 
business object that is available for use. Hence, this field is 
predefaulted and read-only.

Business Component Business Component reference for the credentials field.

The business component used here should be a valid business 
component on the Contact business object.

Field Name Name of the business component field.

Only single value fields are supported; multi-value fields are not 
supported and may cause system instability if used.

Display Name The display name for the business component field. This specifies 
the label for the field at run time.

Search Specification For any one-to-many contact business component, the search 
specification provides the criteria to narrow selection to a single 
record.

Required Flag Flag indicates that the field needs to be verified for the 
authentication to be successful. If a required field is not confirmed 
at run time, the authentication fails.

Defaults to No.

Field Comments
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Defining Customer Authentication Rules
Customer authentication rules define the logic to select an authentication template. When the 
authentication manager is invoked, the business service steps through each rule for all applicable 
rule-sets to find a rule that evaluates to true. The template defined against this rule is used for 
authentication. If no rules are defined, or if none of the rules succeed, the default template, if 
defined, is used for authentication.

To create a customer authentication rule

1 Navigate to the Administration - Application screen > Authentication Administration view.

2 In the Rule Sets list, create a new record, and complete the fields.

Some of the fields are described in the following table. 

NOTE: If the conditional expression is not used, there should be only one rule-set per business 
object/business component defined. If there are multiple rule-sets for the same BO/BC, and a 
conditional expression is not defined, then the sequence of examination is random.

3 In the Rules applet, create a new record, and complete the fields.

Some of the fields are described in the following table.

Field Comments

Name Name for the authentication rule set.

Description Description for the rule set.

Business Object Business Object context for evaluating the rules. 

Business Component Business Component context for the conditional expression and 
rules evaluation.

Conditional Expression A valid Siebel query language expression. If this conditional 
expression evaluates to True, then the rules under the rule-set are 
evaluated.

TIP: Use the expression builder to test the validity of conditional 
expressions.

Active Flag Flag to activate or inactivate a rule-set. 

The field predefaults to Inactive.

Field Comments

Sequence Sequence number for rule evaluation.

Business Component Business component reference for the expression evaluation.

This field predefaults to the BC on the rule-set definition, and is a 
read-only field.
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Invoking Customer Authentication Manager
Customer Authentication Manager is available preconfigured on the Contact, Members, and Providers 
screens. However, using Siebel Workflow, you can invoke the Customer Authentication Manager from 
any screen that contains a Contact, Member, or Provider business component. 

Figure 5 shows the authentication icon on the toolbar. Click this icon to invoke the Customer 
Authentication Manager.

To authenticate a contact

1 Navigate to the Contacts List view.

2 Select the contact to authenticate and click the authentication icon on the toolbar.

The Siebel Authentication Manager dialog box appears. 

3 Check the Confirmed checkbox for each field listed.

Inclusion Expression Siebel query language expression that specifies the rule.

If this conditional expression evaluates to True, then the template 
associated with the rule is selected; further evaluation of the rules 
is aborted.

TIP: Use the expression builder to test the validity of Inclusion 
expressions.

Template Name The authentication template to use if the rule succeeds.

Figure 5. Authentication Icon on Toolbar

Field Comments
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4 Do one of the following:

NOTE: When Authentication Manager is invoked, if a matching template is not identified, an error 
message appears.

Configuring Customer Authentication Manager to 
Handle More Fields

By default Customer Authentication Manager is configured to handle only a maximum of three fields. 
To use more than three fields in Customer Authentication Manager, you must add more virtual fields 
to the authentication business component, and expose them through the appropriate applet.

To configure Authentication Manager to handle more fields

1 Log in to Siebel tools.

2 Navigate to the FINS Authentication Manager UI business component.

The following fields are defined for the business component: 

■ Field0, Field1 and Field2 

■ Required Flag0, Required Flag1, and Required Flag2

■ Ten confirmed flag fields

3 Define a new field called, Field3.

4 Define a new field called, Required Flag3.

5 Add a new confirmed flag field if you have more than 10 authentication fields.

6 Navigate to the FINS Authentication Manager Popup Form Applet.

7 Go to applet Control, and add the new fields: Field3, Required Flag3. 

8 Add a confirmed flag field if you have more than five authentication fields. (The applet already 
contains five confirmed flag fields).

9 Add the fields and corresponding labels to the applet templates.

10 Compile the changes into the SRF.

To... Click...

Authenticate. Authenticate. 

If all required fields are confirmed, the 
authentication succeeds. 

Use an alternate template. Alternate. 

If an alternate template is defined, it appears.

Cancel authentication. Cancel.
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Using the Calculation Manager
The Siebel Calculation Manager is designed to allow financial services institutions to declaratively 
define and execute simple to moderately complex calculations within their Siebel application. It is 
implemented as a business service that accepts input parameters for calculation, and the results are 
available as output parameters. The Calculation Manager is tightly integrated into the Siebel 
application architecture and can use Siebel Business component fields for input or output. The 
business service facilitates specification of embedded calculation by business analysts.

Some examples of how Siebel Calculation Manager could be used:

■ Loan Payment Schedule. The term, amount, and interest rate of a consumer installment loan 
are captured in a Siebel Application. Calculation Manager is invoked to generate a schedule of 
the amounts due—split by principle and interest—for each month of the term. The user evaluates 
the schedule, runs several what-if scenarios with different loan amounts, and then exports the 
schedule to an excel spreadsheet.

■ Currency Conversion. A user wants to know the value of $100,000 in Japanese yen at the 
current exchange rate. Calculation Manager is invoked, and an input dialog box is presented. The 
current exchange rate has been prefilled into the dialog box. The user enters 100,000 as an 
input, and clicks Calculate to see the result. The results are not saved.

■ Early Withdrawal Penalty Calculation. A customer wants to remove money from a retirement 
account he holds, but there is a penalty involved. The calculation of the penalty is complex, and 
has been entered into the Siebel application as eScript. Upon invoking the Calculation Manager, 
the Siebel application pulls in the variables necessary for the penalty calculation and runs the 
eScript. The result is saved in the Siebel business component.

Specifying Calculation Rules
Calculations are entered as calculation rules in a list, similar to how validation rules or Siebel 
personalization rules are administered. 

Calculation rules are specified in three stages:

1 Specify a calculation rule-set. 

See To specify a calculation rule-set on page 195.

2 Specify variables used in the calculation. 

See To specify variables on page 196.

3 Specify calculation details. 

See To specify calculation details on page 197.

To specify a calculation rule-set

1 Navigate to the Administration - Application screen > Calculation Manager view.
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2 In the Rule Sets list, create a new record, and complete the fields. 

Some fields are described in the following table.

To specify variables

1 Navigate to the Administration - Application screen > Calculation Manager view.

2 Select a Rule Set for which you want to specify variables.

3 in the Variables list, create a new record and complete the fields.

Some fields are described in the following table.

Field Comments

Name Calculation rule set name. Rule-set names are language 
independent.

Comments Rule set description.

Business Object Business object context for evaluating the rules.

Array Output Business 
Component

Business component context for writing the output of an array 
calculation, such as Amortization table calculation.

Active Flag Flag to activate the calculation rule set. By default a calculation rule 
set is inactive.

Script Flag Flag to indicate that the calculation rule is specified as a script, 
rather than declarative rules.

Type List of values that provide the ability to categorize rules for easier 
administration.

Applet Title Title for the pop-up applet that appears when the calculation 
manager is invoked in the interactive mode.

Field Comments

Sequence Number Sequence number for the variable specification. The variables on the 
pop-up applet appear in the sequence specified.

Name Internal name for the variable used when specifying the calculation 
rule.

Variable names can contain a maximum of 35 characters and cannot 
include spaces or arithmetic operators. 

Display Format Display format for the variable. Example,

$###.##

Display Name Label for the variable when presented to the user.

Type Type of variable. Values are Input, Output, or Output Array.

Business Component Business component context for the variable.
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To specify calculation details

1 Navigate to the Administration - Application screen > Calculation Manager view.

2 Select a Rule Set for which you want to specify calculation details.

BC Field Name Business Component field name.

If the variable is an:

■ Input variable, the run-time value of the business component 
field name is assigned to this variable. 

■ Output variable, the value calculated for the variable is written 
into the business component field name.

Optional Optional variables are variables not critical to the calculation, but 
may be specified to alter the calculation. 

This flag defaults to No.

Default Value Default value for the variable in the calculations. This value appears 
in the dialog box for the variable.

Testing Value Value for the variable when the Calculation Manager is invoked in the 
simulator.

Suppress Display Flag to indicate that the variable is hidden, and not displayed when 
calculation manager is invoked in the interactive mode.

Variable Include Include the variable in the script generation.

Field Comments
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3 In the Rules list, create a new record, and complete the fields.

Some fields are described in the following table.

Example of Using Embedded eScript for Mortgage 
Calculation
For compound calculations, embedded eScript is a more appropriate mechanism. The following is an 
example of a mortgage calculation using eScript.

var Amount= 0;
var NumPeriods= 0;
var Rate= 0;
var InterestPaid = new Array;
var Payment = new Array;
var Period = new Array;
var PrincipleBalance = new Array;
var PrinciplePaid = new Array;

Field Comments

Sequence Number Sequence number for the rule execution. 

Expression Calculation expression. The expression is guided by the following:

■ Operator Support. All basic arithmetic operators, including 
exponents, are supported (+,-,*,/,^). Nested quantities (that is 
parentheses) are also supported. 

■ Simple Calculations. Simple calculations, such as a+b=c, are 
defined in a single row.

■ Compound Calculations. Multiple rows of calculations 
specified in a single Template. This enables multiple variables to 
be calculated independently, and then used in subsequent 
calculations.

■ For-Next Logic. Simple looping enables the generation of 
arrays. Use a For statement and a Next statement to accomplish 
looping. Example: 

■ row 1: For N=1 to Period, 

■ row 2: [calculation] 

■ row3: Next N

For-Next loops may be nested.

■ If-Then-Else Logic. Simple If-Then-Else logic is supported 
declaratively. As in the case of For-Next, If-Then-Else statements 
appear on multiple rows of the calculation set. Nesting of If-
Than-Else statements is supported.
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var PeriodPayment = 0;
var TotalInterest = 0;
var TotalPayment = 0;

function GetInput (Inputs)
{

with(Inputs)
{

var temp;
temp = GetProperty(“Amount”);
if (temp.length!=0)

Amount= ToNumber(temp);

temp = GetProperty("NumPeriods");
if (temp.length!=0)

NumPeriods= ToNumber(temp);

temp = GetProperty("Rate");
if (temp.length!=0)

Rate= ToNumber(temp);

}

}

function Main()
{

Period[0] = 0;
InterestPaid[0] = 0;
PrinciplePaid[0] = 0;
Payment[0] =0;
PrincipleBalance[0] = Amount;
Rate = Rate /1200;
PeriodPayment = Amount / (1.00/Rate - (1.00/Rate)/Math.pow((1.00+Rate), 
NumPeriods));

for(var i=1; i<=NumPeriods-1; i++)
{ 

Period[i] = i;
InterestPaid[i] = PrincipleBalance[i-1]*Rate;
Payment[i] = PeriodPayment;
PrinciplePaid[i] = Payment[i]-InterestPaid[i];
PrincipleBalance[i] = PrincipleBalance[i-1] - PrinciplePaid[i];

}

TotalPayment = NumPeriods * PeriodPayment;
TotalInterest = TotalPayment - Amount;
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}
function Service_PreInvokeMethod (MethodName, Inputs, Outputs)
{

GetInput(Inputs);
Main();
SetOutput(Outputs);
return( CancelOperation );

}

function SetOutput (Outputs)
{

Outputs.SetType("Result");

var psArray = TheApplication().NewPropertySet();
psArray.SetType("Array");
var len = InterestPaid.length;
for(var j=0; j<=len-1; j++)
{

var psArrayElement = TheApplication().NewPropertySet();
psArrayElement.SetProperty("InterestPaid",InterestPaid[j]);
psArrayElement.SetProperty("Payment",Payment[j]);
psArrayElement.SetProperty("Period",Period[j]);
psArrayElement.SetProperty("PrincipleBalance",PrincipleBalance[j]);
psArrayElement.SetProperty("PrinciplePaid",PrinciplePaid[j]);
psArray.AddChild(psArrayElement);

}
Outputs.AddChild(psArray);

var psPeriodPayment= TheApplication().NewPropertySet();
psPeriodPayment.SetProperty("PeriodPayment",PeriodPayment);
Outputs.AddChild(psPeriodPayment);

var psTotalInterest= TheApplication().NewPropertySet();
psTotalInterest.SetProperty("TotalInterest",TotalInterest);
Outputs.AddChild(psTotalInterest);

var psTotalPayment= TheApplication().NewPropertySet();
psTotalPayment.SetProperty("TotalPayment",TotalPayment);
Outputs.AddChild(psTotalPayment);

}

Invoking Calculation Manager
Calculation Manager is invoked from within a Siebel workflow and can be triggered using a mini-
button on an applet. Use a business service step to invoke Siebel Calculation Manger in a workflow.
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Using the FINS Calculation Engine Business Service and the Calculate business service method, set 
the input arguments as described in Table 22. There are no output arguments for this business 
service.

When invoked interactively, the calculation manager displays a pop-up dialog box with the input and 
output arguments. Perform the calculation by entering all input arguments and clicking the Calculate 
button. A second pop-up dialog box appears with the calculated values. Finish the calculation by 
clicking the Cancel button.

Using the Customer Expectations 
Manager
Managing customer expectations around the length of time it takes to complete their requests is 
crucial in maintaining customer satisfaction. Although many financial transactions complete in 
seconds, a number of key relationship—enhancing tasks require lead time of one or more days to 
complete. For example:

■ Bank check deposits may not be available for immediate withdrawal and are subject to clearing.

■ Credit and insurance applications typically undergo an underwriting process where the 
application is evaluated for its creditworthiness, risk profile, and other factors that go into 
approval and pricing. Fast turnaround is a competitive differentiator.

■ Healthcare service complaints and grievances are handled through a structured review and 
appeals process. In many jurisdictions, the processing of the complaints and grievances must 
meet regulatory standards.

The Siebel Customer Expectations Manager (CEM) provides the ability to use historical estimates of 
task completion times to aid the customer service representative in setting expectations for service 
completion. It is most useful in situations where a standardized process is being executed, and there 
is a need to estimate the expected completion date. Siebel CEM has the following two key features:

■ Ability for an administrator to input the factors governing the time to complete task.

Table 22. Input Arguments to Invoke Calculation Manager

Name Type Comments

Rule Expression Name Literal Calculation Rule name

Primary BC Name Literal Primary Business Component name

Primary BC Rowid Process Property Typically the Object Id of the 
Workflow

Save To BC Literal Y or N

Child BC Namen (Optional) Literal Child Business Component name

Child BC RowIdn (Optional) Literal Child Business Component row id
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■ A run-time engine that sets Due Date and Expected Close Date for the enabled objects.

NOTE: For CEM versus Agreements/Entitlement Metrics, it is possible to establish an agreement for 
an account that includes entitlements mandating the completion of Service Requests within specified 
entitlement metrics. When these are setup, and the user navigates to the Service screen, they see 
a Verify button. Clicking this button invokes the calculation of an Agent Committed Time. The 
entitlement metrics will calculate a contracted due date. In contrast, CEM calculates an estimated 
completion time or due date based on how long a process historically takes to complete. In cases 
where a service agreement is in place, the contracted dates take precedence.

Defining Customer Expectation Manager Rules
The CEM administration screen holds the historical estimates for task completion times and the rules 
for selecting an appropriate line. When CEM is invoked, the business service steps through each rule 
for all applicable rule-sets to find a rule that evaluates to true. The estimates defined against this 
rule are used for calculation of expected times. 

To create a CEM rule

1 Navigate to the Administration - Application screen > Customer Expectations Manager view.

2 In the Rule Sets Applet, create a new record, and complete the fields.

Some fields are described in the following table.

NOTE: If the conditional expression is not used, there should be only one rule-set per business 
object/business component defined. If there are multiple rule-sets for the same BO/BC, and a 
conditional expression is not defined, then the sequence of examination is random.

Field Comments

Name CEM rule set name.

Business Object Business object context for evaluating the rules.

Business Component Business component context for the conditional expression and rules 
evaluation.

Conditional Expression A valid Siebel query language expression. If this conditional 
expression evaluates to True, then the rules under the rule-set 
would be evaluated.

TIP: Use the expression builder to test the validity of conditional 
expressions.

Active Flag Flag to activate or inactivate a rule-set.

The field predefaults to Inactive.
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3 In the Rules list, create a new record, and complete the fields.

Some fields are described in the following table.

Field Comments

Sequence Sequence number for rule evaluation.

Business Component Business component reference for the expression evaluation.

This field predefaults to the BC on the rule-set definition and is a 
read-only field.

Conditional Expression Siebel query language expression that specifies the rule.

If this conditional expression evaluates to True, then the estimates 
associated with the rule is selected; further evaluation of the rules 
is aborted.

TIP: Use the expression builder to test the validity of Inclusion 
expressions.

Name Unique name for the rule.

Used to improve performance of the rule-set search during 
execution. Internally, a user key is constructed on the name field.

Schedule Schedule to use for calculating the expected completion times for 
the task.

Schedules govern the working hours, holidays, and downtime. If 
selected, the start time for the task is calculated using the 
schedule. 

Schedules are administered by navigating to the Administration - 
Service screen > Schedules view. Refer to Siebel Field Service 
Guide for details on schedule administration.

Use Employee Schedule If flagged, the employee schedule is used to calculate the start 
time. Employee schedule override the default schedule.

Unit Unit of measure for the preparation, expected and slack times. 
Valid units: Minutes, Hours, or Days.

Preparation Time Queue time for the task. 

Expected Time Expected time to complete the task.

Slack Time Time buffer to allow for deviations from the expected completion 
time.

Auxiliary Field (Optional) Specify Business Component field-value pairs. The 
specified fields are updated with the values based upon the rule 
selected. Example:

"Priority","0-ASAP"
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Invoking Customer Expectations Manager
In the current version of Siebel Financial Services, CEM is enabled for the Service Request object. 

To invoke CEM

1 Click the Calculate Dates button on the Service Request form. 

The CEM business service is invoked, and based on the administrative setup a pop-up dialog box 
appears with the expected completion dates for the service request. 

Closing the dialog box, the expected completion times are written into the current service 
request. 

2 Click the show more button on the Service Request form to view the expected completion times 
in the Internal Tracking - Expected Times section.

Using Data Transfer Utilities (DTU)
This business service allows you to transfer data from a source business component to a destination 
component. For example, a user can enter data in one view, then use a toolbar command to navigate 
to another view. Data entered in the first view is automatically entered in the second view.

About Data Maps
Data maps are the logic defining the flow of data from one location to another. The DTU business 
service uses data maps to transfer data from one location in the Siebel application to another.

This section contains the following topics:

■ Data Map Objects on page 205

■ Data Map Components on page 205

■ Data Map Component Advanced Options on page 206

■ Data Map Fields on page 208
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Data Map Objects
Data map objects indicate the data that is being transferred from the source business object to the 
destination business object. You can use the Administration - Application > Data Map Administration 
screen to define data map objects. Only Siebel administrators should have access to this screen. Data 
map objects are described in Table 23.

TIP: Data map objects are cached in memory. Whenever you make changes to an existing data map 
object, click the Clear Cache button to refresh the cache so that your changes appear.

You can import or export data map objects as XML files through the Data Map Object applet menu 
items: XML Import, XML Export.

Data Map Components
Data map components define the mapping at the child business component level. Each data map 
object can contain multiple data map components. You can arrange data map components in a 
parent-child hierarchy, but you must specify a parent for all except one data map component. The 
parentless data map component is called the root data map component. Data map components are 
described in Table 24.

Table 23. Data Map Objects

Object Description 

Name Data map object name. Enter a unique name.

Source Business 
Object

Source business object name. You must define this name in the Siebel 
Repository file.

Destination Business 
Object

Destination business object name. You can specify the same business 
object as both source and destination business object.

Inactive Check this box to make the data map object inactive.

Table 24. Data Map Components

Component Description 

Name Data map component name. Enter a unique name for each data map 
component in a data map object.

Source/Destination 
Business Component

Source or destination business component name.

If you specify a parent for this data map component, you must define this 
business component in the Siebel repository file as a child of the source or 
destination business object to which the parent data map component is 
mapped.
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Data Map Component Advanced Options
Fine-tune data transfer at the component level by using Advanced Options multi-value fields. Data 
map components advanced options are described in Table 25.

Parent Parent data map component name.

If you:

■ Specify a parent, the parent is mapped to particular source and 
destination business components. Generally, you map the child data 
map component to a child of those source and destination business 
components.

■ Do not want to specify a parent, leave it empty to indicate that this is 
the root data map component. Each data map object can have only one 
root data map component.

Inactive Check this box to make the data map component inactive.

Table 25. Data Map Components Advanced Options

Component Description 

Source Search 
Specification/Source 
Sort Specification

Defines the source Buscomp search spec and sort spec. The value can be a 
literal search spec/sort spec string. It can also contain a named parameter. 
See Using Named Parameters in DTU on page 209. For example:

[Id] = [&ContactId]

where ContactId is a named parameter. At run time, only named 
parameters are replaced by their string values.

Source Record Row 
Number

One can selectively transfer only a subset of source Buscomp records. This 
can be defined in three formats:

■ Start-End

■ Start-

■ Number

For example, 0-5, 4-, 0. 

NOTE: The row number starts at 0.

Operation Override This option allows one to override the operation at the component level. For 
example, if the current operation is Insert, you can use this option to set 
some component to operate Update instead.

Table 24. Data Map Components

Component Description 
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All advanced option values can contain named parameters. At run time, the named parameter is 
substituted by its run-time value. 

If the source Buscomp has been well positioned, the source search spec, the source sort spec, and 
source record row number must be evaluated to be empty at run time, otherwise a wrong advanced 
option error is encountered. See Well-Positioned Buscomps on page 215 for more information.

Advanced Options does not apply to mvg subcomponents.

No Association Y/N. Applicable to buscomps that have association list. By default, it is Y. 
Data Transfer Utilities first try to locate the desired destination record in the 
associate list. If successful, the located record is associated. Otherwise, a 
new record is created.

If N, association of existing records is not attempted. A new record is 
created instead.

Cached Updates The valid values include:

■ Source BusComp

■ Destination BusComp

■ Source/Destination BusComps

This is a performance enhancement option that defers sending SQL 
statements to the database until they can be sent together. Since none of 
the SQL statements is sent until the end, subsequent steps in the block 
cannot be dependant on a previous step having been committed to the 
database.

When you turn on this option, make sure to confirm all SQL statements are 
generated correctly and there is no inter-dependency.

Field Validation Y/N. By default it is Y.

By default, setting field values in a Siebel BusComp triggers field value 
validation. If you have a bounded picklist, the new value is validated against 
the picklist and the fields in the pick maps are set. Disabling field validation 
also turns off picklists. It is a performance enhancement option.

Table 25. Data Map Components Advanced Options

Component Description 
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Data Map Fields
Data map fields define the field-to-field mapping. Data map fields are described in Table 26.

Table 26. Data Map Fields

Field Description 

Source Type/
Destination Type

Type of the source/destination field. Can be: Field, Expression, or 
Parameter:

■ Field. A Siebel Buscomp field as defined in the srf.

■ Parameter. A named parameter. The parameter should be pre-fixed 
with an ampersand (&). See Using Named Parameters in DTU on 
page 209. For example: 

&ContactId

■ Expression. A Siebel calculation expression. See Calculation 
Expressions in DTU on page 210.

Source/Destination. The contents of these fields depends on the source and destination type. 

If the type is:

■ Field, it should be a Buscomp field name.

■ Expression, it should be a Siebel calculation expression.

■ Parameter, it should be a named parameter.

If the destination field is a calculated expression, then the record is not 
used to update the destination Buscomp. Instead, the result of the 
expression, evaluated at run time, is written back into the source field at 
the end of the data transfer operation of the component. 

If the Source is:

■ A Buscomp field, then source Buscomp is updated. 

■ A Parameter, the corresponding named parameter value is updated.

■ An Expression, nothing happens.
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Using Named Parameters in DTU
You can use named parameters to pass in a run-time dynamic value into DTU. For example, imagine 
you want to pull a contact's latest information into your Buscomp. At design-time, you cannot foresee 
what is the contact’s Id. Instead, you use a named parameter, &ContactId, and at run time, you pass 
in the value &ContactId.

Named parameters are defined implicitly in two ways:

■ Business Service Arguments. Pass in the named parameters when DTU is invoked. DTU knows 
an argument is a named parameter if the argument name is prefixed with an ampersand (&). 

For example,

var psinputs, psoutputs;
var myContactId = '0-45TU890';
psinputs = TheApplication().NewPropertySet();
psoutputs = TheApplication().NewPropertySet();
psinputs.SetProperty ("DataMapObj", "My Test DTU Object");
psinputs.SetProperty ("Operation", "Update");

Key Matches the destination records with source records.

For example, the Update operation updates the record in the destination 
business component whose key destination fields all match those of the 
corresponding source fields.

Each data map component in general should contain at least one key field. 

When there is no key defined, if the operation is:

■ Insert, DTU would proceed without checking if a duplicate record with 
the same key fields already exists. 

■ Update, it would update the current destination record. 

If the destination business component is populated with an associated list 
business component, at least one key field is required.

Source/Destination 
Multi-Value Link

This link indicates that the source and destination fields are multi-value 
fields.

Data is transferred from one multi-value field to another by dividing data 
map fields into several subcomponents. All entries with the same source 
and destination multi-value link constitute a subcomponent. Specify a key 
for each subcomponent.

NOTE: Data transfer from a multi-value field to a single-value field is not 
allowed. 

Table 26. Data Map Fields

Field Description 
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psinputs.SetProperty ("&ContactId", myContactId);
var obs = TheApplication().GetService("FINS Data Transfer Utilities");
obs.InvokeMethod ("DataTransfer",psinputs, psoutputs);

&ContactId serves as a named parameter.

The input value of a named parameter can be a calculation expression. In order to do so, set the 
value to:

Expr: "YourExpression"

which is the syntax of Buscomp field predefault. At run time, the expression is evaluated against 
the initiator Buscomp. For more information on initiator buscomp, see the argument description 
in DataTransfer Method on page 212.

■ Assignment by DTU. At run time, you can transfer into a named parameter if the field type is 
Parameter. When this happens, if the named parameter is still not defined, it is instantiated.

A named parameter must be implicitly defined first before it can be used. In other words, un-
assigned named parameters cannot be used.

Named parameters can be used to define Data Map Component Advanced Options, and Data Map 
Field Source or Destination that are of type Expression. 

All named parameters are output into the DTU service output arguments.

TIP: Whenever a named parameter is used in DTU, it should be prefixed with &.

Calculation Expressions in DTU
When Data Map Field Source/Destination Type is Expression, the Source/Destination Fields are 
calculation expressions that follow Siebel Query Language syntax. See Siebel Personalization 
Administration Guide for more information on Siebel Query Language. 

DTU contains two extensions to Siebel Query Language:

1 Curly bracket pair {field}

2 Named Parameter 

Curly Bracket Pair {field}
Use this syntax to refer to a buscomp field at the other business component side. For example, if you 
define the following expression as the source:

{ContactId}

[ContactId] would be evaluated at the destination bsucomp. When {} is involved, please note that 
{} takes the highest precedence over other operator. Thus, if you have an expression like:

‘{Last Name}' +  'Test'

{Last Name} has precedence over quotes "". If the person's last name is Agee, {Last Name} is 
evaluated to be "Agee". As a result, the final value is
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"Agee" Test

instead of 

{Last Name} Test

Named Parameter
A calculation expression can contain named parameters, using the syntax of [&Parameter]. It is 
important to pre-fix the ampersand to indicate a named parameter. For example,

"Sadmin's opportunity #" + [&OpptyId]

For more information on named parameters, see Using Named Parameters in DTU on page 209.

Data Transfer Utilities Methods
This section describes the following Data Transfer Utilities business service methods:

■ DataTransfer Method on page 212

■ FAFireEventxxx Method on page 213

■ GetActiveViewProp Method on page 213

■ TryMockMethod Method on page 214

■ QueueMethod Method on page 214
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DataTransfer Method
The DataTransfer method transfers data from the source business component to the destination 
business component.

Argument Description

Data Map Object 
(Required)

The name of the data map object that defines the mapping.

Operation (Required) Valid entries include Insert, Update, Delete, and Upsert.

GotoView (Optional) The name of a view that appears to users after the data transfer 
operation.

Option (Optional) A text field that allows you to specify additional options for the operation. 
Supported options include:

■ NewSrcBusObj. Force to instantiate a new Source business object. 
Use instead of NewBusObj.

■ NewDstBusObj. Force to instantiate a new destination business 
object.

■ RootNotCommitted. Suggest DTU not to commit the root component, 
if possible.

■ SrcRootAdminMode. Set the source Buscomp of the root data map 
component to Admin mode. This is valid only if the root source 
Buscomp has not been executed.

■ BatchMode. This is a performance enhancement option that 
suppresses runtime events, disables undo, and defers field pre-
defaults until committing the record. Batch mode is only enabled for 
source or destination business objects that are not the active 
(initiator) business object.

The following syntax is recommended for defining Option: 

/option1 /option2 …

For example,

/NewSrcBusObj /NewDstBusObj

Initiator Business 
Object (Optional)

Used as a sanity check. If the BusObject that invokes DTU is different 
from what is specified by the InitBO argument, DTU exits as an external 
error.

Initiator Business Object is part of the invocation context. DTU receives 
a reference of the initiator business object only when invoked from 
Runtime Evens, Buscomp Named Methods, or workflow processes with its 
business object defined. In Siebel Finance, DTU can be invoked without 
an initiator business object. 
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NOTE: It is recommended that you specify both InitBO and InitBC specifically when invoking DTU.

DTU requeries the initiator buscomp when InitSearchSpec, InitSortSpec, InitEnumFlg are used. 

FAFireEventxxx Method
FAFireEventxxx is a hidden method that you can use to create a toolbar command. It invokes the 
method “EventMethodxxx” on the primary business component of the active view. “EventMethodxxx” 
triggers the event manager, which invokes either a workflow or a business service.

GetActiveViewProp Method
This is an auxiliary function to retrieve the active view’s properties. It does not take any input 
arguments.

Initiator Business 
Component (Optional)

By default, the Buscomp that invokes DTU serves as the InitBC. Initiator 
Buscomp plays an important role in determining how records are 
transferred. Use the InitBC argument to set other Buscomp in the 
Initiator BusObject as the Initiator Buscomp.

Initiator Search 
Specification / Initiator 
Sort Specification 
(Optional)

Initiator Buscomp search spec and sort spec. 

Initiator Buscomp 
Enumerate Flag 
(Optional)

Y/N. By default, Initiator Buscomp Enumerate Flag is N. When it is true, 
DataTransfer is applied to each record in the initiator Buscomp. When 
InitSearchSpec or InitSortSpec is specified, InitEnumFlag is implicitly 
true, even if InitEnumFlg is set to N.

MockMethodReplied Y/N.

Argument Description

Business Object Business object name.

View Active view name.

Screen Active screen name.

Thread Applet Thread applet name.

Argument Description
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TryMockMethod Method
This is an advanced auxiliary function for administration of the tool bar button workflow. It does not 
take any input arguments.

QueueMethod Method
Launch a queue method on an applet in another view. When invoked, the UI navigates to the view 
specified, and then the Queue method is invoked on the specified applet.

Other input arguments of this method will be cached into the application Shared Global, which can 
be retried back. 

DTU DataTransfer method has built-in integration with the QueueMethod. When the input argument 
DataMapObject has the format:

SharedGlobal: NameofSharedGlobal

The data map object name can be retrieved from Shared Global with the name NameofSharedGlobal.

Considerations for Data Transfer Utilities
This section contains the following topics:

■ Use of Active Business Objects on page 215

■ Invocation Context on page 215

Is Administration Mode Y or N.

View Mode Code An integer representing Siebel view mode:

■ 0: SalesRep View

■ 1: Manager View

■ 2: Personal View

■ 3: AllView

Argument Description

MockMethodReplied Y or N.

Argument Description

GotoView Name of the view to go to.

Applet Applet name.

Method Queued method to be invoked on the applet.

Argument Description
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■ Well-Positioned Buscomps on page 215

■ Recursive Invocation on page 216

CAUTION: Spool SQL statements during the development stage to verify that all operations are 
performed.

Use of Active Business Objects
Data Transfer Utilities execute inside a client's object manager. 

The DTU reuses the current active business objects. It does not instantiate an independent source 
business object unless directed. This leads to both a leaner memory use and better performance. 
This is even more so if the destination business object is the same as the source business object. In 
such a case, no new business objects are instantiated for the business service. 

Because of the reuse of active objects, you must exercise caution to preserve the current business 
object context. For example, the business components should not be in the query state when DTU is 
launched.

Invocation Context 
DTU in general needs the pass-in of a reference to the active Buscomp. To do so, the business service 
should be invoked from Event Manager, Buscomp Named Method, or a workflow process that is 
invoked by the event manager. However, in Siebel Healthcare 7.7, the requirement that one must 
have an active Buscomp is relaxed.

Not all Buscomp events can be used to invoke the DataTransfer method. For example, Query event 
in general should not be used to trigger DataTransfer, as the buscomps are not in an updateable 
state. 

In general, use PreDeleteRecord event; do not use DeleteRecord event. The Siebel event manager 
does not pass in a reference to the active Buscomp in the DeleteRecord event.

Use special care when the service is used with other business services in a workflow. Other business 
services should not interfere the passing of a reference to the active buscomp. Use a spooled sql 
statement to confirm the operations carried out are correct.

Well-Positioned Buscomps
A well-positioned Buscomp is a Buscomp that has been positioned correctly, and whose position 
should not be disturbed. DTU uses the following rule:

■ The initiator Buscomp is a well-positioned Buscomp. 

■ The ascendants of a well-positioned Buscomp are well-positioned.

■ For a given data map component, the buscomps involved in all its parent data map components 
are well positioned.

If the source Buscomp is well-positioned:
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■ Data transfer is only invoked on the current row of the source BusComp. Otherwise, the operation 
is carried out on all rows in the source BusComp at the moment of invocation. 

■ Advanced options such as source search spec, source sort spec should be empty.

If the destination Buscomp is well-positioned:

■ You do not need to specify key fields to retrieve the destination record. Even if you do in this 
case, DTU would ignore them.

■ And if the current operation is Insert, it would change to Update by default, unless overridden 
by Operation Overrides.

Recursive Invocation
By default, you cannot use the DataTransfer operation to invoke another DataTransfer operation. In 
other words, at anytime within a client's object manager, there is only one DataTransfer method in 
the call stack.

Configuring Event-based Commands
The Data Transfer Utilities business service allows you to configure toolbar and menu commands 
based on Siebel Event Manager. 

To configure event-based commands

1 Define a command in Siebel Tools. 

Business Service =”FINS Data Transfer Utilities”. Method = “FAFireEventxxx”. The method name 
can be anything that begins with “FAFireEvent”. When the command is invoked, it, in turn, 
invokes method EventMethodxxx on the primary buscomp of the active view, where xxx is of the 
same value as in FAFireEventxxx.

2 Define a toolbar.

3 Define a toolbar item for the command you defined.

4 In the Siebel client, define a run-time event that will receive EventMethodxxx. 
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5 Navigate to the Administration - Runtime Events screen > Events view, and create a Buscomp 
run-time event as listed in the following table. See Siebel Personalization Administration Guide 
for more information on run-time events. 

Alternatively, you can define a workflow that has a Start step that contains run-time events. 
When the workflow is activated, both the Action Sets and run-time events are created 
automatically for you. See Siebel Business Process Framework: Workflow Guide.

6 Siebel run-time events are cached. After you make changes, click the Runtime Events applet 
menu item Reload Runtime Events.

7 Configure dynamic enabling of the command. For more information, see Dynamic Enabling of 
Commands on page 217.

8 Define command visibility. 

a In Siebel Tools, navigate to Business Services > FINS Data Transfer Utilities. 

b Define a user property in which Name = MethodName GotoView, and Value = The name of a 
view. MethodName is the name of the command method. 

When you define this user property, this method is enabled only for users who have visibility 
to the view defined in the value. If the method does not contain a GotoView, visibility is not 
imposed on the method.

Dynamic Enabling of Commands
When a command is invoked from a toolbar button or menu, the Data Transfer Utilities business 
service invokes the method EventMethodxxx on the primary business component of the active view. 
The primary business component should be derived from CSSBCBase to allow the invocation to be 
captured by Siebel Event Manager.

When the view is changed, Siebel framework polls each command for the application-level toolbar 
buttons and application menu to determine whether the button or menu items should be made read-
only. 

There are two mechanisms for the dynamic enabling/disabling of commands in DTU:

Field Entry

Sequence -1

Object Type BusComp

Object Name The name of the business component in which the event is invoked. For a 
toolbar command, this is the primary business component in the view in 
which the command is invoked.

Event InvokeMethod

Sub Event EventMethodxxx. Choose the same value for xxx that you chose for 
FAFireEvent.

Action Set Name The action set that invokes Siebel Workflow Manager or a business service.
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■ Srf mode

■ Mock Event Sink

The System Preference FINS DTU Enable FireEvent Mode is used to determine the mode. The value 
should be Srf or Runtime Event. The default value is Srf.

Srf Mode
In the Srf mode, a FAFireEventxxx invocation on a buscomp is enabled if there is a user property 
underneath the FINS Data Transfer Utilities business service as such that the name of the user 
property is: 

Name: FAFireEventxxx Static Enabled BC [n]

Value: Buscomp Name

You can define multiple Buscomps for a FAFireEventxxx method. 

Srf mode is introduced primarily for performance reasons. Compared with Runtime Event mode, it 
allows fast enabling/disabling of a command button without actually invoking a run-time event. Srf 
mode is the default mode.

Mock Event Sink
When System Preference FINS DTU Enable FireEvent Mode is Runtime Event, Data Transfer Utilities 
determines at run time whether a FAFireEventxxx method should be disabled or not by initializing 
Mock Event Mode. It sets up a global mock event flag within the client’s object manager. It then 
invokes EventMethodxxx on the primary business component of the active view. If this 
EventMethodxxx is finally captured by a Mock Event Sink, a global response flag is set. When the 
Data Transfer Utilities finds out the response flag is set by a mock event sink, it enables the 
FAFireEventxxx method for that particular view. Otherwise, the method is disabled.

Mock Event Sinks are specialized business service methods that capture mock events. They check 
whether the client’s OM is in the mock event mode. If not, they do nothing. If so, they reply to the 
mock event by setting the response flag as well as the output argument.

MockMethodReplied = Y.

TryMockMethod in Data Transfer Utilities is a mock event sink. DataTransfer method has a built-in 
mock event sink.

About Defining a Toolbar Button
For information about configuring a toolbar button, see Configuring Siebel Business Applications.
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Automating Approval Processing
In Siebel Healthcare, administrators can define a number of approval levels without the need for 
programming, scripting, or configuring. You can define both basic or multiple step approval 
processing levels based on the needs of your organization. You can invoke approval processing from 
a workflow or a run-time event. 

Automating an approval process involves the following steps:

■ Administrator defines approval items and approval stages. 

For more information, see Defining Approval Items and Approval Stages on page 219.

■ Administrator invokes approval processing. 

For more information, see Invoking FINS Approval Item Service from a Workflow on page 220.

■ End users approve or decline an approval stage. 

For more information, see Approving or Declining Approval Stages (End User) on page 222.

Defining Approval Items and Approval Stages
An administrator defines the approval process by creating approval items and approval stages in the 
Approval Administration view. 

To define approval items and stages

1 Navigate to the Administration - Application screen > Approval Administration view.

2 In the Approval Item list, add a record and enter a name in the Approval Item field.

3 In the Approval Flow Type field, select one of the following:

■ Sequential. Indicates this Approval Item is distributed to approvers one after another in the 
sequence specified in the Approval Stage. The application routes the Approval Item to the 
next approver only if the current approver approves the request. If any one approver in the 
approval chain declines the request, the Approval Item is rejected and no further routing is 
conducted. 

■ Parallel. Indicates this Approval Item is distributed to all approvers simultaneously for 
approval. The Approval Item is rejected if at least one approver declines the approval 
request.

Once you have defined an Approval Item, the next step is to define the appropriate approval 
stages. The Approval Item and Approval Stage lists have a parent-child relationship. 
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4 In the Approval Stage list, add a record for each approval stage and complete the necessary 
fields.

Some fields are described in the following table.

End users use the My Approval Inbox view to approve an approval item. For more information, see 
Approving or Declining Approval Stages (End User) on page 222.

Invoking FINS Approval Item Service from a Workflow
Invoke FINS Approval Item Service from a workflow by creating a workflow process in Siebel Tools 
containing the following steps:

■ Start. Initiates the process instance. When the conditions have been met, the application 
initiates the process instance. See Configuring the Start Step on page 221 for details.

■ Business Service. A step in a process in which an automated call is made to the FINS Approval 
Item Service. A workflow process definition can have one or more business service steps. See 
Configuring the Business Service Step on page 222 for details.

■ End. A step in a process that specifies when a process instance is finished. 

In order for your workflow to execute correctly, the Start and Business Service steps must meet the 
minimum requirements described in the referenced sections. For more information on workflows, see 
Siebel Business Process Framework: Workflow Guide.

Field Comments

Sequence # Identifies the numeric sequence of this Approval Stage in the current 
Approval Item. The application executes Approval Stages in numerical order 
based on this number. 

Approval Type Specifies whether the approver is a position or an employee.

Owner Login 
Name

Indicates the login name tied to this Approval Stage. Relevant only if 
Approval Type is Employee.

Owner Position Indicates the position tied to this Approval Stage. Relevant only if Approval 
Type is Position.
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Configuring the Start Step
Table 27 details some of the start step parameters for the workflow process.

Table 27. Parameters for Start Step

Field Comments Example

Event The specific event that happens to 
the object. The set of available 
events is different for different 
object types.

Use the WriteRecord business 
component event if you want to 
trigger the approval process after the 
record is written to the database.

Use the WriteRecordNew business 
component event if you want to 
trigger the approval process after a 
new record is written to the 
database.

Event Object The name of the application, 
business component, or applet to 
which the event occurs.

Contact

Event Object Type The type of object to which the 
event occurs. This can be an 
application, business component, 
or applet.

BusComp

Name The name of the Next step branch.

The name of the branch must be 
unique or you cannot import or 
export the workflow process. 

Next Step The name of the step that follows 
when conditions are met. 

Picklist of existing process steps. 

Type The type of branch. The value can be one of the 
following: 

■ Condition. This value indicates 
that a condition is defined for the 
branch.

■ Default. This value indicates that 
if nothing else is satisfied, then 
this branch is followed. 
Additionally, if this value is used, 
any conditions defined for the 
branch are ignored.



Siebel Healthcare Guide Version 8.0

Business Services for Siebel Financial Services ■ Automating Approval Processing

222 

Configuring the Business Service Step
Table 28 and Table 29 detail some of the business service step parameters and input arguments for 
the workflow process.

Approving or Declining Approval Stages (End User)
End users approve approval items in the My Approval Inbox view. Users can view approval items by 
login name or position. For more information on setting up approval processing, see Defining Approval 
Items and Approval Stages on page 219.

To approve or decline an approval stage

1 Navigate to the My Approval Inbox screen.

2 Select one of the following views:

■ My Approvals. Displays all approval items associated with the user’s login name. 

■ My Position Approvals. Displays all approval items associated the current user’s position. 

3 To view additional details about an approval item, drill down on the Approval Identifier link.

4 In that Status field, select Approve or Decline.

Once you select a status, the application populates the Approval By and Approval Date field and 
sets the record to read-only.

Table 28. Parameters for Business Service Step

Field Value

Business Service FINS Approval Item Service

Method Create Approval Stage

Table 29. Input Arguments for Business Service Step

Input Argument Property Name Comments

Approval Item ID Object Id Row Id of the object (for example, a Service 
Request) that needs approval processing.

Approval Item Name Approval Item Name Name of the Approval Item defined in the 
Approval Administration view.

Requesting Buscomp Requesting Buscomp Name of the buscomp object (for example, a 
Service Request) that needs approval 
processing.
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Automating the Display of Disclosure 
Documents
Disclosure processing allows companies to comply with internal company policies and external 
regulations. These policies and regulations require they display disclosure statements or external 
documents to users, and then record whether or not they have read and understood them. 
Implementing the automatic display of disclosure documents involves the following steps:

■ Set up a disclosure by associating it with a product and literature. 

For more information, see Setting Up Disclosures on page 223.

■ Activate the appropriate workflows. 

For more information, see Understanding and Activating Disclosure Workflows on page 224.

■ Invoke the Disclosure UI Service business service. 

For more information, see Invoking the Disclosure UI Service Business Service on page 225.

■ View a disclosure history. 

For more information, see Viewing Disclosures Associated with Contacts (End User) on page 226.

Setting Up Disclosures
To implement disclosure processing, you must associate each disclosure with a product and then, if 
applicable, with the appropriate document. 

To associate a disclosure with a product

1 Navigate to the Administration - Product screen > Disclosure view.

2 In the Product form, query for the product.

3 In the Disclosure list, add a new record, and complete the necessary fields.

4 To activate a disclosure, select it in the Disclosure list, and click Activate.

Clicking Activate, changes the Status from In Progress to Active and makes the record read-only. 

To revise an existing disclosure

1 Navigate to the Administration - Product screen > Disclosure view.

2 In the Product form, query for the product.

3 In the Disclosure list, select the disclosure to be revised, and click Revise.

Clicking Revise creates a new version of the disclosure and sets its status to In Progress.
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4 Make the appropriate changes to the new disclosure, and click Activate.

Clicking Activate, changes the Status from In Progress to Active and makes the record read-only. 
The prior version of the disclosure still appears, but displays a Status of Outdated.

5 To associate literature with a disclosure, add a new record in the Literatures list, and complete 
the necessary fields.

For more information on loading literature into Siebel Healthcare, see the sharing literature 
discussion in Siebel Applications Administration Guide.

Understanding and Activating Disclosure Workflows
Siebel Healthcare includes three workflows that help manage the display of disclosure documents 
and disclosure event logging. Table 30 describes each workflow.

Table 30. Disclosure Workflow Processes

Workflow Process Comments

FINS Disclosure The FINS Disclosure Workflow process accomplishes the following 
tasks:

1 Invokes the Setup method of the Disclosure UI Service 
business service. Invoking this method sets up the 
appropriate disclosure documents based on the selected 
product.

2 Calls the FINS Disclosure Goto File View subprocess. This 
sub-process navigates users to the Disclosure Documents list, 
where they can review all the disclosure documents pertaining 
to the selected product. This subprocess also navigates users 
back to the previous view after they accept or decline the 
disclosure. This final navigation step is accomplished by 
invoking the View Back method of the Disclosure UI Service.

3 Calls the FINS Disclosure Create Activity Sub Workflow 
subprocess. If the user accepts the disclosures, the workflow 
calls the FINS Disclosure Create Activity Sub Workflow 
subprocess to log the disclosure activity.

FINS Disclosure Goto File 
View

This subprocess navigates users to the Disclosure Documents list, 
where they can review all the disclosure documents pertaining to 
the selected product. This subprocess also navigates users back to 
the previous view after they accept or decline the disclosure. This 
final navigation step is accomplished by invoking the View Back 
method of the Disclosure UI Service.

FINS Disclosure Create 
Activity Sub

If the user accepts the disclosures, this sub process logs the 
disclosure activity.
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Before you can display disclosure documents, you must:

■ Deploy the workflow processes using Siebel Tools. 

For more information, see Siebel Business Process Framework: Workflow Guide.

■ Activate the workflow processes described in Table 30. 

For more information, see To activate the workflows used to display disclosure documents on 
page 225

■ Invoke the Disclosure UI Service business service. 

For more information, see Invoking the Disclosure UI Service Business Service on page 225.

To activate the workflows used to display disclosure documents

1 Navigate to the Administration - Business Process screen > Workflow Deployment view.

2 In the Repository Workflow Processes list, use a query to find all processes where the Name field 
contains the word Disclosure. 

NOTE: You can query on *Disclosure*.

3 Activate each workflow process shown in Table 30 on page 224, that has a status of Inactive.

a Select the workflow process record.

b Click Activate.

4 To verify that the Status is Active for each process:

a In the lower Active Workflow Processes list, query again for Name = *Disclosure*. 

b For each process, check that Deployment Status = Active.

Invoking the Disclosure UI Service Business Service
You can invoke the Disclosure UI Service from a workflow. This section describes some of the possible 
steps you can include to enable this invocation. You may need to modify and expand on this 
procedure to accommodate more complex business requirements. The workflow process you create 
must contain the following steps:

■ Start. Initiates the process instance. When the conditions have been met, the application 
initiates the process instance. 

■ Sub Process. Calls the FINS Disclosure Workflow. When creating this step, you must populate 
the following inputs:

■ Contact Id. The Row Id of the contact who places the order of the product.

■ Disclosure Name. The name of the Disclosure that relates to the product.

■ Product Id. The Row Id of the product that the customer has ordered.

■ End. A step in a process that specifies when a process instance is finished. 
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For more information on workflows, see Siebel Business Process Framework: Workflow Guide.

Viewing Disclosures Associated with Contacts (End 
User)
All end users can view disclosures associated with a specific contact on the Contacts Disclosures 
view. This view is read-only and displays the:

■ Disclosure name

■ Date the disclosure was presented to the user

■ Date the user acknowledged the disclosure

■ Date the user accepted the disclosure

For more information on setting up disclosure processing, see Automating the Display of Disclosure 
Documents on page 223.

To view a disclosure history

1 Navigate to the Contacts screen > Contacts List view.

2 In the Contacts list, drill down on the contact.

3 Click the Disclosures view tab.

SmartScript Integration with Workflow
You can invoke a SmartScript from a workflow process and pass parameters from the SmartScript to 
the workflow process. These business services support SmartScript integration with workflow:

■ FINS Web Shopping Service. 

For methods, see FINS Web Shopping Service Methods on page 228.

■ FINS SmartScript Output Service. 

For methods, see FINS SmartScript Output Service Methods on page 229.

NOTE: In order to completely understand the concepts in this section, familiarity with SmartScript 
is required. For more information, see Siebel SmartScript Administration Guide.

For a detailed explanation about how to integrate SmartScript with Workflow, see Example of 
Integrating SmartScript with Workflow on page 227.
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Example of Integrating SmartScript with Workflow
The scenario outlined in this section is an example of how to insert a SmartScript in a workflow 
process. After the SmartScript ends, the workflow proceeds to the next step in the workflow process. 
Your company may follow a different workflow that fits its business requirements.

In this scenario, you are designing a SmartScript that allows customers to complete a loan 
application online. After the loan application is complete, your workflow verifies the customer’s 
address in an external system.

To configure SmartScript integration with Workflow

1 In the SmartScript, create Save User Parameters for the parameters you want to pass to the 
workflow. For more information on SmartScript user parameters, see Siebel SmartScript 
Administration Guide.

2 Create a Business Service step for your workflow, using the FINS Web Shopping Service business 
service, and enter the input arguments described in Table 31 on page 228.

3 Create a subprocess to invoke the SmartScript using the workflow User Interact step. The 
subprocess is based on the SmartScript Player business object and has three steps: a start step, 
a user interact step, and an end step. 

a In the user interact step, set the view name to FINS SmartScript Player View (App).

b In the Next Step’s applet, add two conditions, entering the information listed in the following 
tables:

Entries for Record 1 (first condition):

Entries for Record 2 (second condition):

Field Entry

Branch Name Cancel

Type Condition

Next Step End

Event Object Type Applet

Event Invoke Method

Event Object Smart Script Player Applet (FINS 
eSales App)

Subevent CancelScript

Field Entry

Branch Name Finish

Type Condition
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4 Add a Business Service step using the FINS SmartScript Output Service business service. Enter 
the output arguments described in Table 32 on page 229.

Now you may either end your workflow process or include additional steps, depending on your 
company’s business requirements. The SmartScript is integrated in your workflow process.

FINS Web Shopping Service Methods
The FINS Web Shopping Service business service methods are described in Table 31.

Next Step End

Event Object Type Applet

Event Invoke Method

Event Object Smart Script Player Applet (FINS 
eSales App)

Subevent FinishScript

Table 31. FINS Web Shopping Service Methods

Method Description / Arguments

SetSmartScriptName Input Arguments:

■ Script Name (Required): The name of the SmartScript you want to 
invoke.

■ SSUserParameter# (Required): A SmartScript user parameter 
between 1 and 20. 

For example, SSUserParameter1. The value for the input argument 
must be the exact name of the user parameter specified in the 
SmartScript, whose value needs to be passed into the workflow 
process at the conclusion of the SmartScript.

Field Entry
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FINS SmartScript Output Service Methods
The FINS SmartScript Output Service business service methods are described in Table 32.

Dynamic UI Business Service
This business service and associated administration views allow you to create and render views 
containing a single read-only applet in the Siebel Financial Services application. These views and 
applets, called dynamic applets, allow business analysts and developers to make frequent changes 
to the user interface without the need to recompile and redeploy a Siebel Repository File (SRF).

The following topics are included in this section:

■ Example of Creating a Dynamic Applet with the Dynamic UI Business Service

■ Displaying Dynamic Applets in a Workflow

Example of Creating a Dynamic Applet with the Dynamic 
UI Business Service
The scenario outlined in this section is an example of a Dynamic UI Service in a workflow process. 
Your company may follow a different workflow that fits its business requirements.

You would like to set up your company’s user interface to dynamically display read-only views at run 
time, based on user input. For example, a customer requests a quote for an auto insurance policy. 
The policy includes the option to cover additional drivers. After the customer enters additional driver 
information, the workflow process uses a Dynamic UI applet to display a read-only list of the 
additional drivers for review. Customers can review the list, then select an option to continue the 
process.

To set up a similar user interface for your business, follow the instructions that follow.

Table 32. FINS SmartScript Output Service Methods

Method Description / Arguments

SetOutput Reads the SmartScript user parameters and outputs them as workflow 
properties:

Output Arguments:

■ The name of the user parameter. Specifies the SmartScript user 
parameters as output arguments, and passes the value of the user 
parameters back to the workflow process when the SmartScript ends. 
These output arguments can be mapped to process properties.

■ SmartScript Result Action: Returns the action users take to end the 
SmartScript. Possible values are Finish or Cancel.
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To create a dynamic applet 

1 Navigate to the Administration - Finance screen > Dynamic Applet Administration view.

2 In the Dynamic Applet list, click New, then enter the view alias and view name. 

The view alias must be a unique name. The view name is a picklist of the views defined in the 
Template Definition view.

3 Step off the record. The Applet Instance list automatically displays the name of the applet 
template defined for this view.

4 In the Applet Instance list, enter the applet title, business object name, and business component 
name. 

The business object and business component determine the fields to display for this applet.

5 If you want to set up a default search specification, enter:

■ Business component field. Specifies the field on which to base your search.

■ Default. Specifies a default value for which you want to search. 

6 In the Field Control list, add a new record for each field you want to display. Each field control is 
displayed as a read-only text box with a text label. For each record, enter:

■ Display Sequence number. Indicates the display order for the field. For list applets, the order 
is left to right. For form applets, the order is left to right and top to bottom.

■ Field name. The business component field whose value you want to display.

■ Caption. The display label for the field.

7 In the Button Control list, add a new record for each button you want to display. Enter the 
sequence number, caption, and method for each button.

■ Display Sequence. Indicates the display order for the button, from left to right.

■ Caption. The display label for the button.

■ Method. The method invoked when the button is clicked. The method name must begin with 
FrameEventMethod. For example, FrameEventMethodContinue.

Displaying Dynamic Applets in a Workflow
Workflows can invoke a dynamic applet as part of a process defined for a product application. This 
feature enables an application administrator to establish applet instances without requiring 
recompilation and redeployment of individual applets. 

To integrate the dynamic applet in a workflow

1 Create a subprocess based on the FINS Dynamic UI business object.

2 Add a Dynamic UI Service business service step and invoke the Set View Name method described 
in Table 33 on page 231.
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3 (Optional) Add a second Dynamic UI Service business service step and invoke the AddRecord 
method described in Table 33 on page 231.

4 Add a User Interact step to display the dynamic applet. 

a For the view property of the User Interact step, enter the view template name defined in Step 2 
of Example of Creating a Dynamic Applet with the Dynamic UI Business Service.

b For each button that may be clicked in the dynamic applet, add entries into the Next Steps list 
applet of the User Interact step. The following is an example of such an entry:

The Dynamic UI Service business service methods are described in Table 33.

Creating a View Template for Dynamic Applets
Creating a view template involves first creating views and applets based on specialized applet classes 
within Siebel Tools. These views and applets contain placeholder fields. Placeholder fields are applet 
controls that are not mapped to any particular business component. The views and applets will then 
form the basis of view templates and applet templates. You can use a single view and applet template 
to create any number of dynamic applets. 

Field Entry

Branch Name Continue Button

Type Condition

Next Step End

Event Object Type Applet

Event InvokeMethod

Event Object FINS Dynamic UI List Applet

Subevent FrameEventMethodContinue

Table 33. Dynamic UI Service Methods

Method Description / Arguments

Set View Name Input Arguments:

View Alias (Required): The view alias defined in Step 2 of Example of 
Creating a Dynamic Applet with the Dynamic UI Business Service.

AddRecord 
(Optional)

Overrides the default search specification value.

Input Arguments:

■ Business Component Name (Required): The name of the source 
business component.

■ Object ID (Required): The row ID of the business component.
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Two templates are provided as part of seed data: a view template containing a list applet template, 
and a view template containing a form applet template. The view templates are named as follows:

■ FINS Dynamic UI Form view. A view template that contains a form applet template.

■ FINS Dynamic UI view. A view template that contains a list applet template.

For more information about creating views and templates within Siebel Tools, see Using Siebel Tools.

When creating dynamic applets in Siebel Tools, note the considerations listed as follows. (Use of the 
word applet in the following bulleted list refers to applets created in Siebel Tools.)

■ When setting applet class, use:

■ CSSFrameListFADynamicUI for list applets

■ CSSFrameFADynamicUI for form applets

■ If using a preconfigured business component, the applet business component should be FINS 
Dynamic UI.

■ If you create your own Virtual Business Component (VBC) in Siebel Tools, the business class 
should be CSSBCVDynamicUI.

Dynamic Applet supports 20 fields and five currency codes (that is, five types of currency value). 
In your new VBC, all field names should start with the prefix Field and a number value, (for 
example, Field0..., Field19). All currency code fields should start with the prefix Currency Code 
and a number value, (for example, Currency Code0..., Currency Code4).

■ It is recommended that applets based on the same VBC have their corresponding views use a 
different business object.

Once the views and applets have been created in Siebel Tools, in order to define them as view 
templates and applet templates, they must be added to the Template Definition view.

To add views and applets to the Template Definition view

1 Navigate to the Administration - Finance screen > Dynamic Applet Administration view > 
Template Definition view.

2 In the Template Definition list, click New, and then enter the view name. 

3 In the Applet Template Definition list, click New, and then enter the applet name.

FINS Application View Navigation
The FINS Application View Navigation Service guides users through a series of views based on 
administration data. The view list is dynamically generated according to the products associated with 
the current record. It replaces the Next/Previous button functionality, known as the FINS Application 
Workflow, in previous releases. 

The following topics are presented in this section:

■ Business Service Methods on page 233

■ Business Service Behaviors on page 233
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■ Business Service Administration on page 234

■ Example of FINS Application View Navigation on page 234

■ Upgrade Note on page 235

Business Service Methods
The business service has two methods:

■ GetNextViewName. Gets the next view name without view navigation.

■ GotoNextView. Navigates to the next view.

Table 34 describes the arguments for these methods.

Business Service Behaviors
The FINS Application View Navigation Service is constrained by the following behaviors:

■ The business service can be invoked from any screen.

Table 34. FINS Application View Navigation Service Arguments

Name Type Description

BusComp Required The master buscomp through the view navigation.

Navigation Direction Optional Forward or Backward. Default is Forward.

Product Id Optional Product Id value.

Product Id Field Optional The field in the buscomp that is used to retrieved 
Product Ids.

Status Output ■ 0: success 

■ 1: EOF

■ 2: BOF 

■ 3: Error

Next View Name Output Name of the Next View.

FINS View Navigation 
Mgr Admin BC

Optional Name of the admin buscomp.
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■ The navigation is limited to the views in the current screen that are accessible to the current 
login. 

For example, if there is a product that is associated with views in both the Contact and 
Opportunity screens, and the invocation occurs inside the Contact screen, views in the 
Opportunity screen are ignored. Furthermore, the views that the current login do not have access 
to are also ignored.

■ A view in the view list that is left by clicking the Next button, is treated as a visited view.

■ At any point in the view navigation, if a next view request is triggered and there are views ahead 
of the current views not marked as visited, the service navigates to the skipped views.

■ During the navigation sequence, the master buscomp record row Id should not be changed. 
Otherwise, all the views will be treated as unvisited after the record change.

Business Service Administration
The FINS Application View Navigation Service is administered through the Administration - Product 
screen. 

To administer the FINS Application View Navigation business service

1 Navigate to the Administration - Product screen > Products view.

2 In the Products list, query for the desired product, and drill down on the product name link. 

3 Click the More Info view tab.

4 In the More Info form, click the Application Workflow view link. 

5 Create new records to associate views and their sequence to the product.

NOTE: You can associate views from any screen with a product.

If you specify views with a gap in the sequence on two different products and add both those 
products to, for example, an Application, you navigate based on sequence number and not on 
product. 

For example, if you specify:

■ View V1 with sequence 1 and view V2 with sequence 3 on product A

■ And then also specify view V3 with sequence 2 and view V4 with sequence 4 on product B

■ And then proceed to add both these products to an Application

The navigation sequence will be V1, V3, V2, V4.

Example of FINS Application View Navigation
The FINS Application View Navigation Service is used in Siebel Healthcare on the Application screen, 
where the Application form contains Previous and Next buttons. 
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The invocation on the Application screen uses Applet Named Method, a feature of frame classes 
derived from CSSSWEFrameBase and CSSSWEFrameListBase. The applet User Property has the 
following name/value pairs:

The Next and Previous buttons are mapped to methods as follows:

Upgrade Note
In previous releases, the function provided by the FINS Application View Navigation business service 
was available through NextView and PrevView methods in CSSSWEFrameFINApplication. 

These methods are no longer supported since Siebel Healthcare 7.7. If you have upgraded to Siebel 
Healthcare 7.8 from a release prior to Siebel 7.7, the Next and Previous buttons need to be 
reconfigured following the example provided in Example of FINS Application View Navigation on 
page 234. 

■ Named Method 1: GotoPreView 'INVOKESVC', 'FINS Application View Navigation Service', 
'GotoNextView', '"BusComp'", "'Opportunity'", "'Navigation 
Direction'", "'Backward'", "'Product Id Field'", "'Opportunity 
Product Id'"

■ Named Method 1: GotoNextView 'INVOKESVC', 'FINS Application View Navigation Service', 
'GotoNextView', "'BusComp'", "'Opportunity'", "'Navigation 
Direction'", "'Forward'", "'Product Id Field'", "'Opportunity 
Product Id'"

■ Previous GotoPreView

■ Next GotoNextView
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A Siebel Healthcare Reports

This appendix lists the Actuate reports that are specific to the Siebel Healthcare (Table 35). For more 
information about Actuate reports, including how to customize, enhance, and create Oracle’s Siebel 
reports, see Siebel Reports Administration Guide.

Table 35. Siebel Healthcare Reports

Report Name and Description Navigation Path Report Selection

FINS Call Report Detail

Displays call report details, participating 
contacts and employees, action items, and 
notes of a single call report.

Call Reports > My Call 
Reports 

Detail

FINS Call Report Summary

Displays the company profile of commercial 
banking clients including a corporate 
summary, financial profile, subsidiaries, 
contacts, and activities.

Call Reports > My Call 
Reports

Summary

FINS Contact Profile

Displays contact profile information such as 
name, address, date of birth, interests, 
experience, and activities.

Contacts > My Contacts Profile

FINS Demo Health Providers by Product - 
Healthcare

Displays lists of healthcare providers, grouped 
by health insurance product, with their 
contact and location information.

Providers > My Providers Provider by Product

FINS Demo Health Providers by Specialty 
- Healthcare

Displays lists of healthcare providers, grouped 
by their specialty, with their contact and 
location information.

Providers > My Providers Provider by 
Specialty

Opportunities - By Product Line Opportunities > My 
Opportunities

By Product Line
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Index

A
accounts

Financial Services, as used in 18
action items

associating with call reports 69
activities

viewing aggregated activities for a 
company 40

activity plan templates
group policies, creating activities for the 

template 92
group policies, creating for 91

Actuate reports, table of 237
administration procedures

health program, adding 104
health programs, adding 104

agencies
agents, adding 113
business scenario, company signs new 

agent 112
business scenario, employee adds a new 

agency 112
defined 111
information, adding information associated 

with an agent 113
new partners, adding 113

applets
Command Center applet, configuring 

example 25
Command Center applet, defining actions 23
Command Line applet, creating global 

commands for 27
applicants

individual health policies, adding 
applicant 83

policy coverages, associating with 84
applications

associating company applications with a 
company 41

Applications Administration Guide
about setup tasks information 17

approval stage
approving or declining 222

assessments
company assessments, about creating 41
company assessments, performing 41

Assignment Manager

about using to resolve coverage team 
problems 34

Assignment Statements, fine tuning
about 164
Cache flag, about 166
Light Parser flag, about 165

attachments
associating with call reports 69

authorizations
activities, creating for template 116
authorization actions, recording 117, 118
business scenario 115
creating a authorization 117

automating approval processing
about 219
approval items and stages, defining 219
FINS Approval Item Service, invoking from a 

workflow 220

B
beneficiaries

adding to group policies 101
bill payments

adding importing 76
billing accounts

about 129
billing account records, adding or 

modifying 130
business scenario 129
contact or company, associating billing 

account with 131
policy, associating a billing account with 131
service request, adding to a billing 

account 132
BRP

See Business Rule Processor
Business Rule Process

procedure, defining 157
procedure, defining a step 157
procedures, about defining 156

Business Rule Processor
about 147
business rule process, creating 150
creating and managing, about 149
existing process, revising 150
process of defining 148
process, activating 151
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process, exporting 151
process, importing 151
properties, defining 152
property types. about 152
property, defining 155

Business Rules Process
errors, recovering from within process 167
errors, throwing errors within 166
FINS CAP Buscomp Data Loader Business 

Service 168
FINS CAP Buscomp Handler Business 

Service 172
helper business services, about using 168

Business Rules Processor
debug messages, logging 180
invoking using eScript 179
invoking, about 178

business services
about 138
active business objects, use of 215
approval items and stages, defining 219
approval stage, approving or declining 222
Assignment Statements, fine tuning 164
automating approval processing 219
Business Rule Process procedure, 

defining 157
Business Rule Process procedure, defining a 

step 157
Business Rule Process procedures, 

defining 156
Business Rule Processor debug messages, 

logging 180
Business Rule Processor property types 152
Business Rule Processor property, 

defining 155
Business Rule Processor, about 147
Business Rule Processor, about creating and 

managing 149
Business Rule Processor, activating a 

process 151
Business Rule Processor, creating 150
Business Rule Processor, defining 

properties 152
Business Rule Processor, exporting a 

process 151
Business Rule Processor, importing a 

process 151
Business Rule Processor, invoking using 

eScript 179
Business Rule Processor, process of 

defining 148
Business Rule Processor, revising an existing 

process 150
Business Rules Process, about using helper 

business services 168
Business Rules Process, recovering from 

errors 167
Business Rules Process, throwing errors 

within 166
Business Rules Processor, invoking 178
Cache flag, about 166
calculation details, specifying 197
calculation expressions in Data Transfer 

Utilities 210
Calculation Manager, about and 

examples 195
Calculation Manager, invoking 200
calculation rule set. specifying 195
Customer Authentication Manager 189
Customer Authentication Manager, 

invoking 193
customer authentication rules, creating 192
customer authentication templates, 

creating 190
Customer Expectation Manager rules, 

defining 202
Customer Expectation Manager, 

invoking 204
Customer Expectations Manager 201
data map component advanced options 206
data map components 205
data map fields 208
data map objects 205
data maps, about 204
Data Transfer method 212
Data Transfer Utilities, about 204
Data Validation Manager, about 146
disclosure documents, activating workflows 

used to display 225
disclosure history, viewing associated with 

contacts 226
disclosure processing, automating 

display 223
Disclosure UI Service, about invoking from 

workflow 225
disclosure workflow processes (table) 224
disclosures, associating with a product 223
dynamic applet, creating with Dynamic UI 

business service example 229
dynamic applet, displaying in a workflow 230
dynamic enabling of commands 217
Dynamic UI business service, about 229
Dynamic UI Service methods 232
embedded script for mortgage calculation 

example 198
event-based commands, configuring 216
existing disclosure, revising 223
FINS Application View Navigation 
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Service 232
FINS Application View Navigation Service 

example 234
FINS Application View Navigation Service, 

administering 234
FINS Application View Navigation Service, 

behaviors 233
FINS Application View Navigation Service, 

methods 233
FINS Application View Navigation Service, 

upgrade note 235
FINS Approval Item Service, invoking from a 

workflow 220
FINS CAP Buscomp Data Loader Business 

Service 168
FINS CAP Buscomp Handler Business 

Service 172
FINS SmartScript Output Service 

methods 229
FINS Web Shopping Service methods 228
Free Format Converter 145
invocation context 215
Light Parser flag, about 165
named parameters, using in Data Transfer 

Utilities 209
Record Group templates, creating 186
record templates, creating 182
recursive invocation 216
requirement templates, creating 183
Requirements Manager 181
Requirements Manager key features 181
Requirements Manager, about invoking 181
Requirements Manager, administration 

steps 182
Requirements Manager, example of using for 

Record Group templates 188
Requirements Manager, invoking 186
SmartScript, about invoking from a 

workflow 226
SmartScript, integrating with workflow 

example 227
Template Definition view, adding views and 

applets 232
variables, specifying 196
VBC cache and Instance Manager 140
view template, about creating for dynamic 

applets 231
well-positioned buscomps 215
what is a business service 138

C
Cache flag, about 166
Calculation Expectations Manager

about 201
invoking 204
rules, defining 202

calculation expressions
about 210
curley bracket pair {field} 210
named parameters 211

Calculation Manager
about and examples 195
calculation details, specifying 197
calculation rule set, specifying 195
embedded script for mortgage calculation 

example 198
invoking 200
variables, specifying 196

call report email templates
viewing or changing 67

call reports
action items, notes, and attachments, 

associating with 69
business scenario 64
call report charts, viewing 65
call report distribution list, creating 69
call report email templates, viewing or 

changing 67
call report privacy flag, setting 70
call report, adding 67
Data Transfer Utility, about using 66
defined and about 63
emailing and printing 70
New Call Report Workflow, activating 66

categories
creating contact information for 50

census data
census information, adding 94
detailed census data, importing 93
segmented census data, importing 94

claims
facility claims, adding 76
provider claims, adding 126

ClearCache method, about 172
Collapse button

Edit Layout view 19
summary view control, about 18

command center
about and interface types 20
configuration and administration, about 20

Command Center Action form
Command Center Action applet, configuring 

example 25
Command Center action, selecting 

responsibilities 25
Command Center applet, defining actions 23
Command Center business object, 
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defining 21
process of configuring appearance and 

functions 20
Command Center applet

configuring example 25
defining actions 23

Command Center business object
defining 21

Command Line applet
creating for global commands 27

commands
dynamic enabling, about 217
event-based commands, configuring 216
Mock Event Sink mode 218
Srf mode 218
toolbar buttons, defining 218

companies
about 29
aggregated activities viewing for a 

company 40
aggregated coverage team, viewing 40
aggregated list of contacts, viewing 41
aggregated opportunities, viewing 40
billing account, associating with 131
business scenario, sales representative tracks 

company information 31
company applications, associating with a 

company 41
company assessments, about creating 41
company assessments, performing 41
company coverage team, adding a 

member 43
company coverage teams, about 

managing 43
company hierarchies, about 30
company hierarchies, default 37
company information, making unavailable to 

users 33
company or investor, adding 39
company summaries, viewing 43
competitor designation, changing 34
competitor, indicating a company is a 

competitor 33
coverage team members, about verifying 34
coverage team members, adding or 

deleting 35
coverage team members, search for a 

company without 34
custom-defined relationship type, about 

managing 35
custom-defined relationship type, adding 35
custom-defined relationship, creating 44
data aggregation, about generating company 

hierarchies for 36

default company hierarchy, generating 37
dynamic company hierarchy, creating 38
industry, adding 32
parent-subsidiary relationship, 

establishing 44
primary coverage team members, 

changing 35
service requests, adding associated with a 

company 42
territory, adding 33
values, about setting up 32

company hierarchies
aggregated activities, viewing for a 

company 40
aggregated coverage team, viewing 40
aggregated list of contacts, viewing 41
aggregated opportunities, viewing 40
data aggregation, generating for 36
default company hierarchies 37
default company hierarchy, generating 37
dynamic company hierarchy, creating 38

company relationship hierarchies
custom-defined relationship, creating 44
viewing 44

company summaries, viewing 43
competitor

company, indicating as a competitor 33
designation, changing competitor 

designation 34
contacts

adding 49
billing account, associating with 131
business scenario, sales representative adds a 

new contact 48
categories, creating for contact 

information 50
company, associating a contact with a 

company 50
contact relationship hierarchies, viewing 54
contact summary, viewing 54
customer assessments, about creating 53
customer assessments, creating 53
customer value stars. adjusting 54
defined 47
disclosure history, viewing associated with 

contacts 226
facilities, associating with 75
financial plans, creating 56
household, adding to a 59
households, associating with 59
managing contact information, about 49
mortgages, managing 56
notes, creating about contacts 51
referral, creating to a contact 52
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referral, entering a referral received from a 
contact 51

relationship between contacts, defining 55
Contacts screen

providers, viewing 104
contracts

facility contracts, adding 75
coverage teams

company coverage team, adding a 
member 43

company coverage teams, about 
managing 43

customer assessments
creating 53
creating, about 53
customer value stars, adjusting 54

Customer Authentication Manager
about 189
customer authentication rules, creating 192
customer authentication templates, 

creating 190
invoking 193

customer value stars, adjusting 54
customizable products

reconfiguring in plan design 98
Customize Plan button, using 98

D
data aggregation

company hierarchies, default 37
company hierarchies, generating for data 

aggregation 36
default company hierarchy, generating 37
dynamic company hierarchy, creating 38

Data Transfer method
arguments and descriptions 212
FAFireEventxx method 213
GetActiveViewProp method 213
QueueMethod 214
TryMockMethod 214

Data Transfer Utilities
about 204
about using 66
active business objects 215
calculation expressions in DTU, about 210
data map component advanced options 206
data map components 205
data map fields 208
data map objects 205
data maps, about 204
Data Transfer method 212
invocation context 215
named parameters, using in DTU 209

recursive invocation 216
well-positioned buscomps 215

Data Validation Manager
about 146

deleting
company information, making unavailable to 

users 33
coverage team members 35

disclosure documents
automating display, about 223
contacts, viewing disclosure history 226
Disclosure UI Service, invoking from 

workflow 225
disclosure workflow processes (table) 224
disclosures, associating with a product 223
existing disclosure, revising 223
workflows, activating used to display 

disclosure documents 225
Disclosure UI Service

invoking from a workflow 225
distribution list

about creating 69
dynamic applets

See Dynamic UI business service
dynamic company hierarchy, creating 38
Dynamic UI business service

about 229
dynamic applet, creating with Dynamic UI 

business service example 229
dynamic applet, displaying in a workflow 230
Dynamic UI Service methods 232
Template Definition view, adding views and 

applets 232
view template, about creating for dynamic 

applets 231

E
Edit Layout view

about using and buttons 19
email templates

viewing or changing call report email 
templates 67

emailing
call reports 70

employees
adding employee classes for group 

policies 95
enrolling members

in group policies 100
enrollment

in health programs 106
enrollment waiting periods

coverage, impacting on the start of 97
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errors
Business Rules Process, throwing errors 

within 166
recovering from errors within a Business Rules 

Process 167
event-based commands

configuring 216
Expand button

Edit Layout view 19
summary view control, about 18

F
facilities

business scenario 73
facility claims, adding 76
facility contracts, adding 75
facility locator, adding facilities to 74
facility payment, adding 76
facility records, adding 75
provider, facility or contract, associating with 

a facility 75
facility locator

adding facilities to 74
FAFireEventxxx method 213
financial plans, creating 56
FINS Application View Navigation Service

about 232
administering 234
business service behaviors 233
business service methods 233
example 234
upgrade note 235

FINS Approval Item Service
business service step, configuring 222
start step, configuring 221
workflow, about invoking 220

FINS CAP Buscomp Data Loader Business 
Service

about 168
ClearCache method, about 172
LoadData method example using field 

[n] 171
LoadData method example using Key and 

Value fields 172
LoadData method, about 169

FINS CAP Buscomp Handler Business Service
about 172
GetFieldValue method, about 175
InsertRecord method, about 176
NextRecord method, about 177
query method, about 173
SetFieldValue method, about 176

FINS EAI Free Format Converter

about 145
methods 145
user properties 145

FINS Group Policy Member benefits business 
component

enrollment waiting period, about rules 97
FINS SmartScript Output Service 

methods 229
FINS Web Shopping Service methods 228
Free Format Converter

about 145
methods 145
user properties 145

G
GetActiveViewProp method 213
GetFieldValue method, about 175
global commands

creating for the Command Line applet 27
group policies

activity plan templates, creating 91
activity plan templates, creating activities for 

the template 92
beneficiaries, adding 101
business scenario 88
census data, importing 93
census information, adding 94
customizable products, reconfiguring in plan 

design 98
defined 87
employee classes, adding for group 

policies 95
enrollment waiting periods, impact start of 

coverage 97
group insurance products, adding 90
group policy record, adding 92
members, adding eligible members 100
members, enrolling members 100
payment plans, setting up 101
plans, adding for group policies 95
policy screens, views common to all 88
proposal templates, creating 92
proposals, generating for group policies 98
rate bands, adding 91
segmented census data, importing 94
underwriting information, adding 99
underwriting information, viewing 99

H
health policies, individual

about 79
applicant, adding 83
business scenario 79
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generating quotes, about 79
health policy quotes, providing 82
health risk assessment, performing 84
insurance product, adding 80
payment plan for individual health policy, 

setting up 85
policy coverages, associating with an 

applicant 84
product line type, specifying 80
quote to an active policy, converting 84
rate band, adding 81
service requests, adding 85

health program, adding 104
health programs, adding 104
health risk assessment, performing 84
Hide button

Edit Layout view 19
summary view control, about 18

households
business scenario 58
contact, adding to a household 59
contacts, associating with households 59
defined 57
household summary, viewing 60
privacy option, setting 59
relationship hierarchy, about viewing 60

I
importing

bill payments, about importing 76
census data 93
facility claims, about importing 76
segmented census data 94

InsertRecord method, about 176
Instance Manager, and VBC Cache

about 140
caching VBC configuration 142
components 141
features and limitations 140
purging the VBC cache 143
stages of caching process 141

insurance
insurance product, adding 80
product line type, specifying 80
rate band, adding 81

insurance policy, associating with billing 
account 131

insurance, group policies
about 87
activity plan templates, creating 91
activity plan templates, creating activities for 

the template 92
beneficiaries, adding 101

business scenario 88
census data, importing 93
census information, adding 94
customizable products, reconfiguring in plan 

design 98
employee classes, adding for group 

policies 95
enrollment waiting periods, impact start of 

coverage 97
group insurance products, adding 90
group policy record, adding 92
members, adding eligible members 100
members, enrolling 100
payment plans, setting up 101
plans, adding for group policies 95
policy screens, views common to all 88
proposal templates, creating 92
proposals, generating for group policies 98
rate bands, adding 91
segmented census data, importing 94
underwriting information, adding 99
underwriting information, viewing 99

integration
integration messages 134

investors
about 29
investor, adding 39

L
latitude and longitude values

facility locator, about adding values 74
Light Parser flag, about 165
List of Values

about configuring 18
LoadData method

about and parameters 169
ClearCache method, about 172
example using field [n] 171
example using Key and Values fields 172

longitude and latitude values
facility locator, about adding values 74

M
members

beneficiaries, adding to group policies 101
eligible members, adding 100
enrolling members 100

Members screen
about 103
members, enrolling 106

Mobile Web Client
about performing administrative functions on 

local db 17
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Mock Event Sink mode 218
mortgages, managing

about 56
Move down button

Edit Layout view 19
Move up button

Edit Layout view 19

N
National Association of Security Dealers 

(NASD) registration
tracking 113

New Call Report Workflow
activating 66
Data Transfer Utility, about using to 

modify 66
NextRecord method, about 177
notes

call reports, associating with 69
creating about contacts 51

P
parent-subsidiary relationship

establishing 44
partners

agents, adding 113
business scenario, company signs new 

agent 112
business scenario, employee adds a new 

agency 112
defined 111
information, adding information associated 

with an agent 113
new partners, adding 113
sharing data with partner, about 

enabling 111
payments

facility payments, adding 76
individual health policy, setting up payment 

plan 85
payment plan, setting up for group 

policies 101
provider payments, adding manually 126
provider payments, viewing 125

plans
customizable products, reconfiguring in plan 

design 98
group policies, adding for 95
payment plans, setting up for group 

plans 101
policy premiums. See billing accounts
policy screens, common views 88
printing

call reports 70
privacy flags

setting the call report privacy flag 70
privacy option, setting 59
products

customizable products, reconfiguring in plan 
design 98

proposal templates
creating for group policies 92

proposals
group policies, about generating for 87
group policies. generating for 98

providers
about 121
adding a provider 123
business scenario 121
facility, associating with 75
facility, associating with a provider 124
payments, adding manually 126
profile information, adding 124
provider address, adding 123
provider claims, adding 126
provider contract, adding 125
provider payments, viewing 125
provider report, viewing 126
speciality, associating with a provider 124

Q
QueueMethod 214
quotes

active policy, converting to 84
health policy quotes, providing 82

R
rate bands

insurance rate bands, adding 81
plans, adding for group policies 95
rate band, adding* 91

Record Group templates
creating 186
Requirements Manager, example of using for 

Record Group templates 188
record templates, creating 182
referral information

referral, creating to a contact 52
referral, entering a referral received from a 

contact 51
referrals

activities, creating for template 116
business scenario 115
creating a referral 117
referral actions, recording 117, 118

relationship hierarchy
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contact, about viewing 54
contacts, defining a relationship between 

contacts 55
household relationship hierarchy, about 

viewing 60
relationship types, custom defined

managing, about 35
managing, adding 35

reports
provider report, viewing 126
table of 237

requirement templates, creating 183
Requirements Manager

about and scenarios 181
administration steps 182
example of using for Record Group 

templates 188
invoking Requirements Manager 186
invoking, about 181
key features 181
Record Group templates, creating 186
record templates, creating 182
requirement templates, creating 183

roll-up views
aggregated activities, viewing for a 

company 40
aggregated coverage team, viewing 40
aggregated opportunities, viewing 40

S
service requests

adding associated with company 42
billing account, adding to 132
individual health policies, adding a service 

request 85
SetFieldValue method

about 176
Show button

Edit Layout view 19
Siebel Calculation Expectations Manager

about 201
Siebel Calculation Manager

See Calculation Manager
SmartScript

FINS SmartScript Output Service 
methods 229

FINS Web Shopping Service methods 228
integrating with workflow example 227
workflow, about invoking from 226

Srf mode 218
summary information

viewing a household summary 60
summary views

configuring, about 18
layout, editing 19

T
team members

coverage team members, about verifying 34
coverage team members, adding or 

deleting 35
coverage team members, searching for a 

company without 34
primary coverage team members, 

changing 35
Template Definition view

adding views and applets 232
templates

activity plan templates, creating activities for 
group policies 92

activity plan templates, creating for group 
policies 91

call report email templates, viewing or 
changing 67

customer authentication templates, 
creating 190

Dynamic UI Service methods 232
proposal templates, creating for group 

policies 92
Record Group templates, creating 186
Record Group templates, example of using 

Requirements Manager for 188
record templates, creating 182
requirement templates, creating 183
Template Definition view, adding views and 

applets 232
view template, about creating for dynamic 

applets 231
toolbar buttons, defining 218
TryMockMethod 214

U
underwriting information

adding 99
viewing 99

V
VBC Cache and Instance Manager

about 140
caching VBC configuration 142
components 141
features and limitations 140
purging the VBC cache 143
stages of caching process 141

view template
dynamic applets, about creating for 231
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Dynamic UI Service methods 232
Template Definition view, adding views and 

applets 232

W
wealth management industry

about access to household’s aggregated 
holdings 58

workflows
disclosure documents, activating (table) 225
Disclosure UI Service, invoking from a 

workflow 225
disclosure workflow processes (table) 224
dynamic applets, displaying in a 

workflow 230
FINS Approval Item Service, invoking from a 

workflow 220
SmartScript, about invoking from a 

workflow 226
SmartScript, integrating with workflow 

example 227
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